Important Notice

Texas Instruments and its subsidiaries (TI) reserve the right to make changes to their products or to discontinue any product or service without notice, and advise customers to obtain the latest version of relevant information to verify, before placing orders, that information being relied on is current and complete. All products are sold subject to the terms and conditions of sale supplied at the time of order acknowledgment, including those pertaining to warranty, patent infringement, and limitation of liability.

TI warrants performance of its semiconductor products to the specifications applicable at the time of sale in accordance with TI’s standard warranty. Testing and other quality control techniques are utilized to the extent TI deems necessary to support this warranty. Specific testing of all parameters of each device is not necessarily performed, except those mandated by government requirements.

Customers are responsible for their applications using TI components.

In order to minimize risks associated with the customer’s applications, adequate design and operating safeguards must be provided by the customer to minimize inherent or procedural hazards.

TI assumes no liability for applications assistance or customer product design. TI does not warrant or represent that any license, either express or implied, is granted under any patent right, copyright, mask work right, or other intellectual property right of TI covering or relating to any combination, machine, or process in which such semiconductor products or services might be or are used. TI’s publication of information regarding any third party’s products or services does not constitute TI’s approval, warranty or endorsement thereof.

Copyright © 2001 – 2010 Texas Instruments Incorporated

Revision History

October 2001 – Revision 1.0  August 2003 – Revision 4.21  May 2006 – Revision 6.21
May 2002 – Revision 3.0  May 2004 – Revision 5.1  July 2008 – Revision 7.0
October 2002 – Revision 4.0  June 2005 – Revision 6.0  February 2009 – Revision 7.2
December 2002 – Revision 4.1  September 2005 – Revision 6.1  July 2010 – Revision 8.0

Mailing Address

Texas Instruments
Training Technical Organization
7839 Churchill Way
M/S 3984
Dallas, Texas 75251-1903
Introductions

- Name
- Company
- Project Responsibilities
- DSP / Microcontroller Experience
- TI Processor Experience
- Hardware / Software - Assembly / C
- Interests
C2000™ Delfino™ Workshop Outline

1. Architecture Overview
2. Programming Development Environment
   Lab: Linker command file
3. Peripheral Register Header Files
4. Reset and Interrupts
5. System Initialization
   Lab: Watchdog and interrupts
6. Analog-to-Digital Converter
   Lab: Build a data acquisition system
7. Control Peripherals
   Lab: Generate and graph a PWM waveform
8. Numerical Concepts and IQ Math
   Lab: Low-pass filter the PWM waveform
9. Direct Memory Access (DMA)
   Lab: Use DMA to buffer ADC results
10. System Design
    Lab: Run the code from flash memory
11. Communications
12. DSP/BIOS
    Lab: Change the code to use DSP/BIOS
13. Support Resources

C2000™ Experimenter Kit

Delfino™ Experimenter Kit

ControlCARD

USB Docking Station
Introduction

This architecture overview introduces the basic architecture of the TMS320C28x (C28x) series of microcontrollers from Texas Instruments. The C28x series adds a new level of general purpose processing ability unseen in any previous DSP chips. The C28x is ideal for applications combining digital signal processing, microcontroller processing, efficient C code execution, and operating system tasks.

Unless otherwise noted, the terms C28x and C2833x refer to TMS320F2833x (with FPU) and TMS320F2823x (without FPU) devices throughout the remainder of these notes. For specific details and differences please refer to the device data sheet and user’s guide.

Learning Objectives

When this module is complete, you should have a basic understanding of the C28x architecture and how all of its components work together to create a high-end, uniprocessor control system.

- Review the F28x block diagram and device features
- Describe the F28x bus structure and memory map
- Identify the various memory blocks on the F28x
- Identify the peripherals available on the F28x
# Module Topics

## Architecture Overview

<table>
<thead>
<tr>
<th>Module Topics</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is the TMS320C28x?</td>
<td>1-3</td>
</tr>
<tr>
<td>TMS320C28x Internal Bussing</td>
<td>1-4</td>
</tr>
<tr>
<td>C28x CPU</td>
<td>1-5</td>
</tr>
<tr>
<td>Special Instructions</td>
<td>1-6</td>
</tr>
<tr>
<td>Pipeline Advantage</td>
<td>1-7</td>
</tr>
<tr>
<td>FPU Pipeline</td>
<td>1-8</td>
</tr>
<tr>
<td>Memory</td>
<td>1-9</td>
</tr>
<tr>
<td>Memory Map</td>
<td>1-9</td>
</tr>
<tr>
<td>Code Security Module (CSM)</td>
<td>1-10</td>
</tr>
<tr>
<td>Peripherals</td>
<td>1-10</td>
</tr>
<tr>
<td>Fast Interrupt Response</td>
<td>1-11</td>
</tr>
<tr>
<td>C28x Mode</td>
<td>1-12</td>
</tr>
<tr>
<td>Summary</td>
<td>1-13</td>
</tr>
</tbody>
</table>
What is the TMS320C28x?

The TMS320C28x is a 32-bit fixed point microcontroller that specializes in high performance control applications such as, robotics, industrial automation, mass storage devices, lighting, optical networking, power supplies, and other control applications needing a single processor to solve a high performance application.

The C28x architecture can be divided into 3 functional blocks:

- CPU and busing
- Memory
- Peripherals
What is the TMS320C28x?

TMS320C28x Internal Bussing

As with many DSP-type devices, multiple busses are used to move data between the memories and peripherals and the CPU. The C28x memory bus architecture contains:

- A program read bus (22-bit address line and 32-bit data line)
- A data read bus (32-bit address line and 32-bit data line)
- A data write bus (32-bit address line and 32-bit data line)

The 32-bit-wide data busses enable single cycle 32-bit operations. This multiple bus architecture, known as a Harvard Bus Architecture enables the C28x to fetch an instruction, read a data value and write a data value in a single cycle. All peripherals and memories are attached to the memory bus and will prioritize memory accesses.
C28x CPU

The C28x is a highly integrated, high performance solution for demanding control applications. The C28x is a cross between a general purpose microcontroller and a digital signal processor, balancing the code density of a RISC processor and the execution speed of a DSP with the architecture, firmware, and development tools of a microcontroller.

The DSP features include a modified Harvard architecture and circular addressing. The RISC features are single-cycle instruction execution, register-to-register operations, and a modified Harvard architecture. The microcontroller features include ease of use through an intuitive instruction set, byte packing and unpacking, and bit manipulation.

The C28x design supports an efficient C engine with hardware that allows the C compiler to generate compact code. Multiple busses and an internal register bus allow an efficient and flexible way to operate on the data. The architecture is also supported by powerful addressing modes, which allow the compiler as well as the assembly programmer to generate compact code that is almost one to one corresponded to the C code.

The C28x is as efficient in DSP math tasks as it is in system control tasks. This efficiency removes the need for a second processor in many systems. The 32 x 32-bit MAC capabilities of the C28x and its 64-bit processing capabilities, enable the C28x to efficiently handle higher numerical resolution problems that would otherwise demand a more expensive solution. Along with this is the capability to perform two 16 x 16-bit multiply accumulate instructions simultaneously or Dual MACs (DMAC). Also, some devices feature a floating-point unit.

The C28x is source code compatible with the 24x/240x devices and previously written code can be reassembled to run on a C28x device, allowing for migration of existing code onto the C28x.
Special Instructions

F28x Atomic Read/Modify/Write

Atomic Instructions Benefits

- Simpler programming
- Smaller, faster code
- Uninterruptible (Atomic)
- More efficient compiler

Atomics are small common instructions that are non-interuptable. The atomic ALU capability supports instructions and code that manages tasks and processes. These instructions usually execute several cycles faster than traditional coding.
Pipeline Advantage

The C28x uses a special 8-stage protected pipeline to maximize the throughput. This protected pipeline prevents a write to and a read from the same location from occurring out of order.

This pipelining also enables the C28x to execute at high speeds without resorting to expensive high-speed memories. Special branch-look-ahead hardware minimizes the latency for conditional discontinuities. Special store conditional operations further improve performance.
FPU Pipeline

Floating-point math operations and conversions between integer and floating-point formats require 1 delay slot – everything else does not require a delay slot (load, store, max, min, absolute, negative, etc.)

- Floating Point Unit has an unprotected pipeline
  - i.e. FPU can issue an instruction before previous instruction has written results
- Compiler prevents pipeline conflicts
- Assembler detects pipeline conflicts
- Performance improvement by placing non-conflicting instructions in floating-point pipeline delay slots

Floating-point operations are not pipeline protected. Some instructions require delay slots for the operation to complete. This can be accomplished by insert NOPs or other non-conflicting instructions between operations.

In the user’s guide, instructions requiring delay slots have a ‘p’ after their cycle count. The 2p stands for 2 pipelined cycles. A new instruction can be started on each cycle. The result is valid only 2 instructions later.

Three general guidelines for the FPU pipeline are:

<table>
<thead>
<tr>
<th>Category</th>
<th>Instruction Examples</th>
<th>Delay Slot Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Math</td>
<td>MPYF32, ADDF32, SUBF32, MACF32</td>
<td>2p cycles</td>
</tr>
<tr>
<td></td>
<td></td>
<td>One delay slot</td>
</tr>
<tr>
<td>Conversion</td>
<td>I16TOF32, F32TOI16, F32TOI16R, etc…</td>
<td>2p cycles</td>
</tr>
<tr>
<td></td>
<td></td>
<td>One delay slot</td>
</tr>
<tr>
<td>Everything else*</td>
<td>Load, Store, Compare, Min, Max, Absolute and Negative value</td>
<td>Single cycle</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No delay slot</td>
</tr>
</tbody>
</table>

* Note: MOV32 between FPU and CPU registers is a special case.
Memory

The memory space on the C28x is divided into program memory and data memory. There are several different types of memory available that can be used as both program memory and data memory. They include the flash memory, single access RAM (SARAM), OTP, off-chip memory, and Boot ROM which is factory programmed with boot software routines or standard tables used in math related algorithms.

Memory Map

The C28x CPU contains no memory, but can access memory both on and off the chip. The C28x uses 32-bit data addresses and 22-bit program addresses. This allows for a total address reach of 4G words (1 word = 16-bits) in data memory and 4M words in program memory. Memory blocks on all C28x designs are uniformly mapped to both program and data space.

This memory map shows the different blocks of memory available to the program and data space.
Code Security Module (CSM)

- Prevents reverse engineering and protects valuable intellectual property
- 128-bit user defined password is stored in Flash
- 128-bits = 2^{128} = 3.4 \times 10^{38} possible passwords
- To try 1 password every 8 cycles at 150 MHz, it would take at least 5.8 \times 10^{23} years to try all possible combinations!

Peripherals

The C28x comes with many built-in peripherals optimized to support control applications. These peripherals vary depending on which C28x device you choose.

- ePWM
- SPI
- eCAP
- SCI
- eQEP
- I2C
- Analog-to-Digital Converter
- CAN
- Watchdog Timer
- GPIO
- McBSP
- DMA
Fast Interrupt Response

The fast interrupt response, with automatic context save of critical registers, resulting in a device that is capable of servicing many asynchronous events with minimal latency. C28x implements a zero cycle penalty to do 14 registers context saved and restored during an interrupt. This feature helps reduces the interrupt service routine overheads.

**F28x Fast Interrupt Response Manager**

- 96 dedicated PIE vectors
- No software decision making required
- Direct access to RAM vectors
- Auto flags update
- Concurrent auto context save

<table>
<thead>
<tr>
<th>Auto Context Save</th>
<th>PIE Register Map</th>
</tr>
</thead>
<tbody>
<tr>
<td>T</td>
<td>ST0</td>
</tr>
<tr>
<td>AH</td>
<td>AL</td>
</tr>
<tr>
<td>PH</td>
<td>PL</td>
</tr>
<tr>
<td>AR1 (L)</td>
<td>AR0 (L)</td>
</tr>
<tr>
<td>DP</td>
<td>ST1</td>
</tr>
<tr>
<td>DBSTAT</td>
<td>IER</td>
</tr>
<tr>
<td>PC(msw)</td>
<td>PC(lsw)</td>
</tr>
</tbody>
</table>

Peripheral Interrupts: 12x8 = 96

28x CPU Interrupt logic

INT1 to INT12
12 interrupts

IFR IER INTM 28x CPU
C28x Mode

The C28x is one of several members of the TMS320 digital signal controller/processors family. The C28x is source code compatible with the 24x/240x devices and previously written code can be reassembled to run on a C28x device. This allows for migration of existing code onto the C28x.

F28x Operating Modes

<table>
<thead>
<tr>
<th>Mode Type</th>
<th>Mode Bits OBJMODE</th>
<th>Mode Bits AMODE</th>
<th>Compiler Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>C28x Native Mode</td>
<td>1</td>
<td>0</td>
<td>-v28</td>
</tr>
<tr>
<td>C24x Compatible Mode</td>
<td>1</td>
<td>1</td>
<td>-v28 –m20</td>
</tr>
<tr>
<td>Test Mode (default)</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Reserved</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

- Almost all users will run in C28x Native Mode
- The bootloader will automatically select C28x Native Mode after reset
- C24x compatible mode is mostly for backwards compatibility with an older processor family
Summary

- High performance 32-bit DSP
- 32x32 bit or dual 16x16 bit MAC
- IEEE single-precision floating point unit
- Atomic read-modify-write instructions
- Fast interrupt response manager
- 256Kw on-chip flash memory
- Code security module (CSM)
- Control peripherals
- 12-bit ADC module
- Up to 88 shared GPIO pins
- Watchdog timer
- DMA and external memory interface
- Communications peripherals
Introduction

This module will explain how to use Code Composer Studio (CCS) integrated development environment (IDE) tools to develop a program. Creating projects and setting building options will be covered. Use and the purpose of the linker command file will be described.

Learning Objectives

- Use Code Composer Studio to:
  - Create a Project
  - Set Build Options
- Create a user linker command file which:
  - Describes a system’s available memory
  - Indicates where sections will be placed in memory
Module Topics

Programming Development Environment ................................................................. 2-1

Module Topics ........................................................................................................ 2-2

Code Composer Studio .............................................................................................. 2-3
  Software Development and COFF Concepts ......................................................... 2-3
  C/C++ and Debug Perspective (CCSv4) ............................................................... 2-5
  CCSv4 Projects .................................................................................................... 2-6
  Creating a New CCSv4 Project ............................................................................ 2-7
  CCSv4 Build Options – Compiler / Linker ........................................................... 2-8

Creating a Linker Command File ............................................................................. 2-9
  Sections ................................................................................................................ 2-9
  Linker Command Files (.cmd) ................................................................................ 2-12
  Memory-Map Description ..................................................................................... 2-12
  Section Placement ............................................................................................... 2-13
  Summary: Linker Command File ........................................................................ 2-14

Lab 2: Linker Command File ..................................................................................... 2-15

Lab 2: Solution – lab2.cmd ...................................................................................... 2-22
Code Composer Studio

Software Development and COFF Concepts

In an effort to standardize the software development process, TI uses the Common Object File Format (COFF). COFF has several features which make it a powerful software development system. It is most useful when the development task is split between several programmers.

Each file of code, called a module, may be written independently, including the specification of all resources necessary for the proper operation of the module. Modules can be written using Code Composer Studio (CCS) or any text editor capable of providing a simple ASCII file output. The expected extension of a source file is .ASM for assembly and .C for C programs.

Code Composer Studio includes:
- Integrated Edit/Debug GUI
- Code Generation Tools
- DSP/BIOS

Code Composer Studio includes a built-in editor, compiler, assembler, linker, and an automatic build process. Additionally, tools to connect file input and output, as well as built-in graph displays for output are available. Other features can be added using the plug-ins capability.

Numerous modules are joined to form a complete program by using the linker. The linker efficiently allocates the resources available on the device to each module in the system. The linker uses a command (.CMD) file to identify the memory resources and placement of where the various sections within each module are to go. Outputs of the linking process includes the linked object file (.OUT), which runs on the device, and can include a .MAP file which identifies where each linked section is located.

The high level of modularity and portability resulting from this system simplifies the processes of verification, debug and maintenance. The process of COFF development is presented in greater detail in the following paragraphs.
The concept of COFF tools is to allow modular development of software independent of hardware concerns. An individual assembly language file is written to perform a single task and may be linked with several other tasks to achieve a more complex total system.

Writing code in modular form permits code to be developed by several people working in parallel so the development cycle is shortened. Debugging and upgrading code is faster, since components of the system, rather than the entire system, is being operated upon. Also, new systems may be developed more rapidly if previously developed modules can be used in them.

Code developed independently of hardware concerns increases the benefits of modularity by allowing the programmer to focus on the code and not waste time managing memory and moving code as other code components grow or shrink. A linker is invoked to allocate systems hardware to the modules desired to build a system. Changes in any or all modules, when re-linked, create a new hardware allocation, avoiding the possibility of memory resource conflicts.
C/C++ and Debug Perspective (CCSv4)

A perspective defines the initial layout views of the workbench windows, toolbars, and menus that are appropriate for a specific type of task, such as code development or debugging. This minimizes clutter to the user interface.

- Each perspective provides a set of functionality aimed at accomplishing a specific task

- C/C++ Perspective
  - Displays views used during code development
    - C/C++ project, editor, etc.

- Debug Perspective
  - Displays views used for debugging
    - Menus and toolbars associated with debugging, watch and memory windows, graphs, etc.
CCSv4 Projects

Code Composer works with a project paradigm. Essentially, within CCS you create a project for each executable program you wish to create. Projects store all the information required to build the executable. For example, it lists things like: the source files, the header files, the target system’s memory-map, and program build options.

CCSv4 Project

Project files contain:

- List of files:
  - Source (C, assembly)
  - Libraries
  - DSP/BIOS configuration file
  - Linker command files

- Project settings:
  - Build options (compiler, assembler, linker, and DSP/BIOS)
  - Build configurations

To create a new project, you need to select the following menu items:

File ➔ New ➔ CCS Project

Along with the main Project menu, you can also manage open projects using the right-click popup menu. Either of these menus allows you to modify a project, such as add files to a project, or open the properties of a project to set the build options.
Creating a New CCSv4 Project

A graphical user interface (GUI) is used to assist in creating a new project. The four windows for the GUI are shown in the slide below.
CCSv4 Build Options – Compiler / Linker

Project options direct the code generation tools (i.e. compiler, assembler, linker) to create code according to your system’s needs. When you create a new project, CCS creates two sets of build options – called Configurations: one called Debug, the other Release (you might think of as Optimize).

To make it easier to choose build options, CCS provides a graphical user interface (GUI) for the various compiler and linker options. Here’s a sample of the configuration options.

There is a one-to-one relationship between the items in the text box on the main page and the GUI check and drop-down box selections. Once you have mastered the various options, you can probably find yourself just typing in the options.

There are many linker options but these four handle all of the basic needs.

- `-o <filename>` specifies the output (executable) filename.
- `-m <filename>` creates a map file. This file reports the linker’s results.
- `-c` tells the compiler to autoinitialize your global and static variables.
- `-x` tells the compiler to exhaustively read the libraries. Without this option libraries are searched only once, and therefore backwards references may not be resolved.

To help make sense of the many compiler options, TI provides two default sets of options (configurations) in each new project you create. The Release (optimized) configuration invokes the optimizer with `–o3` and disables source-level, symbolic debugging by omitting `–g` (which disables some optimizations to enable debug).
Creating a Linker Command File

Sections

Looking at a C program, you'll notice it contains both code and different kinds of data (global, local, etc.).

![Sections Diagram]

- All code consists of different parts called sections
- All default section names begin with “.”
- The compiler has default section names for initialized and uninitialized sections

In the TI code-generation tools (as with any toolset based on the COFF – Common Object File Format), these various parts of a program are called Sections. Breaking the program code and data into various sections provides flexibility since it allows you to place code sections in ROM and variables in RAM. The preceding diagram illustrated four sections:

- Global Variables
- Initial Values for global variables
- Local Variables (i.e. the stack)
- Code (the actual instructions)
Following is a list of the sections that are created by the compiler. Along with their description, we provide the Section Name defined by the compiler.

### Compiler Section Names

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Link Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>.text</td>
<td>code</td>
<td>FLASH</td>
</tr>
<tr>
<td>.cinit</td>
<td>initialization values for global and static variables</td>
<td>FLASH</td>
</tr>
<tr>
<td>.econst</td>
<td>constants (e.g. const int k = 3;)</td>
<td>FLASH</td>
</tr>
<tr>
<td>.switch</td>
<td>tables for switch statements</td>
<td>FLASH</td>
</tr>
<tr>
<td>.pinit</td>
<td>tables for global constructors (C++)</td>
<td>FLASH</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Link Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>.ebss</td>
<td>global and static variables</td>
<td>RAM</td>
</tr>
<tr>
<td>.stack</td>
<td>stack space</td>
<td>low 64Kw RAM</td>
</tr>
<tr>
<td>.esysmem</td>
<td>memory for far malloc functions</td>
<td>RAM</td>
</tr>
</tbody>
</table>

Note: During development initialized sections could be linked to RAM since the emulator can be used to load the RAM.

Sections of a C program must be located in different memories in your target system. This is the big advantage of creating the separate sections for code, constants, and variables. In this way, they can all be linked (located) into their proper memory locations in your target embedded system. Generally, they’re located as follows:

**Program Code (.text)**

Program code consists of the sequence of instructions used to manipulate data, initialize system settings, etc. Program code must be defined upon system reset (power turn-on). Due to this basic system constraint it is usually necessary to place program code into non-volatile memory, such as FLASH or EPROM.

**Constants (.cinit – initialized data)**

Initialized data are those data memory locations defined at reset. It contains constants or initial values for variables. Similar to program code, constant data is expected to be valid upon reset of the system. It is often found in FLASH or EPROM (non-volatile memory).

**Variables (.ebss – uninitialized data)**

Uninitialized data memory locations can be changed and manipulated by the program code during runtime execution. Unlike program code or constants, uninitialized data or variables must reside in volatile memory, such as RAM. These memories can be modified and updated, supporting the way variables are used in math formulas, high-level languages, etc. Each variable must be declared with a directive to reserve memory to contain its value. By their nature, no value is assigned, instead they are loaded at runtime by the program.
Linking code is a three step process:

1. Defining the various regions of memory (on-chip SARAM vs. FLASH vs. External Memory).
2. Describing what sections go into which memory regions
3. Running the linker with “build” or “rebuild”
Linker Command Files (.cmd)

The linker concatenates each section from all input files, allocating memory to each section based on its length and location as specified by the MEMORY and SECTIONS commands in the linker command file.

Memory-Map Description

The MEMORY section describes the memory configuration of the target system to the linker.

The format is:  \textit{Name}:  \textit{origin} = 0x????,  \textit{length} = 0x????

For example, if you placed a 64Kw FLASH starting at memory location 0x3E8000, it would read:

\begin{verbatim}
MEMORY
{   FLASH:  origin = 0x300000 , length = 0x040000
}
\end{verbatim}

Each memory segment is defined using the above format. If you added M0SARAM and M1SARAM, it would look like:

\begin{verbatim}
MEMORY
{   M0SARAM:  origin = 0x000000 , length = 0x0400
    M1SARAM:  origin = 0x000400 , length = 0x0400
}
\end{verbatim}
Remember that the DSP has two memory maps: Program, and Data. Therefore, the MEMORY description must describe each of these separately. The loader uses the following syntax to delineate each of these:

<table>
<thead>
<tr>
<th>Linker Page</th>
<th>TI Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page 0</td>
<td>Program</td>
</tr>
<tr>
<td>Page 1</td>
<td>Data</td>
</tr>
</tbody>
</table>

**Linker Command File**

```c
MEMORY
{
    PAGE 0:  /* Program Memory */
        FLASH: origin = 0x300000, length = 0x40000

    PAGE 1:  /* Data Memory */
        MOSARAM: origin = 0x000000, length = 0x400
        MISARAM: origin = 0x000400, length = 0x400
}
SECTIONS
{
    .text:>  FLASH PAGE = 0
    .ebss:>  MOSARAM PAGE = 1
    .cinit:> FLASH PAGE = 0
    .stack:> MISARAM PAGE = 1
}
```

**Section Placement**

The SECTIONS section will specify how you want the sections to be distributed through memory. The following code is used to link the sections into the memory specified in the previous example:

```c
SECTIONS
{
    .text:>  FLASH PAGE 0
    .ebss:>  MOSARAM PAGE 1
    .cinit:> FLASH PAGE 0
    .stack:> MISARAM PAGE 1
}
```

The linker will gather all the code sections from all the files being linked together. Similarly, it will combine all ‘like’ sections.

Beginning with the first section listed, the linker will place it into the specified memory segment.
Summary: Linker Command File

The linker command file (.cmd) contains the inputs — commands — for the linker. This information is summarized below:

<table>
<thead>
<tr>
<th>Memory Map Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Name</td>
</tr>
<tr>
<td>• Location</td>
</tr>
<tr>
<td>• Size</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sections Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Directs software sections into named memory regions</td>
</tr>
<tr>
<td>• Allows per-file discrimination</td>
</tr>
<tr>
<td>• Allows separate load/run locations</td>
</tr>
</tbody>
</table>
# Lab 2: Linker Command File

## Objective

Create a linker command file and link the C program file (Lab2.c) into the system described below.

## System Description

- **TMS320F28335**
- All internal RAM blocks allocated

### Placement of Sections:
- `.text` into RAM Block L0123SARAM on PAGE 0 (program memory)
- `.cinit` into RAM Block L0123SARAM on PAGE 0 (program memory)
- `.ebss` into RAM Block L4SARAM on PAGE 1 (data memory)
- `.stack` into RAM Block M1SARAM on PAGE 1 (data memory)

## Initial Boot Mode Jumper Settings

*Note:* Initially, either the controlCARD or the Docking Station boot mode must be configured to “Jump to M0SARAM” for the workshop lab exercises. Set the “2833x Boot Mode” controlCARD switch SW2 or the Docking Station jumpers as shown in the following table (see Appendix A for the switch or jumper position details):
La 2: Linker Command File

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Down – 0</td>
<td>Down – 0</td>
<td>Up – 1</td>
<td>Down – 0</td>
<td>controlCARD</td>
</tr>
<tr>
<td>Right – 0</td>
<td>Right – 0</td>
<td>Left – 1</td>
<td>Right – 0</td>
<td>Docking Station</td>
</tr>
</tbody>
</table>

➢ Procedure

**Start Code Composer Studio and Open a Workspace**

1. Start Code Composer Studio (CCS) by double clicking the icon on the desktop or selecting it from the Windows Start menu. When CCS loads, a dialog box will prompt you for the location of a workspace folder. Use the default location for the workspace and click **OK**.

   This folder contains all CCS custom settings, which includes project settings and views when CCS is closed so that the same projects and settings will be available when CCS is opened again. The workspace is saved automatically when CCS is closed.

2. The first time CCS opens a “Welcome to Code Composer Studio v4” page appears. Close the page by clicking on the CCS icon in the upper right or by clicking the X on the “Welcome” tab. You should now have an empty workbench. The term workbench refers to the desktop development environment. Maximize CCS to fill your screen.

   The workbench will open in the “C/C++ Perspective” view. Notice the C/C++ icon in the upper right-hand corner. A perspective defines the initial layout views of the workbench windows, toolbars, and menus which are appropriate for a specific type of task (i.e. code development or debugging). This minimizes clutter to the user interface. The “C/C++ Perspective” is used to create or build C/C++ projects. A “Debug Perspective” view will automatically be enabled when the debug session is started. This perspective is used for debugging C/C++ projects.

**Setup Target Configuration**

3. Open the emulator target configuration dialog box. On the menu bar click:

   Target ➔ New Target Configuration...

   In the file name field type **F28335_ExpKit.ccxml**. This is just a descriptive name since multiple target configuration files can be created. Leave the “Use shared location” box checked and select **Finish**.

4. In the next window that appears, select the emulator using the “Connection” pull-down list and choose “Texas Instruments XDS100v1 USB Emulator”. In the box below, check the box to select “Experimenter’s Kit – Delfino F28335”.

2 - 16  C2000 Delfino Workshop - Programming Development Environment
Click **Save** to save the configuration, then close the “Cheat Sheets” and “F28335_ExpKit.ccxml” setup window by clicking the X on the tabs.

5. To view the target configurations, click:

View → Target Configurations

and click the plus sign (+) to the left of **User Defined**. Notice that the F28335_ExpKit.ccxml file is listed and set as the default. If it is not set as the default, right-click on the .ccxml file and select “Set as Default”. Close the Target Configurations window by clicking the X on the tab.

**Create a New Project**

6. A **project** contains all the files you will need to develop an executable output file (.out) which can be run on the MCU hardware. To create a new project click:

File → New → CCS Project

In the Project name field type **Lab2**. **Uncheck** the “Use default location” box. Click the **Browse…** button and navigate to:

C:\C28x\Labs\Lab2\Project

Click **OK** and then click **Next**.

7. The next window that appears selects the platform and configurations. Select the “Project Type” using the pull-down list and choose “C2000”. In the “Configurations” box below, leave the “Debug” and “Release” boxes checked. This will create folders that will hold the output files. Click **Next**.

8. In the next window, inter-project dependencies (if any) are defined. Select **Next**.

9. In the last window, the CCS project settings are selected. Change the “Device Variant” using the pull-down list to “TMS320F28335”. Next, using the pull-down list change the “Linker Command File” to “<none>”. We will be using our own linker command file, rather than the one supplied by CCS. The “Runtime Support Library” will be automatically set to “rts2800_fpu32.lib”. This will select the runtime support library for floating-point devices. Click **Finish**.

10. A new project has now been created. Notice the **C/C++ Projects** window contains **Lab2**. The project is set **Active** and the output files will be located in the **Debug** folder. At this point, the project does not include any source files. The next step is to add the source files to the project.

11. To add the source files to the project, right-click on **Lab2** in the **C/C++ Projects** window and select:

Add Files to Project…

or click: **Project → Add Files to Active Project…**
and make sure you’re looking in C:\C28x\Labs\Lab2\Files. With the “files of type” set to view all files (*.*) select Lab2.c and Lab2.cmd then click OPEN. This will add the files to the project.

12. In the C/C++ Projects window, click the plus sign (+) to the left of Lab2 and notice that the files are listed.

Project Build Options

13. There are numerous build options in the project. Most default option settings are sufficient for getting started. We will inspect a couple of the default options at this time. Right-click on Lab2 in the C/C++ Projects window and select Properties or click:

   Project → Properties

14. A “Properties” window will open and in the section on the left be sure that “C/C++ Build” category is selected. In the “Configuration Settings” section make sure that the Tool Settings tab is selected. Next, under “C2000 Linker” select the “Basic Options”. Notice that .out and .map files are being specified. The .out file is the executable code that will be loaded into the MCU. The .map file will contain a linker report showing memory usage and section addresses in memory.

15. Next in the “Basic Options” set the Stack Size to 0x200.

16. Under “C2000 Compiler” select the “Runtime Model Options”. Notice the “Use large memory model” and “Unified memory” boxes are checked. Also, the “Specify floating point support” is set to fpu32. Select OK to save and close the Properties window.

Edit the Linker Command File - Lab2.cmd

17. To open and edit Lab2.cmd, double click on the filename in the C/C++ Projects window.

18. Edit the Memory{} declaration by describing the system memory shown on the “Lab2: Linker Command File” slide in the objective section of this lab exercise. Combine the memory blocks L0SARAM, L1SARAM, L2SARM, and L3SARAM into a single memory block called L0123SARAM. Place this combined memory block into program memory on page 0. Place the other memory blocks into data memory on page 1.

19. In the Sections{} area, notice that a section called .reset has already been allocated. The .reset section is part of the rts2800_fpu32.lib, and is not needed. By putting the TYPE = DSECT modifier after its allocation, the linker will ignore this section and not allocate it.

20. Place the sections defined on the slide into the appropriate memories via the Sections{} area. Save your work and close the file.
Build and Load the Project

21. Three buttons on the horizontal toolbar control code generation. Hover your mouse over each button as you read the following descriptions:

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Build</td>
<td>Incremental build and link of only modified source files</td>
</tr>
<tr>
<td>2</td>
<td>Rebuild</td>
<td>Full build and link of all source files</td>
</tr>
<tr>
<td>3</td>
<td>Debug</td>
<td>Automatically build, link, load and launch debug-session</td>
</tr>
</tbody>
</table>

22. Click the “Build” button and watch the tools run in the Console window. Check for errors in the Problems window (we have deliberately put an error in Lab2.c). When you get an error, you will see the error message (in red) in the Problems window, and simply double-click the error message. The editor will automatically open to the source file containing the error, and position the mouse cursor at the correct code line.

23. Fix the error by adding a semicolon at the end of the “z = x + y” statement. For future knowledge, realize that a single code error can sometimes generate multiple error messages at build time. This was not the case here.

24. Build the project again. There should be no errors this time.

25. CCS can automatically save modified source files, build the program, open the debug perspective view, connect and download it to the target, and then run the program to the beginning of the main function.

   Click on the “Debug” button (green bug) or click Target → Debug Active Project.

   Notice the Debug icon in the upper right-hand corner indicating that we are now in the “Debug Perspective” view. The program ran through the C-environment initialization routine in the rts2800_fpu32.lib and stopped at main() in Lab2.c.

Debug Environment Windows

It is standard debug practice to watch local and global variables while debugging code. There are various methods for doing this in Code Composer Studio. We will examine two of them here: memory windows, and watch windows.

26. Open a “Memory” window to view the global variable “z”.

   Click: View → Memory on the menu bar.

   Type &z into the address field and select “Data” memory page. Note that you must use the ampersand (meaning “address of”) when using a symbol in a memory window address box. Also note that Code Composer Studio is case sensitive.

   Set the properties format to “Hex 16 Bit – TI Style Hex” in the window. This will give you more viewable data in the window. You can change the contents of any address in the memory window by double-clicking on its value. This is useful during debug.
27. Notice the “Local(1)” window automatically opened and the local variables \( x \) and \( y \) are present. The local window will always contain the local variables for the code function currently being executed.

(Note that local variables actually live on the stack. You can also view local variables in a memory window by setting the address to “SP” after the code function has been entered).

28. We can also add global variables to the watch window if desired. Let's add the global variable “\( z \)”.

Click the “Watch (1)” tab at the top of the watch window. In the empty box in the “Name” column, type \( z \) and then enter. An ampersand is not used here. The watch window knows you are specifying a symbol. (Note that the watch window can be manually opened by clicking: View \( \rightarrow \) Watch Window on the menu bar).

Check that the watch window and memory window both report the same value for “\( z \)”. Trying changing the value in one window, and notice that the value also changes in the other window.

**Single-stepping the Code**

29. Click the “Local (1)” tab at the top of the watch window. Single-step through `main()` by using the \(<F5>\) key (or you can use the Step Into button on the horizontal toolbar). Check to see if the program is working as expected. What is the value for “\( z \)” when you get to the end of the program?

**Terminate Debug Session and Close Project**

30. The Terminate All button will terminate the active debug session, close the debugger and return CCS to the “C/C++ Perspective” view.

   Click: Target \( \rightarrow \) Terminate All or use the Terminate All icon: 

   Close the Terminate Debug Session “Cheat Sheet” by clicking on the \( \times \) on the tab.

31. Next, close the project by right-clicking on Lab2 in the C/C++ Projects window and select Close Project.

   **End of Exercise**
Lab 2: Solution - lab2.cmd

Lab 2: Solution - lab2.cmd

MEMORY
{
  PAGE 0: /* Program Memory */
    L0123SARAM: origin = 0x008000, length = 0x4000
  PAGE 1: /* Data Memory */
    M0SARAM: origin = 0x000000, length = 0x0400
    M1SARAM: origin = 0x000400, length = 0x0400
    L4SARAM: origin = 0x00C000, length = 0x1000
    L5SARAM: origin = 0x00D000, length = 0x1000
    L6SARAM: origin = 0x00E000, length = 0x1000
    L7SARAM: origin = 0x00F000, length = 0x1000
}

SECTIONS
{
  .text: > L0123SARAM PAGE = 0
  .ebss: > L4SARAM PAGE = 1
  .cinit: > L0123SARAM PAGE = 0
  .stack: > M1SARAM PAGE = 1
  .reset: > L0123SARAM PAGE = 0, TYPE = DSECT
}
Peripherial Registers Header Files

Introduction

The purpose of the DSP2833x C-code header files is to simplify the programming of the many peripherals on the C28x device. Typically, to program a peripheral the programmer needs to write the appropriate values to the different fields within a control register. In its simplest form, the process consists of writing a hex value (or masking a bit field) to the correct address in memory. But, since this can be a burdensome and repetitive task, the C-code header files were created to make this a less complicated task.

The DSP2833x C-code header files are part of a library consisting of C functions, macros, peripheral structures, and variable definitions. Together, this set of files is known as the ‘header files.’

Registers and the bit-fields are represented by structures. C functions and macros are used to initialize or modify the structures (registers).

In this module, you will learn how to use the header files and C programs to facilitate programming the peripherals.

Learning Objectives

- Understand the usage of the F2833x C-Code Header Files
- Be able to program peripheral registers
- Understand how the structures are mapped with the linker command file
## Module Topics

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peripheral Registers Header Files</td>
<td>3-1</td>
</tr>
<tr>
<td>Module Topics</td>
<td>3-2</td>
</tr>
<tr>
<td>Traditional and Structure Approach to C Coding</td>
<td>3-3</td>
</tr>
<tr>
<td>Naming Conventions</td>
<td>3-6</td>
</tr>
<tr>
<td>F2833x C-Code Header Files</td>
<td>3-7</td>
</tr>
<tr>
<td>Peripheral Structure .h File</td>
<td>3-7</td>
</tr>
<tr>
<td>Global Variable Definitions File</td>
<td>3-9</td>
</tr>
<tr>
<td>Mapping Structures to Memory</td>
<td>3-10</td>
</tr>
<tr>
<td>Linker Command File</td>
<td>3-10</td>
</tr>
<tr>
<td>Peripheral Specific Routines</td>
<td>3-11</td>
</tr>
<tr>
<td>Summary</td>
<td>3-12</td>
</tr>
</tbody>
</table>
Traditional and Structure Approach to C Coding

### Traditional Approach to C Coding

```c
#define ADCTRL1 (volatile unsigned int *)0x00007100
#define ADCTRL2 (volatile unsigned int *)0x00007101

void main(void)
{
  *ADCTRL1 = 0x1234; //write entire register
  *ADCTRL2 |= 0x4000; //reset sequencer #1
}
```

**Advantages**
- Simple, fast and easy to type
- Variable names exactly match register names (easy to remember)

**Disadvantages**
- Requires individual masks to be generated to manipulate individual bits
- Cannot easily display bit fields in debugger window
- Will generate less efficient code in many cases

### Structure Approach to C Coding

```c
void main(void)
{
  AdcRegs.ADCTRL1.all = 0x1234; //write entire register
  AdcRegs.ADCTRL2.bit.RST_SEQ1 = 1; //reset sequencer #1
}
```

**Advantages**
- Easy to manipulate individual bits
- Watch window is amazing! (next slide)
- Generates most efficient code (on C28x)

**Disadvantages**
- Can be difficult to remember the structure names (Editor Auto Complete feature to the rescue!)
- More to type (again, Editor Auto Complete feature to the rescue)
Traditional and Structure Approach to C Coding

Built-in CCSv4 Register Window

CCSv4 Watch Window using Structures
Is the Structure Approach Efficient?

The structure approach enables efficient compiler use of DP addressing mode and C28x atomic operations.

C Source Code

```c
// Stop CPU Timer0
CpuTimer0Regs.TCR.bit.TSS = 1;

// Load new 32-bit period value
CpuTimer0Regs.PRD.all = 0x00010000;

// Start CPU Timer0
CpuTimer0Regs.TCR.bit.TSS = 0;
```

Generated Assembly Code*

```
MOVW DP, #0030
OR @4, #0x0010
MOVX XAR4, #0x010000
MOVL @2, XAR4
AND @4, #0xFFEF
```

- Easy to read the code w/o comments
- Bit mask built-in to structure

You could not have coded this example any more efficiently with hand assembly!

* C28x Compiler v5.0.1 with -g and either -o1, -o2, or -o3 optimization level

---

Compare with the #define Approach

The #define approach relies heavily on less-efficient pointers for random memory access, and often does not take advantage of C28x atomic operations.

C Source Code

```c
// Stop CPU Timer0
*TIMER0TCR |= 0x0010;

// Load new 32-bit period value
*TIMER0TPRD32 = 0x00010000;

// Start CPU Timer0
*TIMER0TCR &= 0xFFEF;
```

Generated Assembly Code*

```
MOV @AL,*(0:0x0C04)
ORB AL, #0x10
MOVL *(0:0x0C04), @AL
MOVL XAR5, #0x010000
MOVL XAR4, #0x000C0A
MOVL*XAR4[0], XAR5
MOV @AL, *(0:0x0C04)
AND @AL, #0xFFEF
MOVL *(0:0x0C04), @AL
```

- Hard to read the code w/o comments
- User had to determine the bit mask

* C28x Compiler v5.0.1 with -g and either -o1, -o2, or -o3 optimization level
Naming Conventions

The header files use a familiar set of naming conventions. They are consistent with the Code Composer Studio configuration tool, and generated file naming conventions.

Structure Naming Conventions

- The DSP2833x header files define:
  - All of the peripheral structures
  - All of the register names
  - All of the bit field names
  - All of the register addresses

```
PeripheralName.RegisterName.all                      // Access full 16 or 32-bit register
PeripheralName.RegisterName.half.LSW                 // Access low 16-bits of 32-bit register
PeripheralName.RegisterName.half.MSW                 // Access high 16-bits of 32-bit register
PeripheralName.RegisterName.bit.FieldName            // Access specified bit fields of register
```

Notes:

1. “PeripheralName” are assigned by TI and found in the DSP2833x header files. They are a combination of capital and small letters (i.e. CpuTimer0Regs).
2. “RegisterName” are the same names as used in the data sheet. They are always in capital letters (i.e. TCR, TIM, TPR,...).
3. “FieldName” are the same names as used in the data sheet. They are always in capital letters (i.e. POL, TOG, TSS,...).

Editor Auto Complete to the Rescue!
F2833x C-Code Header Files

The C-code header files consists of .h, c source files, linker command files, and other useful example programs, documentations and add-ins for Code Composer Studio.

DSP2833x Header File Package
(http://www.ti.com, literature # SPRC530)

- Contains everything needed to use the structure approach
- Defines all peripheral register bits and register addresses
- Header file package includes:

```
DSP2833x_headers\include    \rightarrow .h files
DSP2833x_headers\cmd        \rightarrow linker .cmd files
DSP2833x_headers\gel        \rightarrow .gel files for CCS
DSP2833x_examples           \rightarrow CCS3 examples
DSP2833x_examples_ccsv4     \rightarrow CCS4 examples
DSP2823x_examples           \rightarrow CCS3 examples
DSP2823x_examples_ccsv4     \rightarrow CCS4 examples
doc                         \rightarrow documentation
```

A peripheral is programmed by writing values to a set of registers. Sometimes, individual fields are written to as bits, or as bytes, or as entire words. Unions are used to overlap memory (register) so the contents can be accessed in different ways. The header files group all the registers belonging to a specific peripheral.

A DSP2833x_Peripheral.gel GEL file can provide a pull down menu to load peripheral data structures into a watch window. Code Composer Studio can load a GEL file automatically. To include functions to the standard F28335.gel that is part of Code Composer Studio, add:

```c
GEL_LoadGel("base_path/gel/DSP2833x_Peripheral.gel")
```

The GEL file can also be loaded during a Code Composer Studio session by clicking:

File \rightarrow Load GEL...

Peripheral Structure .h File

The DSP2833x_Device.h header file is the main include file. By including this file in the .c source code, all of the peripheral specific .h header files are automatically included. Of course, each specific .h header file can included individually in an application that do not use all the header files, or you can comment out the ones you do not need. (Also includes typedef statements).
Peripheral Structure .h files (1 of 2)

- Contain bits field structure definitions for each peripheral register

```c
/* ADC Individual Register Bit Definitions */
struct ADCTRL1_BITS {     // bits description
    Uint16          rsvd1:4;              // 3:0 reserved
    Uint16          SEQ_CASC:1;   // 4 Cascaded sequencer mode
    Uint16          SEQ_OVRD:1     // 5 Sequencer override
    Uint16          CONT_RUN:1;    // 6 Continuous run
    Uint16          CPS:1;                // 7 ADC core clock prescaler
    Uint16          ACQ_PS:4;         // 11:8 Acquisition window size
    Uint16          SUSMOD:2;       // 13:12 Emulation suspend mode
    Uint16          RESET:1;           // 14 ADC reset
    Uint16          rsvd2:1;              // 15 reserved
};

/* Allow access to the bit fields or entire register */
union ADCTRL1_REG {
    Uint16             all;
    struct ADCTRL1_BITS  bit;
};
```

---

Peripheral Structure .h files (2 of 2)

- The header file package contains a .h file for each peripheral in the device

<table>
<thead>
<tr>
<th>Header File 1</th>
<th>Header File 2</th>
<th>Header File 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSP2833x_Device.h</td>
<td>DSP2833x_AdvCtrl.h</td>
<td>DSP2833x_SysCtrl.h</td>
</tr>
<tr>
<td>DSP2833x_PieCtrl.h</td>
<td>DSP2833x_Adc.h</td>
<td>DSP2833x_CpuTimers.h</td>
</tr>
<tr>
<td>DSP2833x_ECan.h</td>
<td>DSP2833x_ECap.h</td>
<td>DSP2833x_EPwm.h</td>
</tr>
<tr>
<td>DSP2833x_EQep.h</td>
<td>DSP2833x_Gpio.h</td>
<td>DSP2833x_I2c.h</td>
</tr>
<tr>
<td>DSP2833x_Sci.h</td>
<td>DSP2833x_Spi.h</td>
<td>DSP2833x_XIntrupt.h</td>
</tr>
<tr>
<td>DSP2833x_PieVect.h</td>
<td>DSP2833x_DefaultIsr.h</td>
<td>DSP2833x_DMA.h</td>
</tr>
<tr>
<td>DSP2833x_Mcbsp.h</td>
<td>DSP2833x_XIntf.h</td>
<td></td>
</tr>
</tbody>
</table>

- **DSP2833x_Device.h**
  - Main include file (for '2833x and '2823x devices)
  - Will include all other .h files
  - Include this file (directly or indirectly) in each source file:
    ```c
    #include "DSP2833x_Device.h"
    ```
Global Variable Definitions File

With DSP2833x_GlobalVariableDefs.c included in the project all the needed variable definitions are globally defined.

- Declares a global instantiation of the structure for each peripheral
- Each structure is placed in its own section using a DATA_SECTION pragma to allow linking to the correct memory (see next slide)

```c
#include "DSP2833x_Device.h"
...
#pragma DATA_SECTION(AdcRegs,"AdcRegsFile");
volatile struct ADC_REGS AdcRegs;
...
```

- Add this file to your CCS project:

```c
DSP2833x_GlobalVariableDefs.c
```
Mapping Structures to Memory

The data structures describe the register set in detail. And, each instance of the data type (i.e., register set) is unique. Each structure is associated with an address in memory. This is done by (1) creating a new section name via a DATA_SECTION pragma, and (2) linking the new section name to a specific memory in the linker command file.

### Linker Command Files for the Structures

**DSP2833x_nonBIOS.cmd and DSP2833x_BIOS.cmd**

- Links each structure to the address of the peripheral using the structures named section
- non-BIOS and BIOS versions of the .cmd file
- Add one of these files to your CCS project:
  
  - DSP2833x_nonBIOS.cmd
  - DSP2833x_BIOS.cmd

### Linker Command File

When using the header files, the user adds the MEMORY regions that correspond to the CODE_SECTION and DATA_SECTION pragmas found in the .h and global-definitons.c file.

The user can modify their own linker command file, or use the pre-configured linker command files such as EzDSP_RAM_lnk.cmd or F28335.cmd. These files have the peripheral memory regions defined and tied to the individual peripheral.
Peripheral Specific Routines

Peripheral Specific C functions are used to initialize the peripherals. They are used by adding the appropriate .c file to the project.

Peripheral Specific Examples

- Example projects for each peripheral
- Helpful to get you started
- Separate projects for ‘2833x and ‘2823x
  - ‘2823x projects configured for no FPU
Summary

Peripheral Register Header Files Summary

- Easier code development
- Easy to use
- Generates most efficient code
- Increases effectiveness of CCS watch window
- TI has already done all the work!
  - Use the correct header file package for your device:
    - F2803x # SPRC892
    - F2802x # SPRC832
    - F2833x and F2823x # SPRC530
    - F280x and F2801x # SPRC191
    - F2804x # SPRC324
    - F281x # SPRC097

Go to http://www.ti.com and enter the literature number in the keyword search box
Reset and Interrupts

Introduction

This module describes the interrupt process and explains how the Peripheral Interrupt Expansion (PIE) works.

Learning Objectives

- Describe the F28x reset process and post-reset device state
- List the event sequence during an interrupt
- Describe the F28x interrupt structure
Module Topics

Reset and Interrupts  ................................................................. 4-1

Module Topics ............................................................................. 4-2

Reset .......................................................................................... 4-3
Reset - Bootloader ..................................................................... 4-3

Interrupts ...................................................................................... 4-5
Interrupt Processing ................................................................... 4-5
Peripheral Interrupt Expansion (PIE) ....................................... 4-7
PIE Interrupt Vector Table ......................................................... 4-9
Interrupt Response and Latency ................................................. 4-10
Reset

Reset Sources

Watchdog Timer

XRS pin active

To XRS pin

F28x Core

Reset - Bootloader

Reset - Bootloader

Reset
OBJMODE = 0 AMODE = 0
ENPIE = 0 INTM = 1

Reset vector fetched from boot ROM
0x3F FFC0

Bootloader sets
OBJMODE = 1 AMODE = 0
Boot determined by state of GPIO pins

Execution Entry Point
FLASH MO SARAM OTP XINTF

Bootloading Routines
SCI-A / SPI-A I2C eCAN-A McBSP-A GPIO / XINTF
## Bootloader Options

<table>
<thead>
<tr>
<th>GPIO pins</th>
<th>87 / 86 / 85 / 84 / XA15 / XA14 / XA13 / XA12</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 1 1 1</td>
<td>jump to FLASH address 0x33 FFF6</td>
<td></td>
</tr>
<tr>
<td>1 1 1 0</td>
<td>bootloader code to on-chip memory via SCI-A</td>
<td></td>
</tr>
<tr>
<td>1 1 0 1</td>
<td>bootloader external EEPROM to on-chip memory via SPI-A</td>
<td></td>
</tr>
<tr>
<td>1 1 0 0</td>
<td>bootloader external EEPROM to on-chip memory via I2C</td>
<td></td>
</tr>
<tr>
<td>1 0 1 1</td>
<td>Call CAN_Boot to load from eCAN-A mailbox 1</td>
<td></td>
</tr>
<tr>
<td>1 0 1 0</td>
<td>bootloader code to on-chip memory via McBSP-A</td>
<td></td>
</tr>
<tr>
<td>1 0 0 1</td>
<td>jump to XINTF Zone 6 address 0x10 0000 for 16-bit data</td>
<td></td>
</tr>
<tr>
<td>1 0 0 0</td>
<td>jump to XINTF Zone 6 address 0x10 0000 for 32-bit data</td>
<td></td>
</tr>
<tr>
<td>0 1 1 1</td>
<td>jump to OTP address 0x38 0400</td>
<td></td>
</tr>
<tr>
<td>0 1 1 0</td>
<td>bootloader code to on-chip memory via GPIO port A (parallel)</td>
<td></td>
</tr>
<tr>
<td>0 1 0 1</td>
<td>bootloader code to on-chip memory via XINTF (parallel)</td>
<td></td>
</tr>
<tr>
<td>0 1 0 0</td>
<td>jump to M0 SARAM address 0x00 0000</td>
<td></td>
</tr>
<tr>
<td>0 0 1 1</td>
<td>branch to check boot mode</td>
<td></td>
</tr>
<tr>
<td>0 0 1 0</td>
<td>branch to Flash without ADC calibration (TI debug only)</td>
<td></td>
</tr>
<tr>
<td>0 0 0 1</td>
<td>branch to M0 SARAM without ADC calibration (TI debug only)</td>
<td></td>
</tr>
<tr>
<td>0 0 0 0</td>
<td>branch to SCI-A without ADC calibration (TI debug only)</td>
<td></td>
</tr>
</tbody>
</table>

## Reset Code Flow - Summary

- **Execution Entry Point Determined By GPIO Pins**
- **M0 SARAM (1Kw)**
- **OTP (1Kw)**
- **FLASH (256Kw)**
- **Boot ROM (8Kw)**
- **Boot Code 0x3F F9CE**
- **BROM vector (64w) 0x3F F9CE**
- **XINTF Zone 6 (x16 / x32) 0x10 0000**
- **RESET 0x3F FFC0**
Interrupts

Interrupt Sources

Internal Sources
- ePWM, eCAP, eQEP, ADC, SCI, SPI, I2C, eCAN, McBSP, DMA, WD
- TINT2
- TINT1
- TINT0

External Sources
- XINT1 – XINT7
- TZx
- XRS
- XNMI_XINT13

F28x CORE
- XRS
- NMI
- INT1
- INT2
- INT3
- ...
- INT12
- INT13
- INT14

Interrupt Processing

Maskable Interrupt Processing

Conceptual Core Overview

Core Interrupt (IFR) “Latch” (IER) “Switch” (INT) “Global Switch”

- INT1
- INT2
- ...
- ...
- INT14

- A valid signal on a specific interrupt line causes the latch to display a “1” in the appropriate bit
- If the individual and global switches are turned “on” the interrupt reaches the core
Interrupts

### Interrupt Flag Register (IFR)

<table>
<thead>
<tr>
<th>15</th>
<th>14</th>
<th>13</th>
<th>12</th>
<th>11</th>
<th>10</th>
<th>9</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>RTOSINT</td>
<td>DLOGINT</td>
<td>INT14</td>
<td>INT13</td>
<td>INT12</td>
<td>INT11</td>
<td>INT10</td>
<td>INT9</td>
</tr>
<tr>
<td>7</td>
<td>6</td>
<td>5</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>INT8</td>
<td>INT7</td>
<td>INT6</td>
<td>INT5</td>
<td>INT4</td>
<td>INT3</td>
<td>INT2</td>
<td>INT1</td>
</tr>
</tbody>
</table>

Pending: IFR Bit = 1
Absent: IFR Bit = 0

```c
/*** Manual setting/clearing IFR ***/
extern cregister volatile unsigned int IFR;
IFR |= 0x0008; //set INT4 in IFR
IFR &= 0xFFF7; //clear INT4 in IFR
```

- Compiler generates atomic instructions (non-interruptible) for setting/clearing IFR
- If interrupt occurs when writing IFR, interrupt has priority
- IFR(bit) cleared when interrupt is acknowledged by CPU
- Register cleared on reset

### Interrupt Enable Register (IER)

<table>
<thead>
<tr>
<th>15</th>
<th>14</th>
<th>13</th>
<th>12</th>
<th>11</th>
<th>10</th>
<th>9</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>RTOSINT</td>
<td>DLOGINT</td>
<td>INT14</td>
<td>INT13</td>
<td>INT12</td>
<td>INT11</td>
<td>INT10</td>
<td>INT9</td>
</tr>
<tr>
<td>7</td>
<td>6</td>
<td>5</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>INT8</td>
<td>INT7</td>
<td>INT6</td>
<td>INT5</td>
<td>INT4</td>
<td>INT3</td>
<td>INT2</td>
<td>INT1</td>
</tr>
</tbody>
</table>

Enable: Set IER Bit = 1
Disable: Clear IER Bit = 0

```c
/*** Interrupt Enable Register ***/
extern cregister volatile unsigned int IER;
IER |= 0x0008; //enable INT4 in IER
IER &= 0xFFF7; //disable INT4 in IER
```

- Compiler generates atomic instructions (non-interruptible) for setting/clearing IER
- Register cleared on reset
Interrupt Global Mask Bit

ST1

INTM

- INTM used to globally enable/disable interrupts:
  - Enable: INTM = 0
  - Disable: INTM = 1 (reset value)
- INTM modified from assembly code only:

```asm
/*** Global Interrupts ***/
asm(" CLRC INTM");  // enable global interrupts
asm(" SETC INTM");  // disable global interrupts
```

Peripheral Interrupt Expansion (PIE)
## F2833x PIE Interrupt Assignment Table

<table>
<thead>
<tr>
<th></th>
<th>INTx.8</th>
<th>INTx.7</th>
<th>INTx.6</th>
<th>INTx.5</th>
<th>INTx.4</th>
<th>INTx.3</th>
<th>INTx.2</th>
<th>INTx.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>INT1</td>
<td>WAKEINT</td>
<td>TINT0</td>
<td>ADCINT</td>
<td>XINT2</td>
<td>XINT1</td>
<td>SEQ2INT</td>
<td>SEQ1INT</td>
<td></td>
</tr>
<tr>
<td>INT2</td>
<td>EPWM6 _TZINT</td>
<td>EPWM5 _TZINT</td>
<td>EPWM4 _TZINT</td>
<td>EPWM3 _TZINT</td>
<td>EPWM2 _TZINT</td>
<td>EPWM1 _TZINT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT3</td>
<td>EPWM6 _INT</td>
<td>EPWM5 _INT</td>
<td>EPWM4 _INT</td>
<td>EPWM3 _INT</td>
<td>EPWM2 _INT</td>
<td>EPWM1 _INT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT4</td>
<td>ECAPS _INT</td>
<td>ECAP5 _INT</td>
<td>ECAP4 _INT</td>
<td>ECAP3 _INT</td>
<td>ECAP2 _INT</td>
<td>ECAP1 _INT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT6</td>
<td>MXINTA</td>
<td>MRINTA</td>
<td>MXINTB</td>
<td>MRINTB</td>
<td>SPITXINTA</td>
<td>SPIRXINTA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT7</td>
<td>DINTCH6</td>
<td>DINTCH5</td>
<td>DINTCH4</td>
<td>DINTCH3</td>
<td>DINTCH2</td>
<td>DINTCH1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT8</td>
<td>SCITXINTC</td>
<td>SCIRXINTC</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT9</td>
<td>ECAN1 _INTB</td>
<td>ECAN0 _INTB</td>
<td>ECAN1 _INTA</td>
<td>ECAN0 _INTA</td>
<td>SCITXINTB</td>
<td>SCIRXINTB</td>
<td>SCITXINTA</td>
<td>SCIRXINTA</td>
</tr>
<tr>
<td>INT10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT12</td>
<td>LUF</td>
<td>LVF</td>
<td>XINT7</td>
<td>XINT6</td>
<td>XINT5</td>
<td>XINT4</td>
<td>XINT3</td>
<td></td>
</tr>
</tbody>
</table>

## PIE Registers

### PIEIFRx register (x = 1 to 12)

<table>
<thead>
<tr>
<th></th>
<th>15</th>
<th>8</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>//</td>
<td>reserved</td>
<td>INTx.8</td>
<td>INTx.7</td>
<td>INTx.6</td>
<td>INTx.5</td>
<td>INTx.4</td>
<td>INTx.3</td>
<td>INTx.2</td>
<td>INTx.1</td>
<td></td>
</tr>
</tbody>
</table>

### PIEIERx register (x = 1 to 12)

<table>
<thead>
<tr>
<th></th>
<th>15</th>
<th>8</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>//</td>
<td>reserved</td>
<td>INTx.8</td>
<td>INTx.7</td>
<td>INTx.6</td>
<td>INTx.5</td>
<td>INTx.4</td>
<td>INTx.3</td>
<td>INTx.2</td>
<td>INTx.1</td>
<td></td>
</tr>
</tbody>
</table>

### PIE Interrupt Acknowledge Register (PIEACK)

|     | 15 | 12 | 11 | 10 | 9 | 8 | 7 | 6 | 5 | 4 | 3 | 2 | 1 | 0 |
|-----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|
| //   | reserved | PIEACKx |        |        |        |        |        |        |        |        |        |        |        |        |        |

### PIECTRL register

<table>
<thead>
<tr>
<th></th>
<th>15</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PIEVECT</td>
<td>ENPIE</td>
</tr>
</tbody>
</table>

#include "DSP2833x_Device.h"

PieCtrlRegs.PIE1FR1.bit.INTx4 = 1; //manually set IFR for XINT1 in PIE group 1
PieCtrlRegs.PIE1ER3.bit.INTx5 = 1; //enable EPWM5_INT in PIE group 3
PieCtrlRegs.PIEACK.all = 0x0004; //acknowledge the PIE group 3
PieCtrlRegs.PIECTRL.bit.ENPIE = 1; //enable the PIE

---

4 - 8 C2000 Delfino Workshop - Reset and Interrupts
PIE Interrupt Vector Table

Default Interrupt Vector Table at Reset

<table>
<thead>
<tr>
<th>Vector</th>
<th>Offset</th>
</tr>
</thead>
<tbody>
<tr>
<td>RESET</td>
<td>00</td>
</tr>
<tr>
<td>INT1</td>
<td>02</td>
</tr>
<tr>
<td>INT2</td>
<td>04</td>
</tr>
<tr>
<td>INT3</td>
<td>06</td>
</tr>
<tr>
<td>INT4</td>
<td>08</td>
</tr>
<tr>
<td>INT5</td>
<td>0A</td>
</tr>
<tr>
<td>INT6</td>
<td>0C</td>
</tr>
<tr>
<td>INT7</td>
<td>0E</td>
</tr>
<tr>
<td>INT8</td>
<td>10</td>
</tr>
<tr>
<td>INT9</td>
<td>12</td>
</tr>
<tr>
<td>INT10</td>
<td>14</td>
</tr>
<tr>
<td>INT11</td>
<td>16</td>
</tr>
<tr>
<td>INT12</td>
<td>18</td>
</tr>
<tr>
<td>INT13</td>
<td>1A</td>
</tr>
<tr>
<td>INT14</td>
<td>1C</td>
</tr>
<tr>
<td>DATALOG</td>
<td>1E</td>
</tr>
<tr>
<td>RTOSINT</td>
<td>20</td>
</tr>
<tr>
<td>EMUINT</td>
<td>22</td>
</tr>
<tr>
<td>NMI</td>
<td>24</td>
</tr>
<tr>
<td>ILLEGAL</td>
<td>26</td>
</tr>
<tr>
<td>USER 1-12</td>
<td>28-3E</td>
</tr>
</tbody>
</table>

Remapped

- PIE vector location – 0x00 0D00 – 256 words in data memory
- RESET and INT1-INT12 vector locations are re-mapped
- CPU vectors are re-mapped to 0x00 0D00 in data memory

PIE Vector Mapping (ENPIE = 1)

<table>
<thead>
<tr>
<th>Vector Name</th>
<th>PIE Address</th>
<th>PIE Vector Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset</td>
<td>0x00 0D00</td>
<td>Reset fetched from Boot ROM 0x3F FFC0</td>
</tr>
<tr>
<td>INT1</td>
<td>0x00 0D02</td>
<td>INT1 remapped to PIE group below</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>INTx remapped to PIE group below</td>
</tr>
<tr>
<td>INT12</td>
<td>0x00 0D18</td>
<td>INT12 remapped to PIE group below</td>
</tr>
<tr>
<td>INT13</td>
<td>0x00 0D1A</td>
<td>CPU Timer 1</td>
</tr>
<tr>
<td>INT14</td>
<td>0x00 0D1C</td>
<td>CPU Timer 2</td>
</tr>
<tr>
<td>DATALOG</td>
<td>0x00 0D1E</td>
<td>CPU Data Logging Interrupt</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>USER12</td>
<td>0x00 0D3E</td>
<td>User Defined Trap</td>
</tr>
<tr>
<td>INT1.1</td>
<td>0x00 0D40</td>
<td>PIE INT1.1 Interrupt Vector</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>INT1.8</td>
<td>0x00 0D4E</td>
<td>PIE INT1.8 Interrupt Vector</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>INT12.1</td>
<td>0x00 0DF0</td>
<td>PIE INT12.1 Interrupt Vector</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>INT12.8</td>
<td>0x00 0DFE</td>
<td>PIE INT12.8 Interrupt Vector</td>
</tr>
</tbody>
</table>

- PIE vector location – 0x00 0D00 – 256 words in data memory
- RESET and INT1-INT12 vector locations are re-mapped
- CPU vectors are re-mapped to 0x00 0D00 in data memory
Interrupts

Device Vector Mapping - Summary

Interrupt Response and Latency

Interrupt Response - Hardware Sequence

<table>
<thead>
<tr>
<th>CPU Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Registers → stack</td>
<td>14 Register words auto saved</td>
</tr>
<tr>
<td>0 → IFR (bit)</td>
<td>Clear corresponding IFR bit</td>
</tr>
<tr>
<td>0 → IER (bit)</td>
<td>Clear corresponding IER bit</td>
</tr>
<tr>
<td>1 → INTM/DBGM</td>
<td>Disable global ints/debug events</td>
</tr>
<tr>
<td>Vector → PC</td>
<td>Loads PC with int vector address</td>
</tr>
<tr>
<td>Clear other status bits</td>
<td>Clear LOOP, EALLOW, IDLESTAT</td>
</tr>
</tbody>
</table>

Note: some actions occur simultaneously, none are interruptible

<table>
<thead>
<tr>
<th>T</th>
<th>ST0</th>
</tr>
</thead>
<tbody>
<tr>
<td>AH</td>
<td>AL</td>
</tr>
<tr>
<td>PH</td>
<td>PL</td>
</tr>
<tr>
<td>AR1</td>
<td>AR0</td>
</tr>
<tr>
<td>DP</td>
<td>ST1</td>
</tr>
<tr>
<td>DBSTAT</td>
<td>IER</td>
</tr>
<tr>
<td>PC(msw)</td>
<td>PC(lsw)</td>
</tr>
</tbody>
</table>
Interrupt Latency

- Minimum latency (to when real work occurs in the ISR):
  - Internal interrupts: 14 cycles
  - External interrupts: 16 cycles
- Maximum latency: Depends on wait states, INTM, etc.

Assumes ISR in internal RAM

 ISR instruction executed on next cycle

Cycles

1. Save return address
2. Sync ext. signal (ext. interrupt only)
3. F1/F2/D1 of ISR instruction (3 reg. pairs saved)
4. Get vector and place in PC (3 reg. pairs saved)
5. Recognition delay (3), SP alignment (1), interrupt placed in pipeline

Internal interrupt occurs here

External interrupt occurs here

ISR instruction executed on next cycle

Sync ext. signal

(ex. interrupt only)

Recognition delay (3), SP alignment (1), interrupt placed in pipeline

Get vector and place in PC (3 reg. pairs saved)

F1/F2/D1 of ISR instruction (3 reg. pairs saved)

Save return address

D2/R1/R2 of ISR instruction

ISR instruction executed on next cycle

C2000 Delfino Workshop - Reset and Interrupts
Interrupts
System Initialization

Introduction

This module discusses the operation of the OSC/PLL-based clock module and watchdog timer. Also, the general-purpose digital I/O ports, external interrupts, various low power modes and the EALLOW protected registers will be covered.

Learning Objectives

- OSC/PLL Clock Module
- Watchdog Timer
- General Purpose Digital I/O
- External Interrupts
- Low Power Modes
- Register Protection
## Module Topics

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Initialization</td>
<td>5-1</td>
</tr>
<tr>
<td>Oscillator/PLL Clock Module</td>
<td>5-2</td>
</tr>
<tr>
<td>Watchdog Timer</td>
<td>5-3</td>
</tr>
<tr>
<td>General-Purpose Digital I/O</td>
<td>5-5</td>
</tr>
<tr>
<td>External Interrupts</td>
<td>5-9</td>
</tr>
<tr>
<td>Low Power Modes</td>
<td>5-12</td>
</tr>
<tr>
<td>Register Protection</td>
<td>5-13</td>
</tr>
<tr>
<td>Lab 5: System Initialization</td>
<td>5-15</td>
</tr>
</tbody>
</table>

The OSC/PLL clock module provides all the necessary clocking signals for C28x devices. The PLL has a 4-bit ratio control to select different CPU clock rates. Two modes of operation are supported – crystal operation, and external clock source operation. Crystal operation allows the use of an external crystal/resonator to provide the time base to the device. External clock source operation allows the internal oscillator to be bypassed, and the device clocks are generated from an external clock source input on the XCLKIN pin. The watchdog receives a clock signal from OSCCLK. The C28x core provides a SYSCLKOUT clock signal. This signal is prescaled to provide a clock source for some of the on-chip peripherals through the high-speed and low-speed peripheral clock prescalers. Other peripherals are clocked by SYSCLKOUT and use their own clock prescalers for operation.
High / Low – Speed Peripheral Clock
Prescaler Registers
(lab file: SysCtrl.c)

The peripheral clock control register allows individual peripheral clock signals to be enabled or
disabled. If a peripheral is not being used, its clock signal could be disabled, thus reducing power
consumption.
Watchdog Timer

Watchdog Timer

- Resets the C28x if the CPU crashes
  - Watchdog counter runs independent of CPU
  - If counter overflows, a reset or interrupt is triggered (user selectable)
  - CPU must write correct data key sequence to reset the counter before overflow
- Watchdog must be serviced or disabled within 131,072 WDCLK cycles after reset
- This translates to 4.37 ms with a 30 MHz WDCLK

The watchdog timer provides a safeguard against CPU crashes by automatically initiating a reset if it is not serviced by the CPU at regular intervals. In motor control applications, this helps protect the motor and drive electronics when control is lost due to a CPU lockup. Any CPU reset will revert the PWM outputs to a high-impedance state, which should turn off the power converters in a properly designed system.

The watchdog timer is running immediately after system power-up/reset, and must be dealt with by software soon after. Specifically, you have 4.37ms (for a 150 MHz device) after any reset before a watchdog initiated reset will occur. This translates into 131,072 instruction cycles, which is a seemingly tremendous amount! Indeed, this is plenty of time to get the watchdog configured as desired and serviced. A failure of your software to properly handle the watchdog after reset could cause an endless cycle of watchdog initiated resets to occur.
Watchdog Timer Module
(lab file: Watchdog.c)

Watchdog Timer Period Selection

<table>
<thead>
<tr>
<th>WDPS Bits</th>
<th>FRC rollover</th>
<th>WD timeout period @ 30 MHz OSCCLK</th>
</tr>
</thead>
<tbody>
<tr>
<td>00x:</td>
<td>1</td>
<td>4.37 ms *</td>
</tr>
<tr>
<td>010:</td>
<td>2</td>
<td>8.74 ms</td>
</tr>
<tr>
<td>011:</td>
<td>4</td>
<td>17.48 ms</td>
</tr>
<tr>
<td>100:</td>
<td>8</td>
<td>34.96 ms</td>
</tr>
<tr>
<td>101:</td>
<td>16</td>
<td>69.92 ms</td>
</tr>
<tr>
<td>110:</td>
<td>32</td>
<td>139.84 ms</td>
</tr>
<tr>
<td>111:</td>
<td>64</td>
<td>279.68 ms</td>
</tr>
</tbody>
</table>

* reset default

- Remember: Watchdog starts counting immediately after reset is released!
- Reset default with WDCLK = 30 MHz computed as
  \( (1/30 \text{ MHz}) \times 512 \times 256 = 4.37 \text{ ms} \)
Watchdog Timer

Watchdog Timer Control Register
SysCtrlRegs.WDCR (lab file: Watchdog.c)

WD Flag Bit
Gets set when the WD causes a reset
• Writing a 1 clears this bit
• Writing a 0 has no effect

Watchdog Disable Bit
Write 1 to disable
(Functions only if WD OVERRIDE bit in SCSR is equal to 1)

Logic Check Bits
Write as 101 or reset immediately triggered

WD Prescale Selection Bits

<table>
<thead>
<tr>
<th>WDPS</th>
<th>WDCLK</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 0 0</td>
<td>OSCCLK / 512 / 1</td>
</tr>
<tr>
<td>0 0 1</td>
<td>OSCCLK / 512 / 2</td>
</tr>
<tr>
<td>0 1 0</td>
<td>OSCCLK / 512 / 4</td>
</tr>
<tr>
<td>0 1 1</td>
<td>OSCCLK / 512 / 8</td>
</tr>
<tr>
<td>1 0 0</td>
<td>OSCCLK / 512 / 16</td>
</tr>
<tr>
<td>1 0 1</td>
<td>OSCCLK / 512 / 32</td>
</tr>
<tr>
<td>1 1 0</td>
<td>OSCCLK / 512 / 64</td>
</tr>
</tbody>
</table>

Resetting the Watchdog
SysCtrlRegs.WDKEY (lab file: Watchdog.c)

- WDKEY write values:
  55h - counter enabled for reset on next AAh write
  AAh - counter set to zero if reset enabled
- Writing any other value has no effect
- Watchdog should not be serviced solely in an ISR
  • If main code crashes, but interrupt continues to execute, the watchdog will not catch the crash
  • Could put the 55h WDKEY in the main code, and the AAh WDKEY in an ISR; this catches main code crashes and also ISR crashes
Watchdog Timer

### WDKEY Write Results

<table>
<thead>
<tr>
<th>Sequential Step</th>
<th>Value Written to WDKEY</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>AAh</td>
<td>No action</td>
</tr>
<tr>
<td>2</td>
<td>AAh</td>
<td>No action</td>
</tr>
<tr>
<td>3</td>
<td>55h</td>
<td>WD counter enabled for reset on next AAh write</td>
</tr>
<tr>
<td>4</td>
<td>55h</td>
<td>WD counter enabled for reset on next AAh write</td>
</tr>
<tr>
<td>5</td>
<td>55h</td>
<td>WD counter enabled for reset on next AAh write</td>
</tr>
<tr>
<td>6</td>
<td>AAh</td>
<td>WD counter is reset</td>
</tr>
<tr>
<td>7</td>
<td>AAh</td>
<td>No action</td>
</tr>
<tr>
<td>8</td>
<td>55h</td>
<td>WD counter enabled for reset on next AAh write</td>
</tr>
<tr>
<td>9</td>
<td>AAh</td>
<td>WD counter is reset</td>
</tr>
<tr>
<td>10</td>
<td>55h</td>
<td>WD counter enabled for reset on next AAh write</td>
</tr>
<tr>
<td>11</td>
<td>23h</td>
<td>No effect; WD counter not reset on next AAh write</td>
</tr>
<tr>
<td>12</td>
<td>AAh</td>
<td>No action due to previous invalid value</td>
</tr>
<tr>
<td>13</td>
<td>55h</td>
<td>WD counter enabled for reset on next AAh write</td>
</tr>
<tr>
<td>14</td>
<td>AAh</td>
<td>WD counter is reset</td>
</tr>
</tbody>
</table>

### System Control and Status Register

SysCtrlRegs.SCSR (lab file: Watchdog.c)

**WD Override (protect bit)**

Protects WD from being disabled

- 0 = WDDIS bit in WDCR has no effect (WD cannot be disabled)
- 1 = WDDIS bit in WDCR can disable the watchdog

- This bit is a clear-only bit (write 1 to clear)
- The reset default of this bit is a 1

<table>
<thead>
<tr>
<th>Bit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>15 - 3</td>
<td>reserved</td>
</tr>
<tr>
<td>2</td>
<td>WDINTS</td>
</tr>
<tr>
<td>1</td>
<td>WDENINT</td>
</tr>
<tr>
<td>0</td>
<td>WDOVERRIDE</td>
</tr>
</tbody>
</table>

**WD Interrupt Status (read only)**

- 0 = active
- 1 = not active

**WD Enable Interrupt**

- 0 = WD generates a DSP reset
- 1 = WD generates a WDINT interrupt
General-Purpose Digital I/O

F2833x GPIO Grouping Overview
(lab file: Gpio.c)

F2833x GPIO Pin Block Diagram
(lab file: Gpio.c)

* See device datasheet for pin function selection matrices
General-Purpose Digital I/O

F2833x GPIO Input Qualification

- Qualification available on ports A & B (GPIO 0 - 63) only
- Individually selectable per pin
  - no qualification (peripherals only)
  - sync to SYSCLKOUT only
  - qualify 3 samples
  - qualify 6 samples
- Port C pins are fixed as 'sync to SYSCLKOUT'

F2833x GPIO Input Qual Registers

GpioCtrlRegs.register (lab file: Gpio.c)

GPAQSEL1 / GPAQSEL2 / GPBQSEL1 / GPBQSEL2

| 31 | 30 | 29 | 28 | 27 | 26 | 25 | 24 | 23 | 22 | 21 | 20 | 19 | 18 | 17 | 16 | 15 | 14 | 13 | 12 | 11 | 10 | 9  | 8  | 7  | 6  | 5  | 4  | 3  | 2  | 1  | 0  | 16 pins configured per register |
|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|---
### C2833x GPIO Control Registers

**GpioCtrlRegs.register (lab file: Gpio.c)**

<table>
<thead>
<tr>
<th>Register</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPACTRL</td>
<td>GPIO A Control Register [GPIO 0 – 31]</td>
</tr>
<tr>
<td>GPAQSEL1</td>
<td>GPIO A Qualifier Select 1 Register [GPIO 0 – 15]</td>
</tr>
<tr>
<td>GPAQSEL2</td>
<td>GPIO A Qualifier Select 2 Register [GPIO 16 – 31]</td>
</tr>
<tr>
<td>GPAMUX1</td>
<td>GPIO A Mux1 Register [GPIO 0 – 15]</td>
</tr>
<tr>
<td>GPAMUX2</td>
<td>GPIO A Mux2 Register [GPIO 16 – 31]</td>
</tr>
<tr>
<td>GPADIR</td>
<td>GPIO A Direction Register [GPIO 0 – 31]</td>
</tr>
<tr>
<td>GPAPUD</td>
<td>GPIO A Pull-Up Disable Register [GPIO 0 – 31]</td>
</tr>
<tr>
<td>GPBCTRL</td>
<td>GPIO B Control Register [GPIO 32 – 63]</td>
</tr>
<tr>
<td>GPBQSEL1</td>
<td>GPIO B Qualifier Select 1 Register [GPIO 32 – 47]</td>
</tr>
<tr>
<td>GPBQSEL2</td>
<td>GPIO B Qualifier Select 2 Register [GPIO 48 – 63]</td>
</tr>
<tr>
<td>GPBMUX1</td>
<td>GPIO B Mux1 Register [GPIO 32 – 47]</td>
</tr>
<tr>
<td>GPBMUX2</td>
<td>GPIO B Mux2 Register [GPIO 48 – 63]</td>
</tr>
<tr>
<td>GPBDIR</td>
<td>GPIO B Direction Register [GPIO 32 – 63]</td>
</tr>
<tr>
<td>GPBPUD</td>
<td>GPIO B Pull-Up Disable Register [GPIO 32 – 63]</td>
</tr>
<tr>
<td>GPCMUX1</td>
<td>GPIO C Mux1 Register [GPIO 64 – 79]</td>
</tr>
<tr>
<td>GPCMUX2</td>
<td>GPIO C Mux2 Register [GPIO 80 – 87]</td>
</tr>
<tr>
<td>GPCDIR</td>
<td>GPIO C Direction Register [GPIO 64 – 87]</td>
</tr>
<tr>
<td>GPCPUD</td>
<td>GPIO C Pull-Up Disable Register [GPIO 64 – 87]</td>
</tr>
</tbody>
</table>

### C2833x GPIO Data Registers

**GpioDataRegs.register (lab file: Gpio.c)**

<table>
<thead>
<tr>
<th>Register</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPADAT</td>
<td>GPIO A Data Register [GPIO 0 – 31]</td>
</tr>
<tr>
<td>GPASET</td>
<td>GPIO A Data Set Register [GPIO 0 – 31]</td>
</tr>
<tr>
<td>GPPCLEAR</td>
<td>GPIO A Data Clear Register [GPIO 0 – 31]</td>
</tr>
<tr>
<td>GPTOGGLE</td>
<td>GPIO A Data Toggle [GPIO 0 – 31]</td>
</tr>
<tr>
<td>GPBDAT</td>
<td>GPIO B Data Register [GPIO 32 – 63]</td>
</tr>
<tr>
<td>GPBSET</td>
<td>GPIO B Data Set Register [GPIO 32 – 63]</td>
</tr>
<tr>
<td>GPBCLEAR</td>
<td>GPIO B Data Clear Register [GPIO 32 – 63]</td>
</tr>
<tr>
<td>GPTOGGLE</td>
<td>GPIO B Data Toggle [GPIO 32 – 63]</td>
</tr>
<tr>
<td>GPCDAT</td>
<td>GPIO C Data Register [GPIO 64 – 87]</td>
</tr>
<tr>
<td>GPCSET</td>
<td>GPIO C Data Set Register [GPIO 64 – 87]</td>
</tr>
<tr>
<td>GPCCLEAR</td>
<td>GPIO C Data Clear Register [GPIO 64 – 87]</td>
</tr>
<tr>
<td>GPTOGGLE</td>
<td>GPIO C Data Toggle [GPIO 64 – 87]</td>
</tr>
</tbody>
</table>
External Interrupts

- 8 external interrupt signals: XNMI, XINT1-7
- The signals can be mapped to a variety of pins
  - XNMI, XINT1-2 can be mapped to any of GPIO0-31
  - XINT3-7 can be mapped to any of GPIO32-63
- The eCAP pins and their interrupts can be used as additional external interrupts if needed
- XNMI, XINT1, and XINT2 also each have a free-running 16-bit counter that measures the elapsed time between interrupts
  - The counter resets to zero each time the interrupt occurs

External Interrupt Registers

<table>
<thead>
<tr>
<th>Interrupt</th>
<th>Pin Selection Register (GpioIntRegs.register)</th>
<th>Configuration Register (XInterruptRegs.register)</th>
<th>Counter Register (XInterruptRegs.register)</th>
</tr>
</thead>
<tbody>
<tr>
<td>XNMI</td>
<td>GPIOXNMISEL</td>
<td>XNMICR</td>
<td>XNMICTR</td>
</tr>
<tr>
<td>XINT1</td>
<td>GPIOXINT1SEL</td>
<td>XINT1CR</td>
<td>XINT1CTR</td>
</tr>
<tr>
<td>XINT2</td>
<td>GPIOXINT2SEL</td>
<td>XINT2CR</td>
<td>XINT2CTR</td>
</tr>
<tr>
<td>XINT3</td>
<td>GPIOXINT3SEL</td>
<td>XINT3CR</td>
<td>-</td>
</tr>
<tr>
<td>XINT4</td>
<td>GPIOXINT4SEL</td>
<td>XINT4CR</td>
<td>-</td>
</tr>
<tr>
<td>XINT5</td>
<td>GPIOXINT5SEL</td>
<td>XINT5CR</td>
<td>-</td>
</tr>
<tr>
<td>XINT6</td>
<td>GPIOXINT6SEL</td>
<td>XINT6CR</td>
<td>-</td>
</tr>
<tr>
<td>XINT7</td>
<td>GPIOXINT7SEL</td>
<td>XINT7CR</td>
<td>-</td>
</tr>
</tbody>
</table>

- Pin Selection Register chooses which pin(s) the signal comes out on
- Configuration Register controls the enable/disable and polarity
- Counter Register holds the interrupt counter
Low Power Modes

<table>
<thead>
<tr>
<th>Low Power Mode</th>
<th>CPU Logic Clock</th>
<th>Peripheral Logic Clock</th>
<th>Watchdog Clock</th>
<th>PLL / OSC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal Run</td>
<td>on</td>
<td>on</td>
<td>on</td>
<td>on</td>
</tr>
<tr>
<td>IDLE</td>
<td>off</td>
<td>on</td>
<td>on</td>
<td>on</td>
</tr>
<tr>
<td>STANDBY</td>
<td>off</td>
<td>off</td>
<td>on</td>
<td>on</td>
</tr>
<tr>
<td>HALT</td>
<td>off</td>
<td>off</td>
<td>off</td>
<td>off</td>
</tr>
</tbody>
</table>

See device datasheet for power consumption in each mode

Low Power Mode Control Register 0
SysCtrlRegs.LPMCR0 (lab file: SysCtrl.c)

- **WDINTE**: Watchdog Interrupt
- **reserved**: Wake from STANDBY
- **QUALSTDBY**: GPIO signal qualification
- **LPM0**: Low Power Mode Selection

**Watchdog Interrupt**
- 0 = disable (default)
- 1 = enable

**Wake from STANDBY**
- 000000 = 2 OSCCLKs
- 000001 = 3 OSCCLKs
- ...111111 = 65 OSCCLKS (default)

**GPIO signal qualification**
- 000000 = 2 OSCCLKs
- 000001 = 3 OSCCLKs
- ...111111 = 65 OSCCLKS (default)

**Low Power Mode Mode Entering**
1. Set LPM bits
2. Enable desired exit interrupt(s)
3. Execute IDLE instruction
4. The power down sequence of the hardware depends on LP mode

**Low Power Mode Selection**
- 00 = Idle (default)
- 01 = Standby
- 1x = Halt

*QUALSTDBY will qualify the GPIO wakeup signal in series with the GPIO port qualification. This is useful when GPIO port qualification is not available or insufficient for wake-up purposes.*
Low Power Modes

Low Power Mode Exit

<table>
<thead>
<tr>
<th>Low Power Mode</th>
<th>Exit Interrupt</th>
<th>RESET or XNMI</th>
<th>GPIO Port A Signal</th>
<th>Watchdog Interrupt</th>
<th>Any Enabled Interrupt</th>
</tr>
</thead>
<tbody>
<tr>
<td>IDLE</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>STANDBY</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>HALT</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
</tbody>
</table>

GPIO Low Power Wakeup Select

SysCtrlRegs.GPIOLPMSEL

GPIO31 GPIO30 GPIO29 GPIO28 GPIO27 GPIO26 GPIO25 GPIO24
GPIO23 GPIO22 GPIO21 GPIO20 GPIO19 GPIO18 GPIO17 GPIO16
GPIO15 GPIO14 GPIO13 GPIO12 GPIO11 GPIO10 GPIO9 GPIO8
GPIO7 GPIO6 GPIO5 GPIO4 GPIO3 GPIO2 GPIO1 GPIO0

Wake device from HALT and STANDBY mode (GPIO Port A)
0 = disable (default)
1 = enable
Register Protection

Write-Read Protection
DevEmuRegs.PROTSTART & DevEmuRegs.PROTRANGE

Suppose you need to write to a peripheral register and then read a different register for the same peripheral (e.g., write to control, read from status register)?

- CPU pipeline protects W-R order for the same address
- Write-Read protection mechanism protects W-R order for different addresses
  - Configured by PROTSTART and PROTRANGE registers
  - Default values for these registers protect the address range 0x4000 to 0x7FFF
  - Default values typically sufficient

Note: PF0 is not protected by default because the flexibility of PROTSTART and PROTRANGE are such that M0 and M1 SARAM blocks would also need to be protected, thereby reducing the performance of this RAM. See TMS320x2833x, 2823x System Control and Interrupts Reference Guide, #SPRUFB0

EALLOW Protection (1 of 2)

- EALLOW stands for Emulation Allow
- Code access to protected registers allowed only when EALLOW = 1 in the ST1 register
- The emulator can always access protected registers
- EALLOW bit controlled by assembly level instructions
  - ‘EALLOW’ sets the bit (register access enabled)
  - ‘EDIS’ clears the bit (register access disabled)
- EALLOW bit cleared upon ISR entry, restored upon exit
EALLOW Protection (2 of 2)

The following registers are protected:

- Device Emulation
- Flash
- Code Security Module
- PIE Vector Table
- DMA (most registers)
- eCAN/B (control registers only; mailbox RAM not protected)
- ePWM1 - 6 (some registers)
- GPIO (control registers only)
- System Control

See device datasheet and peripheral users guides for detailed listings

EALLOW register access C-code example:

```
asm(" EALLOW");           // enable protected register access
SysCtrlRegs.WDKEY=0x55;   // write to the register
asm(" EDIS");             // disable protected register access
```
Lab 5: System Initialization

- **Objective**

  The objective of this lab is to perform the processor system initialization. Additionally, the peripheral interrupt expansion (PIE) vectors will be initialized and tested using the information discussed in the previous module. This initialization process will be used again in all of the lab exercises throughout this workshop. The system initialization for this lab will consist of the following:

  - Setup the clock module – PLL, HISPCP = /1, LOSPCP = /4, low-power modes to default values, enable all module clocks
  - Disable the watchdog – clear WD flag, disable watchdog, WD prescale = 1
  - Setup watchdog system and control register – DO NOT clear WD OVERRIDE bit, WD generate a CPU reset
  - Setup shared I/O pins – set all GPIO pins to GPIO function (e.g. a "00" setting for GPIO function, and a “01”, “10”, or “11” setting for a peripheral function.)

  The first part of the lab exercise will setup the system initialization and test the watchdog operation by having the watchdog cause a reset. In the second part of the lab exercise the PIE vectors will be added and tested by using the watchdog to generate an interrupt. This lab will make use of the DSP2833x C-code header files to simplify the programming of the device, as well as take care of the register definitions and addresses. Please review these files, and make use of them in the future, as needed.

- **Procedure**

  **Create a New Project**

  1. Create a new project (File → New → CCS Project) and name it **Lab5**. Uncheck the “Use default location” box. Using the Browse... button navigate to: C:\C28x\Labs\Lab5\Project. Click OK and then click Next. The next three windows should default to the options previously selected (project type C2000, no inter-project dependencies selected, and device variant TMS320F28335 – be sure to set the “Linker Command File” to <none>). Use the defaults and at the last window click Finish.

  2. Right-click on Lab5 in the C/C++ Projects window and add the following files to the project (Add Files to Project...) from C:\C28x\Labs\Lab5\Files:

      CodeStartBranch.asm  Lab.h
      DelayUs.asm          Lab_5_6_7.cmd
      DSP2833x_DefaultIsr.h Main_5.c
      DSP2833x_GlobalVariableDefs.c SysCtrl.c
      DSP2833x_Headers_nonBIOS.cmd Watchdog.c
      Gpio.c
Do not add DefaultIsr_5.c, PieCtrl_5_6_7_8_9_10.c, and PieVect_5_6_7_8_9_10.c. These files will be added and used with the interrupts in the second part of this lab exercise.

Project Build Options

3. Setup the build options by right-clicking on Lab5 in the C/C++ Projects window and select Properties. Then select the “C/C++ Build” Category. Be sure that the Tool Settings tab is selected.

4. Under “C2000 Linker” select “Basic Options” and set the Stack Size to 0x200.

5. Next we need to setup the include search path to include the peripheral register header files. Under “C2000 Compiler” select “Include Options”. In the box that opens click the Add icon (first icon with green plus sign). Then in the “Add directory path” window type:

\${PROJECT_ROOT}/../../DSP2833x_headers/include

Click OK to include the search path. Finally, click OK to save and close the build options window.

Modify Memory Configuration

6. Open and inspect the linker command file Lab_5_6_7.cmd. Notice that the user defined section “codestart” is being linked to a memory block named BEGIN_M0. The codestart section contains code that branches to the code entry point of the project. The bootloader must branch to the codestart section at the end of the boot process. Recall that the “Jump to M0 SARAM” bootloader mode branches to address 0x000000 upon bootloader completion.

Modify the linker command file Lab_5_6_7.cmd to create a new memory block named BEGIN_M0: origin = 0x000000, length = 0x0002, in program memory. You will also need to modify the existing memory block M0SARAM in data memory to avoid any overlaps with this new memory block.

Setup System Initialization

7. Modify SysCtrl.c and Watchdog.c to implement the system initialization as described in the objective for this lab.

8. Open and inspect Gpio.c. Notice that the shared I/O pins have been set to the GPIO function. Save your work and close the modified files.

Build and Load

9. Click the “Build” button and watch the tools run in the Console window. Check for errors in the Problems window.
10. Click the “Debug” button (green bug). The “Debug Perspective” view should open, the program will load automatically, and you should now be at the start of main().

**Run the Code – Watchdog Reset**

11. Place the cursor in the “main loop” section (on the `asm(` “ NOP”`) ; ` instruction line) and right click the mouse key and select Run To Line. This is the same as setting a breakpoint on the selected line, running to that breakpoint, and then removing the breakpoint.

12. Place the cursor on the first line of code in main() and set a breakpoint by right clicking the mouse key and select Toggle Breakpoint. Notice that line is highlighted with a blue dot indicating that the breakpoint has been set. Alternately, you can double-click in the line number field to the left of the code line to set the breakpoint. The breakpoint is set to prove that the watchdog is disabled. If the watchdog causes a reset, code execution will stop at this breakpoint.

13. Run your code for a few seconds by using the Run button on the toolbar, or using Target → Run on the menu bar. After a few seconds halt your code by using the Halt button on the toolbar, or by using Target → Halt. Where did your code stop? Are the results as expected? If things went as expected, your code should be in the “main loop”.

14. Switch to the “C/C++ Perspective” view by clicking the C/C++ icon in the upper right-hand corner. Modify the InitWatchdog() function to enable the watchdog (WDCR). This will enable the watchdog to function and cause a reset. Save the file.

15. Click the “Build” button. Select Yes to “Reload the program automatically”. Switch back to the “Debug Perspective” view by clicking the Debug icon in the upper right-hand corner.

16. Like before, place the cursor in the “main loop” section (on the `asm(` “ NOP”`) ; ` instruction line) and right click the mouse key and select Run To Line.

17. Run your code. Where did your code stop? Are the results as expected? If things went as expected, your code should have stopped at the breakpoint. What happened is as follows. While the code was running, the watchdog timed out and reset the processor. The reset vector was then fetched and the ROM bootloader began execution. The bootloader transferred execution to the beginning of our code at address 0x000000 in the M0SARAM, and execution continued until the breakpoint was hit in main().

**Setup PIE Vector for Watchdog Interrupt**

The first part of this lab exercise used the watchdog to generate a CPU reset. This was tested using a breakpoint set at the beginning of main(). Next, we are going to use the watchdog to generate an interrupt. This part will demonstrate the interrupt concepts learned in the previous module.
Lab 5: System Initialization

18. In the “C/C++ Perspective” view add the following files to the project from C:\C28x\Labs\Lab5\Files:
   - DefaultIsr_5.c
   - PieCtrl_5_6_7_8_9_10.c
   - PieVect_5_6_7_8_9_10.c

   Check your files list to make sure the files are there.

19. In Main_5.c, add code to call the InitPieCtrl() function. There are no passed parameters or return values, so the call code is simply:

   InitPieCtrl();

20. Using the “PIE Interrupt Assignment Table” shown in the previous module find the location for the watchdog interrupt, “WAKEINT”. This will be used in the next step.

   PIE group #: __________ # within group: __________

21. Modify main() to do the following:
   - Enable global interrupts (INTM bit)

   Then modify InitWatchdog() to do the following:
   - Enable the “WAKEINT” interrupt in the PIE (Hint: use the PieCtrlRegs structure)
   - Enable the appropriate core interrupt in the IER register

22. In Watchdog.c modify the system control and status register (SCSR) to cause the watchdog to generate a WAKEINT rather than a reset. Save all changes to the files.

23. Open and inspect DefaultIsr_5.c. This file contains interrupt service routines. The ISR for WAKEINT has been trapped by an emulation breakpoint contained in an inline assembly statement using “ESTOP0”. This gives the same results as placing a breakpoint in the ISR. We will run the lab exercise as before, except this time the watchdog will generate an interrupt. If the registers have been configured properly, the code will be trapped in the ISR.

24. Open and inspect PieCtrl_5_6_7_8_9_10.c. This file is used to initialize the PIE RAM and enable the PIE. The interrupt vector table located in PieVect_5_6_7_8_9_10.c is copied to the PIE RAM to setup the vectors for the interrupts. Close the modified and inspected files.

**Build and Load**

25. Click the “Build” button and select Yes to “Reload the program automatically”. Switch to the “Debug Perspective” view.

**Run the Code – Watchdog Interrupt**

26. Place the cursor in the “main loop” section, right click the mouse key and select Run To Line.
27. Run your code. Where did your code stop? Are the results as expected? If things went as expected, your code should stop at the “ESTOP0” instruction in the WAKEINT ISR.

**Terminate Debug Session and Close Project**

28. Terminate the active debug session using the Terminate All button. This will close the debugger and return CCS to the “C/C++ Perspective” view.

29. Next, close the project by right-clicking on Lab5 in the C/C++ Projects window and select Close Project.

**End of Exercise**

**Note:** By default, the watchdog timer is enabled out of reset. Code in the file CodeStartBranch.asm has been configured to disable the watchdog. This can be important for large C code projects (ask your instructor if this has not already been explained). During this lab exercise, the watchdog was actually re-enabled (or disabled again) in the file Watchdog.c.
Introduction

This module explains the operation of the analog-to-digital converter. The system consists of a 12-bit analog-to-digital converter with 16 analog input channels. The analog input channels have a range from 0 to 3 volts. Two input analog multiplexers are used, each supporting 8 analog input channels. Each multiplexer has its own dedicated sample and hold circuit. Therefore, sequential, as well as simultaneous sampling is supported. Also, the ADC system features programmable auto sequence conversions with 16 results registers. Start of conversion (SOC) can be performed by an external trigger, software, or an ePWM event.

Learning Objectives

- Understand the operation of the Analog-to-Digital converter (ADC)
- Use the ADC to perform data acquisition
Module Topics

**Analog-to-Digital Converter**

*Module Topics* ................................................................................................................................. 6-1

*Analog-to-Digital Converter* ............................................................................................................... 6-2

- Analog-to-Digital Converter Registers ......................................................................................... 6-3
- Example – Sequencer “Start/Stop” Operation .............................................................................. 6-5
- ADC Conversion Result Buffer Register ....................................................................................... 6-10
- Signed Input Voltages .................................................................................................................. 6-11
- ADC Calibration ............................................................................................................................. 6-12

*Lab 6: Analog-to-Digital Converter* ................................................................................................. 6-14
Analog-to-Digital Converter

ADC Module Block Diagram (Cascaded Mode)

ADC Module Block Diagram (Dual-Sequencer mode)
**ADC Operating Mode Choices**

- The user can make one choice from each category below
- Choices are completely independent *

<table>
<thead>
<tr>
<th>Sequencer Mode</th>
<th>Sampling Mode</th>
<th>Run Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cascaded</td>
<td>Sequential</td>
<td>Start/Stop</td>
</tr>
<tr>
<td>Dual</td>
<td>Simultaneous</td>
<td>Continuous</td>
</tr>
</tbody>
</table>

* Note that using Continuous Run mode with Dual Sequencer generally doesn't make sense since sequencer #2 will not get to do any conversions!

---

**ADC Clocking Flow**

- **CLKIN** (30 MHz)
- **PLL CR**
  - **DIV** bits: 1011b (x10)
- **PLL STS**
  - **DIVSEL** bits: 10b (/2)
- **SYSCLKOUT** (150 MHz)
  - **HSPCLK** bits: To CPU
  - **PLLST**
    - **DIVSEL** bits: 000b (/1)
- **ADCTRL3**
  - **ADCCLKPS** bits: 0110b
    - \( FCLK = \text{HSPCLK/(2*ADCCLKPS)} \)
- **ADCTRL1**
  - **FCLK** (12.5 MHz)
  - **CPS** bit: 0b
    - \( \text{ADCCLK} = \text{FCLK/(CPS+1)} \)
  - **ACQ PS** bits: 0111b
    - sampling window = \((\text{ACQ PS} + 1)(1/\text{ADCCLK})\)
- **HISPCP** bits: 000b
- **HSPCLK** (150 MHz)

Note: Maximum F2833x ADCCLK is 25 MHz, but INL (integral nonlinearity error) is greater above 12.5 MHz. See the device datasheet for more information.
## Analog-to-Digital Converter Registers

### AdcRegs.register (lab file: Adc.c)

<table>
<thead>
<tr>
<th>Register</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADCTRL1</td>
<td>ADC Control Register 1</td>
</tr>
<tr>
<td>ADCTRL2</td>
<td>ADC Control Register 2</td>
</tr>
<tr>
<td>ADCTRL3</td>
<td>ADC Control Register 3</td>
</tr>
<tr>
<td>ADCMAXCONV</td>
<td>ADC Maximum Conversion Channels Register</td>
</tr>
<tr>
<td>ADCCHSELSEQ1</td>
<td>ADC Channel Select Sequencing Control Register 1</td>
</tr>
<tr>
<td>ADCCHSELSEQ2</td>
<td>ADC Channel Select Sequencing Control Register 2</td>
</tr>
<tr>
<td>ADCCHSELSEQ3</td>
<td>ADC Channel Select Sequencing Control Register 3</td>
</tr>
<tr>
<td>ADCCHSELSEQ4</td>
<td>ADC Channel Select Sequencing Control Register 4</td>
</tr>
<tr>
<td>ADCASEQSR</td>
<td>ADC Autosequence Status Register</td>
</tr>
<tr>
<td>ADCRESULT0</td>
<td>ADC Conversion Result Buffer Register 0</td>
</tr>
<tr>
<td>ADCRESULT1</td>
<td>ADC Conversion Result Buffer Register 1</td>
</tr>
<tr>
<td>ADCRESULT2</td>
<td>ADC Conversion Result Buffer Register 2</td>
</tr>
<tr>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>ADCRESULT14</td>
<td>ADC Conversion Result Buffer Register 14</td>
</tr>
<tr>
<td>ADCRESULT15</td>
<td>ADC Conversion Result Buffer Register 15</td>
</tr>
<tr>
<td>ADCREFSEL</td>
<td>ADC Reference Select Register</td>
</tr>
<tr>
<td>ADCOFFTRIM</td>
<td>ADC Offset Trim Register</td>
</tr>
<tr>
<td>ADCST</td>
<td>ADC Status and Flag Register</td>
</tr>
</tbody>
</table>
ADC Control Register 1
AdcRegs.ADCTRL1

Upper Register:

ADC Module Reset
0 = no effect
1 = reset (set back to 0 by ADC logic)

Acquisition Time Prescale (S/H)
ACQ Window = (ACQ_PS + 1)*(1/ADCCLK)

Emulation Suspend Mode
00 = free run (do not stop)
01 = stop after current sequence
10 = stop after current conversion
11 = stop immediately

Conversion Prescale
0: ADCCLK = FCLK / 1
1: ADCCLK = FCLK / 2

Lower Register:

Continuous Run
0 = stops after reaching end of sequence
1 = continuous (starts all over again from “initial state”)

Sequencer Mode
0 = dual mode
1 = cascaded mode

Sequencer Override
(functions only if CONT_RUN = 1)
0 = sequencer pointer resets to “initial state” at end of MAX_CONVn
1 = sequencer pointer resets to “initial state” after “end state”
ADC Control Register 2
AdcRegs.ADCTRL2

Upper Register:

- **ePWM SOC B** (cascaded mode only)
  - 0 = no action
  - 1 = start by ePWM signal
- **Start Conversion (SEQ1)**
  - 0 = clear pending SOC trigger
  - 1 = software trigger-start SEQ1
- **Reset SEQ1**
  - 0 = no action
  - 1 = immediate reset SEQ1 to “initial state”
- **Interrupt Enable (SEQ1)**
  - 0 = interrupt disable
  - 1 = interrupt enable
- **Interrupt Mode (SEQ1)**
  - 0 = interrupt every EOS
  - 1 = interrupt every other EOS

Lower Register:

- **External SOC (SEQ1)**
  - 0 = no action
  - 1 = start by signal from ADCSOC pin
- **Start Conversion (SEQ2)** (dual-sequencer mode only)
  - 0 = clear pending SOC trigger
  - 1 = software trigger-start SEQ2
- **Reset SEQ2**
  - 0 = no action
  - 1 = immediate reset SEQ2 to “initial state”
- **Interrupt Enable (SEQ2)**
  - 0 = interrupt disable
  - 1 = interrupt enable
- **Interrupt Mode (SEQ2)**
  - 0 = interrupt every EOS
  - 1 = interrupt every other EOS

---

C2000 Delfino Workshop - Analog-to-Digital Converter 6 - 7
Analog-to-Digital Converter

### ADC Control Register 3

**AdcRegs.ADCTRL3**

- **ADC Bandgap and Reference Power Down**
  - 00 = powered down
  - 11 = powered up

- **ADC Power Down (except Bandgap & Ref.)**
  - 0 = powered down
  - 1 = powered up

- **ADC Clock Prescale**
  - 0 : FCLK = HSPCLK
  - 1 to F : FCLK = HSPCLK / (2*ADCCLKPS)

- **Sampling Mode Select**
  - 0 = sequential sampling mode
  - 1 = simultaneous sampling mode

### Maximum Conversion Channels Register

**AdcRegs.ADCMAXCONV**

- **Bit fields define the number of conversions per trigger (binary+1)**

#### Cascaded Mode

- **SEQ2**
- **SEQ1**

- Each sequencer starts at the “initial state” and advances sequentially
- Each will wrap at the “end state” unless software resets it sooner

<table>
<thead>
<tr>
<th>Initial state</th>
<th>SEQ1</th>
<th>SEQ2</th>
<th>Cascaded</th>
</tr>
</thead>
<tbody>
<tr>
<td>End state</td>
<td>CONV07</td>
<td>CONV15</td>
<td>CONV15</td>
</tr>
</tbody>
</table>
### ADC Input Channel Select Sequencing Control Registers

AdcRegs.ADCCHSELSEQx

<table>
<thead>
<tr>
<th>ADCCHSELSEQ1</th>
<th>CONV03</th>
<th>CONV02</th>
<th>CONV01</th>
<th>CONV00</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADCCHSELSEQ2</td>
<td>CONV07</td>
<td>CONV06</td>
<td>CONV05</td>
<td>CONV04</td>
</tr>
<tr>
<td>ADCCHSELSEQ3</td>
<td>CONV11</td>
<td>CONV10</td>
<td>CONV09</td>
<td>CONV08</td>
</tr>
<tr>
<td>ADCCHSELSEQ4</td>
<td>CONV15</td>
<td>CONV14</td>
<td>CONV13</td>
<td>CONV12</td>
</tr>
</tbody>
</table>

For purposes of these registers, channel numbers are:

- 0 = ADCINA0
- 8 = ADCINB0
- 7 = ADCINA7
- 15 = ADCINB7
Example – Sequencer “Start/Stop” Operation

Example - Sequencer Configuration (1 of 2)

Configuration Requirements:
- ePWM triggers the ADC
  - Three autoconversions (V1, V2, V3) off trigger 1 (CTR = 0)
  - Three autoconversions (I1, I2, I3) off trigger 2 (CTR = PRD)
- ADC in cascaded sequencer and sequential sampling modes

Example - Sequencer Configuration (2 of 2)

- MAX_CONV1 is set to 2 and Channel Select Sequencing Control Registers are set to:
<table>
<thead>
<tr>
<th>Bits →</th>
<th>15-12</th>
<th>11-8</th>
<th>7-4</th>
<th>3-0</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>I₁</td>
<td>V₃</td>
<td>V₂</td>
<td>V₁</td>
</tr>
<tr>
<td>×</td>
<td>×</td>
<td>I₃</td>
<td>I₂</td>
<td></td>
</tr>
<tr>
<td>ADCCHSELSEQ1</td>
<td>ADCCHSELSEQ2</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Once reset and initialized, SEQ1 waits for a trigger
- First trigger, three conversions performed: CONV00 (V1), CONV01 (V2), CONV02 (V3)
- MAX_CONV1 value is reset to 2 (unless changed by software)
- SEQ1 waits for second trigger
- Second trigger, three conversions performed: CONV03 (I1), CONV04 (I2), CONV05 (I3)
- End of second sequence, ADC Results registers have the following values:

<table>
<thead>
<tr>
<th>RESULT0</th>
<th>V₁</th>
</tr>
</thead>
<tbody>
<tr>
<td>RESULT1</td>
<td>V₂</td>
</tr>
<tr>
<td>RESULT2</td>
<td>V₃</td>
</tr>
<tr>
<td>RESULT3</td>
<td>I₁</td>
</tr>
<tr>
<td>RESULT4</td>
<td>I₂</td>
</tr>
<tr>
<td>RESULT5</td>
<td>I₃</td>
</tr>
</tbody>
</table>

- SEQ1 waits at current state for another trigger
- User can reset SEQ1 by software to state CONV00 and repeat same trigger 1,2 session
ADC Conversion Result Buffer Register

ADC Conversion Result Registers

<table>
<thead>
<tr>
<th>Input Voltage</th>
<th>Digital Result</th>
<th>AdcRegs. ADCRESULTx</th>
<th>AdcMirror. ADCRESULTx</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.0</td>
<td>FFFh</td>
<td>1111</td>
<td>1111</td>
</tr>
<tr>
<td>1.5</td>
<td>7FFh</td>
<td>0111</td>
<td>1111</td>
</tr>
<tr>
<td>0.00073</td>
<td>1h</td>
<td>0000</td>
<td>0000</td>
</tr>
<tr>
<td>0</td>
<td>0h</td>
<td>0000</td>
<td>0000</td>
</tr>
</tbody>
</table>

Signed Input Voltages

How Can We Handle Signed Input Voltages?

Example: \(-1.5 \text{ V} \leq V_{\text{in}} \leq +1.5 \text{ V}\)

1) Add 1.5 volts to the analog input

2) Subtract “1.5” from the digital result

```c
#include “DSP2833x_Device.h”
#define offset 0x07FF
void main(void)
{
    int16 value;    // signed
    value = AdcMirror.ADCRESULT0 - offset;
}
```
ADC Calibration

Built-In ADC Calibration

- TI reserved OTP contains device specific ADC calibration data (2 words)
- The Boot ROM contains an ADC_cal() routine (6 words) that copies the calibration data to the ADCREFSEL and ADCOFFTRIM registers
- ADC_cal() must be run to meet the ADC specs in the datasheet
  - The Bootloader automatically calls ADC_cal() such that no action is normally required by the user
  - If the bootloader is bypassed (e.g., during development) ADC_cal() should be called by the application:

```c
#define ADC_cal_func_ptr (void (*)(void))0x380080
void main(void)
{
    (*ADC_cal_func_ptr)(); // call ADC_cal()
}
```

Manual ADC Calibration

- If the offset and gain errors in the datasheet * are unacceptable for your application, or you want to also compensate for board level errors (e.g., sensor or amplifier offset), you can manually calibrate
- Offset error
  - Compensated in analog with the ADCOFFTRIM register
  - No reduction in full-scale range
  - Ground an input pin, set ADCOFFTRIM to maximum offset error, and take a reading
  - Re-adjust ADCOFFTRIM to make result zero
- Gain error
  - Compensated in software
  - Some loss in full-scale range
  - Requires use of a second ADC input pin and an upper-range reference voltage on that pin; see “TMS320280x and TMS320F2801x ADC Calibration” appnote #SPRAAD8 for more information
- Tip: To minimize mux-to-mux variation effects, put your most critical signals on a single mux and use that mux for calibration inputs

* +/-15 LSB offset, +/-30 LSB gain. See device datasheet for exact specifications
Analog-to-Digital Converter

ADC Reference Selection

<table>
<thead>
<tr>
<th>ADC Reference Selection</th>
<th>15 - 14</th>
<th>13 - 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>REF_SEL</td>
<td>reserved</td>
<td></td>
</tr>
</tbody>
</table>

- **The F28335 ADC has an internal reference with temperature stability of ~50 PPM/°C** *
- **If this is not sufficient for your application, there is the option to use an external reference** *
  - External reference choices: 2.048 V, 1.5 V, 1.024 V
  - The reference value DOES NOT change the 0 - 3 V full-scale range of the ADC
- **The ADCREFSEL register controls the reference choice**

* See device datasheet for exact specifications and ADC reference hardware connections
Lab 6: Analog-to-Digital Converter

Objective

The objective of this lab is to become familiar with the programming and operation of the on-chip analog-to-digital converter. The MCU will be setup to sample a single ADC input channel at a prescribed sampling rate and store the conversion result in a memory buffer. This buffer will operate in a circular fashion, such that new conversion data continuously overwrites older results in the buffer.

Recall that there are three basic ways to initiate an ADC start of conversion (SOC):

1. Using software
   a. SOC_SEQ1/SOC_SEQ2 bit in ADCTRL2 causes an SOC upon completion of the current conversion (if the ADC is currently idle, an SOC occurs immediately)
2. Automatically triggered on user selectable ePWM conditions
   a. ePWM underflow (CTR = 0)
   b. ePWM period match (CTR = PRD)
   c. ePWM compare match (CTRU/D = CMPA/B)
3. Externally triggered using a pin
   a. ADCSOC pin

One or more of these methods may be applicable to a particular application. In this lab, we will be using the ADC for data acquisition. Therefore, one of the ePWMs (ePWM2) will be configured to automatically trigger the SOCA signal at the desired sampling rate (SOC method 2b above). The ADC end-of-conversion interrupt will be used to prompt the CPU to copy the results of the ADC conversion into a results buffer in memory. This buffer pointer will be managed in a circular fashion, such that new conversion results will continuously overwrite older conversion results in the buffer. In order to generate an interesting input signal, the code also alternately toggles a GPIO pin (GPIO18) high and low in the ADC interrupt service routine. The ADC ISR
will also toggle LED LD3 on the controlCARD as a visual indication that the ISR is running. This pin will be connected to the ADC input pin, and sampled. After taking some data, Code Composer Studio will be used to plot the results. A flow chart of the code is shown in the following slide.

**Lab 6: Code Flow Diagram**

### Notes
- Program performs conversion on ADC channel A0 (ADCINA0 pin)
- ADC conversion is set at a 48 kHz sampling rate
- ePWM2 is triggering the ADC on period match using SOCA trigger
- Data is continuously stored in a circular buffer
- GPIO18 pin is also toggled in the ADC ISR
- ADC ISR will also toggle the controlCARD LED LD3 as a visual indication that it is running

#### Procedure

**Open the Project**

1. A project named Lab6 has been created for this lab. Open the project by clicking on Project ➔ Import Existing CCS/CCE Eclipse Project. The “Import” window will open then click Browse... next to the “Select root directory” box. Navigate to: C:\C28x\Labs\Lab6\Project and click OK. Then click Finish to import the project. All build options have been configured the same as the previous lab. The files used in this lab are:
Setup ADC Initialization and Enable Core/PIE Interrupts

2. In Main_6.c add code to call InitAdc() and InitEPwm() functions. The InitEPwm() function is used to configure ePWM2 to trigger the ADC at a 48 kHz rate. Details about the ePWM and control peripherals will be discussed in the next module.

3. Edit Adc.c to implement the ADC initialization as described in the objective for the lab by configuring the following registers: ADCTRL1, ADCTRL2, ADCMAXCONV and ADCCHSELSEQ1. (Set ADC for cascaded sequencer mode, CPS = CLK/1, and acquisition time prescale = 8 * (1/ADCCLK), ePWM2 triggering the ADC on period match using SOCA trigger).

4. Using the “PIE Interrupt Assignment Table” find the location for the ADC interrupt “ADCINT” and fill in the following information:

   PIE group #: _______    # within group: _______

   This information will be used in the next step.

5. Modify the end of Adc.c to do the following:
   - Enable the “ADCINT” interrupt in the PIE (Hint: use the PieCtrlRegs structure)
   - Enable the appropriate core interrupt in the IER register

6. Open and inspect DefaultIsr_6.c. This file contains the ADC interrupt service routine. Save your work and close the modified files.

Build and Load

7. Click the “Build” button and watch the tools run in the Console window. Check for errors in the Problems window.

8. Click the “Debug” button (green bug). The “Debug Perspective” view should open, the program will load automatically, and you should now be at the start of main().

Run the Code

9. In Main_6.c place the cursor in the “main loop” section, right click on the mouse key and select Run To Line.

10. Open a memory window to view some of the contents of the ADC results buffer. The address label for the ADC results buffer is AdcBuf in the “Data” memory page.
11. Using a connector wire provided, connect the ADCINA0 (pin # ADC-A0) to “GND” (pin # GND) on the Docking Station. Then run the code again, and halt it after a few seconds. Verify that the ADC results buffer contains the expected value of ~0x0000. Note that you may not get exactly 0x0000 if the device you are using has positive offset error.

12. Adjust the connector wire to connect the ADCINA0 (pin # ADC-A0) to “+3.3V” (pin # GPIO-20) on the Docking Station. (Note: pin # GPIO20 has been set to “1” in Gpio.c). Then run the code again, and halt it after a few seconds. Verify that the ADC results buffer contains the expected value of ~0x0FFF. Note that you may not get exactly 0x0FFF if the device you are using has negative offset error.

13. Adjust the connector wire to connect the ADCINA0 (pin # ADC-A0) to GPIO18 (pin # GPIO-18) on the Docking Station. Then run the code again, and halt it after a few seconds. Examine the contents of the ADC results buffer (the contents should be alternating ~0x0000 and ~0x0FFF values). Are the contents what you expected?

14. Open and setup a graph to plot a 48-point window of the ADC results buffer. Click: Tools → Graph → Single Time and set the following values:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acquisition Buffer Size</td>
<td>48</td>
</tr>
<tr>
<td>DSP Data Type</td>
<td>16-bit unsigned integer</td>
</tr>
<tr>
<td>Sampling Rate (Hz)</td>
<td>48000</td>
</tr>
<tr>
<td>Start Address</td>
<td>AdcBuf</td>
</tr>
<tr>
<td>Display Data Size</td>
<td>48</td>
</tr>
<tr>
<td>Time Display Unit</td>
<td>µs</td>
</tr>
</tbody>
</table>

Select OK to save the graph options.

15. Recall that the code toggled the GPIO18 pin alternately high and low. (Also, the ADC ISR is toggling the LED LD3 on the controlCARD as a visual indication that the ISR is running). If you had an oscilloscope available to display GPIO18, you would expect to see a square-wave. Why does Code Composer Studio plot resemble a triangle wave? What is the signal processing term for what is happening here?
16. Recall that the program toggled the GPIO18 pin at a 48 kHz rate. Therefore, a complete cycle (toggle high, then toggle low) occurs at half this rate, or 24 kHz. We therefore expect the period of the waveform to be 41.667 μs. Confirm this by measuring the period of the triangle wave using the “measurement marker mode” graph feature. Right-click on the graph and select Measurement Marker Mode. Move the mouse to the first measurement position and left-click. Again, right-click on the graph and select Measurement Marker Mode. Move the mouse to the second measurement position and left-click. The graph will automatically calculate the difference between the two values taken over a complete waveform period. When done, clear the measurement points by right-clicking on the graph and select Remove All Measurement Marks.

Using Real-time Emulation

Real-time emulation is a special emulation feature that offers two valuable capabilities:

A. Windows within Code Composer Studio can be updated at up to a 10 Hz rate while the MCU is running. This not only allows graphs and watch windows to update, but also allows the user to change values in watch or memory windows, and have those changes affect the MCU behavior. This is very useful when tuning control law parameters on-the-fly, for example.

B. It allows the user to halt the MCU and step through foreground tasks, while specified interrupts continue to get serviced in the background. This is useful when debugging portions of a realtime system (e.g., serial port receive code) while keeping critical parts of your system operating (e.g., commutation and current loops in motor control).

We will only be utilizing capability “A” above during the workshop. Capability “B” is a particularly advanced feature, and will not be covered in the workshop.

17. The memory and graph windows displaying AdcBuf should still be open. The connector wire between ADCINA0 (pin # ADC-A0) and GPIO18 (pin # GPIO-18) should still be connected. In real-time mode, we will have our window continuously refresh at the default rate. To view the refresh rate click:

Window ➔ Preferences...

and in the section on the left select the “CCS” category. Click the plus sign (+) to the left of “CCS” and select “Debug”. In the section on the right notice the default setting:

- “Continuous refresh interval (milliseconds)” = 1000

Click OK.

Note: Increasing the “Continuous refresh interval” causes all enabled continuous refresh windows to refresh at a faster rate. This can be problematic when a large number of windows are enabled, as bandwidth over the emulation link is limited. Updating too many windows can cause the refresh frequency to bog down. In this case you can just selectively enable continuous refresh for the individual windows of interest.
18. Next we need to enable the graph window for continuous refresh. In the upper right-hand corner of the graph window, left-click on the yellow icon with the arrows rotating in a circle over a pause sign. Note when you hover your mouse over the icon, it will show “Enable Continuous Refresh”. This will allow the graph to continuously refresh in real-time while the program is running.

19. Enable the memory window for continuous refresh using the same procedure as the previous step.

20. Code Composer Studio includes Scripts that are functions which automate entering and exiting real-time mode. Four functions are available:
   - Run_Realtime_with_Reset (reset CPU, enter real-time mode, run CPU)
   - Run_Realtime_with_Restart (restart CPU, enter real-time mode, run CPU)
   - Full_Halt (exit real-time mode, halt CPU)
   - Full_Halt_with_Reset (exit real-time mode, halt CPU, reset CPU)

These Script functions are executed by clicking:

Scripts \(\rightarrow\) Realtime Emulation Control \(\rightarrow\) Function

In the remaining lab exercises we will be using the first and third above Script functions to run and halt the code in real-time mode.

21. Run the code and watch the windows update in real-time mode. Click:

Scripts \(\rightarrow\) Realtime Emulation Control \(\rightarrow\) Run_Realtime_with_Reset

Carefully remove and replace the connector wire from GPIO18. Are the values updating as expected?

22. Fully halt the CPU in real-time mode. Click:

Scripts \(\rightarrow\) Realtime Emulation Control \(\rightarrow\) Full_Halt

23. So far, we have seen data flowing from the MCU to the debugger in real-time. In this step, we will flow data from the debugger to the MCU.
   - Open and inspect Main_6.c. Notice that the global variable DEBUG_TOGGLE is used to control the toggling of the GPIO18 pin. This is the pin being read with the ADC.
   - Highlight DEBUG_TOGGLE with the mouse, right click and select “Add Watch Expression”. The global variable DEBUG_TOGGLE should now be in the watch window with a value of “1”.
   - Enable the watch window for continuous refresh
   - Run the code in real-time mode and change the value to “0”. Are the results shown in the memory and graph window as expected? Change the value back to “1”. As you can see, we are modifying data memory contents while the processor is running in real-time (i.e., we are not halting the MCU nor interfering with its operation in any way)! When done, fully halt the CPU.
Terminate Debug Session and Close Project

24. Terminate the active debug session using the Terminate All button. This will close the debugger and return CCS to the “C/C++ Perspective” view.

25. Next, close the project by right-clicking on Lab6 in the C/C++ Projects window and select Close Project.

End of Exercise
Introduction

This module explains how to generate PWM waveforms using the ePWM unit. Also, the eCAP unit, and eQEP unit will be discussed.

Learning Objectives

- Pulse Width Modulation (PWM) review
- Generate a PWM waveform with the Pulse Width Modulator Module (ePWM)
- Use the Capture Module (eCAP) to measure the width of a waveform
- Explain the function of Quadrature Encoder Pulse Module (eQEP)

Note: Different numbers of ePWM, eCAP, and eQEP modules are available on F2833x and F2823x devices. See the device datasheet for more information.
Module Topics

Control Peripherals........................................................................................................................................... 7-1

Module Topics.................................................................................................................................................. 7-2

PWM Review.................................................................................................................................................... 7-3

ePWM............................................................................................................................................................ 7-5
  ePWM Time-Base Sub-Module .................................................................................................................. 7-6
  ePWM Compare Sub-Module .................................................................................................................... 7-9
  ePWM Action Qualifier Sub-Module .......................................................................................................... 7-11
  Asymmetric and Symmetric Waveform Generation using the ePWM .................................................... 7-16
  PWM Computation Example .................................................................................................................... 7-17
  ePWM Dead-Band Sub-Module .................................................................................................................. 7-18
  ePWM PWM Chopper Sub-Module ........................................................................................................... 7-21
  ePWM Trip-Zone Sub-Module .................................................................................................................... 7-24
  ePWM Event-Trigger Sub-Module ............................................................................................................. 7-27
  Hi-Resolution PWM (HRPWM) .............................................................................................................. 7-29

eCAP............................................................................................................................................................. 7-30

eQEP............................................................................................................................................................. 7-36

Lab 7: Control Peripherals .............................................................................................................................. 7-38
PWM Review

What is Pulse Width Modulation?

- **PWM** is a scheme to represent a signal as a sequence of pulses
  - fixed carrier frequency
  - fixed pulse amplitude
  - pulse width proportional to instantaneous signal amplitude
  - **PWM energy ≈ original signal energy**

Pulse width modulation (PWM) is a method for representing an analog signal with a digital approximation. The PWM signal consists of a sequence of variable width, constant amplitude pulses which contain the same total energy as the original analog signal. This property is valuable in digital motor control as sinusoidal current (energy) can be delivered to the motor using PWM signals applied to the power converter. Although energy is input to the motor in discrete packets, the mechanical inertia of the rotor acts as a smoothing filter. Dynamic motor motion is therefore similar to having applied the sinusoidal currents directly.
Why use PWM with Power Switching Devices?

- Desired output currents or voltages are known
- Power switching devices are transistors
  - Difficult to control in proportional region
  - Easy to control in saturated region
- PWM is a digital signal \( \Rightarrow \) easy for DSP to output

![Diagram showing PWM concept](image-url)
ePWM Time-Base Sub-Module

Clock Prescaler

16-Bit Time-Base Counter

Compare Logic

Action Qualifier

Dead Band

Period Register

Shadowed

Compare Register

Shadowed

Comparing Register

EPWMxSYNCO

EPWMxSYNCl

TBCLK

SYSCLKOUT

EPWMxA

EPWMxB

TZy

1. Count Up Mode
2. Count Down Mode
3. Count Up and Down Mode

Asymmetrical Waveform

Symmetrical Waveform
**ePWM Phase Synchronization**

![Diagram showing ePWM Phase Synchronization]

**ePWM Time-Base Sub-Module Registers**

*(lab file: EPwm.c)*

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>TBCTL</td>
<td>Time-Base Control</td>
<td>EPwmXRegs.TBCTL.all =</td>
</tr>
<tr>
<td>TBSTS</td>
<td>Time-Base Status</td>
<td>EPwmXRegs.TBSTS.all =</td>
</tr>
<tr>
<td>TBPHS</td>
<td>Time-Base Phase</td>
<td>EPwmXRegs.TBPHS =</td>
</tr>
<tr>
<td>TBCTR</td>
<td>Time-Base Counter</td>
<td>EPwmXRegs.TBCTR =</td>
</tr>
<tr>
<td>TBPRD</td>
<td>Time-Base Period</td>
<td>EPwmXRegs.TBPRD =</td>
</tr>
</tbody>
</table>
ePWM Time-Base Control Register

**Upper Register:**

- **Phase Direction**
  - 0 = count down after sync
  - 1 = count up after sync

- **TB Clock Prescale**
  - 000 = /1 (default)
  - 001 = /2
  - 010 = /4
  - 011 = /8
  - 100 = /16
  - 101 = /32
  - 110 = /64
  - 111 = /128

- **High Speed TB Clock Prescale**
  - 000 = /1
  - 001 = /2 (default)
  - 010 = /4
  - 011 = /6
  - 100 = /8
  - 101 = /10
  - 110 = /12
  - 111 = /14

- **Emulation Halt Behavior**
  - 00 = stop after next CTR inc/dec
  - 01 = stop when:
    - Up Mode; CTR = PRD
    - Down Mode; CTR = 0
    - Up/Down Mode; CTR = 0
  - 1x = free run (do not stop)

-TBCLK = SYSCLKOUT / (HSPCLKDIV * CLKDIV)

**Lower Register:**

- **Software Force Sync Pulse**
  - 0 = no action
  - 1 = force one-time sync

- **Sync Output Select**
  - 0 = EPWMxSYNCI
  - 01 = CTR = 0
  - 10 = CTR = CMPB
  - 11 = disable SyncOut

- **Counter Mode**
  - 00 = count up
  - 01 = count down
  - 10 = count up and down
  - 11 = stop – freeze (default)

- **Period Shadow Load**
  - 0 = load on CTR = 0
  - 1 = load immediately

- **Phase Reg. Enable**
  - 0 = disable
  - 1 = CTR = TBPHS on EPWMxSYNCI signal

(HSPCLKDIV is for legacy compatibility)
ePWM Compare Sub-Module

- Clock Prescaler
- 16-Bit Time-Base Counter
- Compare Logic
- Action Qualifier
- Period Register
- PWM Chopper
- Trip Zone
- SYSCLKOUT
- EPWMxSYNCI
- EPWMxA
- EPWMxB
- TZY
- Count Up Mode
- Asymmetrical Waveform
- Count Down Mode
- Asymmetrical Waveform
- Count Up and Down Mode
- Symmetrical Waveform

Compare events are fed to the Action Qualifier Module.
### ePWM Compare Sub-Module Registers

(lab file: EPwm.c)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMPCTL</td>
<td>Compare Control</td>
<td>EPwmxRegs.CMPCTL.all =</td>
</tr>
<tr>
<td>CMPA</td>
<td>Compare A</td>
<td>EPwmxRegs.CMPA =</td>
</tr>
<tr>
<td>CMPB</td>
<td>Compare B</td>
<td>EPwmxRegs.CMPB =</td>
</tr>
</tbody>
</table>

### ePWM Compare Control Register

EPwmxRegs.CMPCTL

CMPA and CMPB Shadow Full Flag
(bit automatically clears on load)
0 = shadow not full
1 = shadow full

- 15 - 10: reserved
- 9: SHDWBFULL
- 8: SHDWAFULL
- 7: reserved

CMPA and CMPB Operating Mode
0 = shadow mode;
  double buffer w/ shadow register
1 = immediate mode;
  shadow register not used

- 6: SHDBMODE
- 5: reserved
- 4: SHDWAMODE
- 3 - 2: LOADBMODE
- 1 - 0: LOADAMODE

CMPA and CMPB Shadow Load Mode
00 = load on CTR = 0
01 = load on CTR = PRD
10 = load on CTR = 0 or PRD
11 = freeze (no load possible)
ePWM Action Qualifier Sub-Module

Clock Prescaler

16-Bit Time-Base Counter

Compare Logic

Action Qualifier

Dead Band

Trip Zone

PWM Chopper

Period Register

Compare Register

Shadowed

SYSCLKOUT

EPWMxSYNCI

EPWMxSYNCO

TBCLK

ePWM Action Qualifier Actions

for EPWMA and EPWMB

<table>
<thead>
<tr>
<th>S/W Force</th>
<th>Time-Base Counter equals:</th>
<th>EPWM Output Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Zero</td>
<td>CMPA</td>
</tr>
<tr>
<td>SW X</td>
<td>Z X</td>
<td>CA X</td>
</tr>
<tr>
<td>SW ↓</td>
<td>Z</td>
<td>CA</td>
</tr>
<tr>
<td>SW ↑</td>
<td>Z</td>
<td>CA</td>
</tr>
<tr>
<td>SW T</td>
<td>Z T</td>
<td>CA T</td>
</tr>
</tbody>
</table>
ePWM Count Up Asymmetric Waveform with Independent Modulation on EPWMA / B

TBCTR
TBPRD

EPWMA
EPWMB

Z ↑ PX CB X CA ↓ Z ↑ PX CB X CA ↓ Z ↑ PX CB X CA ↓ Z ↑ PX

ePWM Count Up Asymmetric Waveform with Independent Modulation on EPWMA

TBCTR
TBPRD

EPWMA
EPWMB

CA ↑ CB ↓ CA ↑ CB ↓ CA ↑ CB ↓ Z ↓ Z ↓ Z ↓
ePWM Count Up-Down Symmetric Waveform
with Independent Modulation on EPWMA / B

EPWMA

EPWMB

ePWM Count Up-Down Symmetric Waveform
with Independent Modulation on EPWMA

EPWMA

EPWMB
### ePWM Action Qualifier Sub-Module Registers

(lab file: EPwm.c)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>AQCTLA</td>
<td>AQ Control Output A</td>
<td>EPwmRegs.AQCTLA.all =</td>
</tr>
<tr>
<td>AQCTLB</td>
<td>AQ Control Output B</td>
<td>EPwmRegs.AQCTLB.all =</td>
</tr>
<tr>
<td>AQSFRC</td>
<td>AQ S/W Force</td>
<td>EPwmRegs.AQSFRC.all =</td>
</tr>
<tr>
<td>AQCSFRC</td>
<td>AQ Cont. S/W Force</td>
<td>EPwmRegs.AQCSFRC.all =</td>
</tr>
</tbody>
</table>

### ePWM Action Qualifier Control Register

EPwmRegs.AQCTL\(\_\_\_\_\) \(y = A \text{ or } B\)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Bit Locations</th>
</tr>
</thead>
<tbody>
<tr>
<td>reserved</td>
<td></td>
<td>15 - 12</td>
</tr>
<tr>
<td>CBD</td>
<td></td>
<td>11 - 10</td>
</tr>
<tr>
<td>CBU</td>
<td></td>
<td>9 - 8</td>
</tr>
<tr>
<td>CAD</td>
<td></td>
<td>7 - 6</td>
</tr>
<tr>
<td>CAU</td>
<td></td>
<td>5 - 4</td>
</tr>
<tr>
<td>PRD</td>
<td></td>
<td>3 - 2</td>
</tr>
<tr>
<td>ZRO</td>
<td></td>
<td>1 - 0</td>
</tr>
</tbody>
</table>

- **Action when CTR = CMPB on UP Count**
- **Action when CTR = CMPA on UP Count**
- **Action when CTR = 0**

- Action when CTR = CMPB on DOWN Count
- Action when CTR = CMPA on DOWN Count
- Action when CTR = PRD

00 = do nothing (action disabled)
01 = clear (low)
10 = set (high)
11 = toggle (low → high; high → low)
**ePWM Action Qualifier S/W Force Register**

EPwmxRegs.AQSFR

- **One-Time S/W Force on Output B / A**
  - 0 = no action
  - 1 = single s/w force event

- **AQSFRC Shadow Reload Options**
  - 00 = load on event CTR = 0
  - 01 = load on event CTR = PRD
  - 10 = load on event CTR = 0 or CTR = PRD
  - 11 = load immediately (from active reg.)

- **Action on One-Time S/W Force B / A**
  - 00 = do nothing (action disabled)
  - 01 = clear (low)
  - 10 = set (high)
  - 11 = toggle (low → high; high → low)

**ePWM Action Qualifier Continuous S/W Force Register**

EPwmxRegs.AQCSFR

- **Continuous S/W Force on Output B / A**
  - 00 = forcing disabled
  - 01 = force continuous low on output
  - 10 = force continuous high on output
  - 11 = forcing disabled
Asymmetric and Symmetric Waveform Generation using the ePWM

PWM switching frequency:

The PWM carrier frequency is determined by the value contained in the time-base period register, and the frequency of the clocking signal. The value needed in the period register is:

Asymmetric PWM: \[ \text{period register} = \left( \frac{\text{switching period}}{\text{timer period}} \right) - 1 \]

Symmetric PWM: \[ \text{period register} = \frac{\text{switching period}}{2(\text{timer period})} \]

Notice that in the symmetric case, the period value is half that of the asymmetric case. This is because for up/down counting, the actual timer period is twice that specified in the period register (i.e. the timer counts up to the period register value, and then counts back down).

PWM resolution:

The PWM compare function resolution can be computed once the period register value is determined. The largest power of 2 is determined that is less than (or close to) the period value. As an example, if asymmetric was 1000, and symmetric was 500, then:

Asymmetric PWM: approx. 10 bit resolution since \(2^{10} = 1024 \approx 1000\)

Symmetric PWM: approx. 9 bit resolution since \(2^9 = 512 \approx 500\)

PWM duty cycle:

Duty cycle calculations are simple provided one remembers that the PWM signal is initially inactive during any particular timer period, and becomes active after the (first) compare match occurs. The timer compare register should be loaded with the value as follows:

Asymmetric PWM: \(\text{TxCMPR} = (100\% - \text{duty cycle}) \times \text{TxPR}\)

Symmetric PWM: \(\text{TxCMPR} = (100\% - \text{duty cycle}) \times \text{TxPR}\)

Note that for symmetric PWM, the desired duty cycle is only achieved if the compare registers contain the computed value for both the up-count compare and down-count compare portions of the time-base period.
PWM Computation Example

**Symmetric PWM Computation Example**

- Determine TBPRD and CMPA for 150 kHz, 25% duty symmetric PWM from a 150 MHz time base clock

\[ \text{TBPRD} = \frac{1}{2} \cdot \frac{f_{TBCLK}}{f_{PWM}} = \frac{1}{2} \cdot \frac{150 \text{ MHz}}{150 \text{ kHz}} = 500 \]

\[ \text{CMPA} = (100\% - \text{duty cycle}) \cdot \text{TBPRD} = 0.75 \cdot 500 = 375 \]

**Asymmetric PWM Computation Example**

- Determine TBPRD and CMPA for 150 kHz, 25% duty asymmetric PWM from a 150 MHz time base clock

\[ \text{TBPRD} = \frac{f_{TBCLK}}{f_{PWM}} - 1 = \frac{150 \text{ MHz}}{150 \text{ kHz}} - 1 = 999 \]

\[ \text{CMPA} = (100\% - \text{duty cycle}) \cdot \text{(TBPRD+1)} - 1 = 0.75 \cdot (999+1) - 1 = 749 \]
Motivation for Dead-Band

*Transistor gates turn on faster than they shut off*
*Short circuit if both gates are on at the same time!*
Dead-band control provides a convenient means of combating current shoot-through problems in a power converter. Shoot-through occurs when both the upper and lower gates in the same phase of a power converter are open simultaneously. This condition shorts the power supply and results in a large current draw. Shoot-through problems occur because transistors open faster than they close, and because high-side and low-side power converter gates are typically switched in a complimentary fashion. Although the duration of the shoot-through current path is finite during PWM cycling, (i.e. the closing gate will eventually shut), even brief periods of a short circuit condition can produce excessive heating and over stress in the power converter and power supply.

Two basic approaches exist for controlling shoot-through: modify the transistors, or modify the PWM gate signals controlling the transistors. In the first case, the opening time of the transistor gate must be increased so that it (slightly) exceeds the closing time. One way to accomplish this is by adding a cluster of passive components such as resistors and diodes in series with the transistor gate, as shown in the next figure.

The resistor acts to limit the current rise rate towards the gate during transistor opening, thus increasing the opening time. When closing the transistor however, current flows unimpeded from the gate via the by-pass diode and closing time is therefore not affected. While this passive approach offers an inexpensive solution that is independent of the control microprocessor, it is
imprecise, the component parameters must be individually tailored to the power converter, and it cannot adapt to changing system conditions.

The second approach to shoot-through control separates transitions on complimentary PWM signals with a fixed period of time. This is called dead-band. While it is possible to perform software implementation of dead-band, the C28x offers on-chip hardware for this purpose that requires no additional CPU overhead. Compared to the passive approach, dead-band offers more precise control of gate timing requirements. In addition, the dead time is typically specified with a single program variable that is easily changed for different power converters or adapted on-line.

### ePWM Dead-Band Sub-Module Registers

*(lab file: EPwm.c)*

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBCTL</td>
<td>Dead-Band Control</td>
<td>EPwmxRegs.DBCONL.all =</td>
</tr>
<tr>
<td>DBRED</td>
<td>10-bit Rising Edge Delay</td>
<td>EPwmxRegs.DBRED =</td>
</tr>
<tr>
<td>DBFED</td>
<td>10-bit Falling Edge Delay</td>
<td>EPwmxRegs.DBFED =</td>
</tr>
</tbody>
</table>

Rising Edge Delay = $T_{TBCLK} \times DBRED$

Falling Edge Delay = $T_{TBCLK} \times DBFED$
ePWM Dead Band Control Register

**EPwmxRegs.DBCTL**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>15-6</td>
<td>reserved</td>
</tr>
<tr>
<td>5-4</td>
<td>IN_MODE</td>
</tr>
<tr>
<td>3-2</td>
<td>POLSEL</td>
</tr>
<tr>
<td>1-0</td>
<td>OUT_MODE</td>
</tr>
</tbody>
</table>

- **Polarity Select**
  - 00 = active high
  - 01 = active low complementary (RED)
  - 10 = active high complementary (FED)
  - 11 = active low

- **In-Mode Control**
  - 00 = PWMxA is source for RED and FED
  - 01 = PWMxA is source for FED
  - PWMxB is source for RED
  - 10 = PWMxA is source for RED
  - PWMxB is source for FED
  - 11 = PWMxB is source for RED and FED

- **Out-Mode Control**
  - 00 = disabled (DBM bypass)
  - 01 = PWMxA = no delay
  - PWMxB = FED
  - 10 = PWMxA = RED
  - PWMxB = no delay
  - 11 = RED & FED (DBM fully enabled)

---

ePWM PWM Chopper Sub-Module

**ePWM PWM Chopper Sub-Module**

- **16-Bit Time-Base Counter**
- **Compare Logic**
- **Action Qualifier**
- **Dead Band**
- **Trip Zone**
- **PWM Chopper**
- **Shadowed Compare Register**
- **Shadowed Compare Register**
- **Shadowed Period Register**

- **Clock Prescaler**
- **TBCLK**
- **EPWMxSYNCl**
- **EPWMxSYNCO**
- **SYSCLKOUT**

---
Purpose of the PWM Chopper

- Allows a high frequency carrier signal to modulate the PWM waveform generated by the Action Qualifier and Dead-Band modules
- Used with pulse transformer-based gate drivers to control power switching elements
### ePWM Chopper Sub-Module Registers

*(lab file: EPwm.c)*

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCCTL</td>
<td>PWM-Chopper Control</td>
<td>EPwxRegs.PCCTL.all =</td>
</tr>
</tbody>
</table>

#### ePWM Chopper Control Register

EPwxRegs.PCCTL

**Chopper Clk Duty Cycle**

<table>
<thead>
<tr>
<th>Value</th>
<th>Duty Cycle (%)</th>
<th>Value</th>
<th>Duty Cycle (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>000</td>
<td>1/8 (12.5%)</td>
<td>001</td>
<td>2/8 (25.0%)</td>
</tr>
<tr>
<td>010</td>
<td>3/8 (37.5%)</td>
<td>011</td>
<td>4/8 (50.0%)</td>
</tr>
<tr>
<td>100</td>
<td>5/8 (62.5%)</td>
<td>101</td>
<td>6/8 (75.0%)</td>
</tr>
<tr>
<td>110</td>
<td>7/8 (87.5%)</td>
<td>111</td>
<td>reserved</td>
</tr>
</tbody>
</table>

**Chopper Clk Freq.**

<table>
<thead>
<tr>
<th>Value</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>000</td>
<td>SYSCLKOUT/8 ÷ 1</td>
</tr>
<tr>
<td>001</td>
<td>SYSCLKOUT/8 ÷ 2</td>
</tr>
<tr>
<td>010</td>
<td>SYSCLKOUT/8 ÷ 3</td>
</tr>
<tr>
<td>011</td>
<td>SYSCLKOUT/8 ÷ 4</td>
</tr>
<tr>
<td>100</td>
<td>SYSCLKOUT/8 ÷ 5</td>
</tr>
<tr>
<td>101</td>
<td>SYSCLKOUT/8 ÷ 6</td>
</tr>
<tr>
<td>110</td>
<td>SYSCLKOUT/8 ÷ 7</td>
</tr>
<tr>
<td>111</td>
<td>SYSCLKOUT/8 ÷ 8</td>
</tr>
</tbody>
</table>

**Chopper Enable**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>disable (bypass)</td>
</tr>
<tr>
<td>1</td>
<td>enable</td>
</tr>
</tbody>
</table>

**One-Shot Pulse Width**

<table>
<thead>
<tr>
<th>Value</th>
<th>Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000</td>
<td>1 x SYSCLKOUT/8</td>
</tr>
<tr>
<td>0001</td>
<td>2 x SYSCLKOUT/8</td>
</tr>
<tr>
<td>0010</td>
<td>3 x SYSCLKOUT/8</td>
</tr>
<tr>
<td>0011</td>
<td>4 x SYSCLKOUT/8</td>
</tr>
<tr>
<td>0100</td>
<td>5 x SYSCLKOUT/8</td>
</tr>
<tr>
<td>0101</td>
<td>6 x SYSCLKOUT/8</td>
</tr>
<tr>
<td>0110</td>
<td>7 x SYSCLKOUT/8</td>
</tr>
<tr>
<td>0111</td>
<td>8 x SYSCLKOUT/8</td>
</tr>
<tr>
<td>1000</td>
<td>9 x SYSCLKOUT/8</td>
</tr>
<tr>
<td>1001</td>
<td>10 x SYSCLKOUT/8</td>
</tr>
<tr>
<td>1010</td>
<td>11 x SYSCLKOUT/8</td>
</tr>
<tr>
<td>1011</td>
<td>12 x SYSCLKOUT/8</td>
</tr>
<tr>
<td>1100</td>
<td>13 x SYSCLKOUT/8</td>
</tr>
<tr>
<td>1101</td>
<td>14 x SYSCLKOUT/8</td>
</tr>
<tr>
<td>1110</td>
<td>15 x SYSCLKOUT/8</td>
</tr>
<tr>
<td>1111</td>
<td>16 x SYSCLKOUT/8</td>
</tr>
</tbody>
</table>
Trip-Zone Features

- Trip-Zone has a fast, clock independent logic path to high-impedance the EPWMxA/B output pins
- Interrupt latency may not protect hardware when responding to over current conditions or short-circuits through ISR software
- Supports:  
  #1) one-shot trip for major short circuits or over current conditions  
  #2) cycle-by-cycle trip for current limiting operation

The power drive protection is a safety feature that is provided for the safe operation of systems such as power converters and motor drives. It can be used to inform the monitoring program of
motor drive abnormalities such as over-voltage, over-current, and excessive temperature rise. If the power drive protection interrupt is unmasked, the PWM output pins will be put in the high-impedance state immediately after the pin is driven low. An interrupt will also be generated.

### ePWM Trip-Zone Sub-Module Registers

*lab file: EPwm.c*

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>TZCTL</td>
<td>Trip-Zone Control</td>
<td>EPwmRegs.TZCTL.all =</td>
</tr>
<tr>
<td>TZSEL</td>
<td>Trip-Zone Select</td>
<td>EPwmRegs.TZSEL.all =</td>
</tr>
<tr>
<td>TZEINT</td>
<td>Enable Interrupt</td>
<td>EPwmRegs.TZEINT.all =</td>
</tr>
<tr>
<td>TZFLG</td>
<td>Trip-Zone Flag</td>
<td>EPwmRegs.TZFLG.all =</td>
</tr>
<tr>
<td>TZCLR</td>
<td>Trip-Zone Clear</td>
<td>EPwmRegs.TZCLR.all =</td>
</tr>
<tr>
<td>TZFRC</td>
<td>Trip-Zone Force</td>
<td>EPwmRegs.TZFRC.all =</td>
</tr>
</tbody>
</table>

### ePWM Trip-Zone Control Register

*EPwmRegs.TZCTL*

<table>
<thead>
<tr>
<th>15 - 4 reserved</th>
<th>3 - 2 TZB</th>
<th>1 - 0 TZA</th>
</tr>
</thead>
</table>

TZ1 to TZ6 Action on EPWMxB / EPWMxA
- 00 = high impedance
- 01 = force high
- 10 = force low
- 11 = do nothing (disable)
**ePWM Trip-Zone Select Register**

EPwm\(x\)Regs.TZSEL

- **One-Shot Trip Zone**
  
  (event only cleared under S/W control; remains latched)
  
  \(0 = \text{disable as trip source} \quad 1 = \text{enable as trip source}\)

- **Cycle-by-Cycle Trip Zone**
  
  (event cleared when CTR = 0; i.e. cleared every PWM cycle)
  
  \(0 = \text{disable as trip source} \quad 1 = \text{enable as trip source}\)

**ePWM Trip-Zone Enable Interrupt Register**

EPwm\(x\)Regs.TZEINT

- **One-Shot Interrupt Enable**
  
  \(0 = \text{disable} \quad 1 = \text{enable}\)

- **Cycle-by-Cycle Interrupt Enable**
  
  \(0 = \text{disable} \quad 1 = \text{enable}\)
ePWM Event-Trigger Sub-Module

Clock Prescaler

16-Bit Time-Base Counter

Compare Logic

Period Register

Action Qualifier

Dead Band

PWM Chopper

Trip Zone

EPWMxA

EPWMxB

TZy

SYSLCKOUT

EPWMxSYNCI

EPWMxSYNCO

ePWM Event-Trigger Interrupts and SOC

TBCTR

TBPRD

CMPB

CMPA

EPWMA

EPWMB

CTR = 0

CTR = PRD

CTR = CMPA

CTR = CMPB

CTR = CMPB
### ePWM Event-Trigger Sub-Module Registers

(lab file: EPwm.c)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>ETSEL</td>
<td>Event-Trigger Selection</td>
<td>EPwmRegs.ETSEL.all =</td>
</tr>
<tr>
<td>ETPS</td>
<td>Event-Trigger Pre-Scale</td>
<td>EPwmRegs.ETPS.all =</td>
</tr>
<tr>
<td>ETFLG</td>
<td>Event-Trigger Flag</td>
<td>EPwmRegs.ETFLG.all =</td>
</tr>
<tr>
<td>ETCLR</td>
<td>Event-Trigger Clear</td>
<td>EPwmRegs.ETCLR.all =</td>
</tr>
<tr>
<td>ETFRC</td>
<td>Event-Trigger Force</td>
<td>EPwmRegs.ETFRC.all =</td>
</tr>
</tbody>
</table>

### ePWM Event-Trigger Selection Register

EPwmRegs.ETSEL

<table>
<thead>
<tr>
<th>Bit</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>Enable SOCB / A</td>
<td>0 = disable, 1 = enable</td>
</tr>
<tr>
<td>14-12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10-8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7-4</td>
<td>Enable EPWMxINT</td>
<td>0 = disable, 1 = enable</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2-0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- EPWMxSOCB / A Select
  - 000 = reserved
  - 001 = CTR = 0
  - 010 = CTR = PRD
  - 011 = reserved
  - 100 = CTRU = CMPA
  - 101 = CTRD = CMPA
  - 110 = CTRU = CMPB
  - 111 = CTRD = CMPB

- EPWMxINT Select
  - 000 = reserved
  - 001 = CTR = 0
  - 010 = CTR = PRD
  - 011 = reserved
  - 100 = CTRU = CMPA
  - 101 = CTRD = CMPA
  - 110 = CTRU = CMPB
  - 111 = CTRD = CMPB
**Hi-Resolution PWM (HRPWM)**

- Significantly increases the resolution of conventionally derived digital PWM
- Uses 8-bit extensions to Compare registers (CMPxHR) and Phase register (TBPHSHR) for edge positioning control
- Typically used when PWM resolution falls below ~9-10 bits which occurs at frequencies greater than ~300 kHz (with system clock of 150 MHz)
- Not all ePWM outputs support HRPWM feature (see device datasheet)
eCAP

**Capture Module (eCAP)**

- The eCAP module timestamps transitions on a capture input pin

The capture units allow time-based logging of external TTL signal transitions on the capture input pins. The C28x has up to six capture units.

Capture units can be configured to trigger an A/D conversion that is synchronized with an external event. There are several potential advantages to using the capture for this function over the ADCSOC pin associated with the ADC module. First, the ADCSOC pin is level triggered, and therefore only low to high external signal transitions can start a conversion. The capture unit does not suffer from this limitation since it is edge triggered and can be configured to start a conversion on either rising edges or falling edges. Second, if the ADCSOC pin is held high longer than one conversion period, a second conversion will be immediately initiated upon completion of the first. This unwanted second conversion could still be in progress when a desired conversion is needed. In addition, if the end-of-conversion ADC interrupt is enabled, this second conversion will trigger an unwanted interrupt upon its completion. These two problems are not a concern with the capture unit. Finally, the capture unit can send an interrupt request to the CPU while it simultaneously initiates the A/D conversion. This can yield a time savings when computations are driven by an external event since the interrupt allows preliminary calculations to begin at the start-of-conversion, rather than at the end-of-conversion using the ADC end-of-conversion interrupt. The ADCSOC pin does not offer a start-of-conversion interrupt. Rather, polling of the ADCSOC bit in the control register would need to be performed to trap the externally initiated start of conversion.
Some Uses for the Capture Module

- Measure the time width of a pulse
- Low speed velocity estimation from incr. encoder:

Problem: At low speeds, calculation of speed based on a measured position change at fixed time intervals produces large estimate errors

Alternative: Estimate the speed using a measured time interval at fixed position intervals

\[ v_k \approx \frac{x_k - x_{k-1}}{\Delta t} \]

- Auxiliary PWM generation

### eCAP Module Block Diagram – Capture Mode

[Diagram of eCAP Module Block Diagram showing components such as Capture 1, Capture 2, Capture 3, Capture 4, 32-Bit Time-Stamp Counter, Event Logic, CAP1POL, CAP2POL, CAP3POL, CAP4POL, Polarity Select 1, Polarity Select 2, Polarity Select 3, Polarity Select 4, Prescale, ECAPx pin, and SYSCLKOUT.]
eCAP Module Block Diagram – APWM Mode

32-Bit Time-Stamp Counter

Period Register (CAP1)

Period Register (CAP3)

Shadowed

immediate mode

32-Bit Time-Stamp Counter

PWM Compare Logic

Compare Register (CAP2)

Compare Register (CAP4)

ECAP pin

SYSCLKOUT

immediate mode

eCAP Module Registers

(lab file: ECap.c)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>ECCTL1</td>
<td>Capture Control 1</td>
<td>ECap.xRegs.ECCTL1.all =</td>
</tr>
<tr>
<td>ECCTL2</td>
<td>Capture Control 2</td>
<td>ECap.xRegs.ECCTL2.all =</td>
</tr>
<tr>
<td>TSCTR</td>
<td>Time-Stamp Counter</td>
<td>ECap.xRegs.TSCTR =</td>
</tr>
<tr>
<td>CTRPHS</td>
<td>Counter Phase Offset</td>
<td>ECap.xRegs.CTRPHS =</td>
</tr>
<tr>
<td>CAP1</td>
<td>Capture 1</td>
<td>ECap.xRegs.CAP1 =</td>
</tr>
<tr>
<td>CAP2</td>
<td>Capture 2</td>
<td>ECap.xRegs.CAP2 =</td>
</tr>
<tr>
<td>CAP3</td>
<td>Capture 3</td>
<td>ECap.xRegs.CAP3 =</td>
</tr>
<tr>
<td>CAP4</td>
<td>Capture 4</td>
<td>ECap.xRegs.CAP4 =</td>
</tr>
<tr>
<td>ECEINT</td>
<td>Enable Interrupt</td>
<td>ECap.xRegs.ECEINT.all =</td>
</tr>
<tr>
<td>ECFLG</td>
<td>Interrupt Flag</td>
<td>ECap.xRegs.ECFLG.all =</td>
</tr>
<tr>
<td>ECCLR</td>
<td>Interrupt Clear</td>
<td>ECap.xRegs.ECCLR.all =</td>
</tr>
<tr>
<td>ECFRC</td>
<td>Interrupt Force</td>
<td>ECap.xRegs.ECFRC.all =</td>
</tr>
</tbody>
</table>
#### eCAP Control Register 1
ECap×Regs.ECCTL1

**Upper Register:**

<table>
<thead>
<tr>
<th>Bits</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>15 - 14</td>
<td>FREE_SOFT</td>
</tr>
<tr>
<td>13 - 9</td>
<td>PRESCALE</td>
</tr>
<tr>
<td>8</td>
<td>CAPLDEN</td>
</tr>
</tbody>
</table>

- **Emulation Control**
  - 00 = TSCTR stops immediately
  - 01 = TSCTR runs until equals 0
  - 1X = free run (do not stop)

- **Event Filter Prescale Counter**
  - 00000 = divide by 1 (bypass)
  - 00001 = divide by 2
  - 00010 = divide by 4
  - 00011 = divide by 6
  - 00100 = divide by 8
  - ...
  - 11110 = divide by 60
  - 11111 = divide by 62

**CAP1 – 4 Load on Capture Event**
- 0 = disable
- 1 = enable

**Lower Register:**

- **Counter Reset on Capture Event**
  - 0 = no reset (absolute time stamp mode)
  - 1 = reset after capture (difference mode)

- **Capture Event Polarity**
  - 0 = trigger on rising edge
  - 1 = trigger on falling edge
**eCAP Control Register 2**

**Upper Register:**

Capture / APWM mode
- 0 = capture mode
- 1 = APWM mode

- 15 - 11: reserved
- 10: APWM POL
- 9: CAP_APWM
- 8: SW_SYNC

- APWM Output Polarity (valid only in APWM mode)
  - 0 = active high output
  - 1 = active low output

- Software Force Counter Synchronization
  - 0 = no effect
  - 1 = TSCTR load of current module and other modules if SYNCO_SEL bits = 00

**Lower Register:**

- 7 - 6: SYNCO_SEL
- 5: SYNCI_EN
- 4: TSCTRSTOP
- 3: REARM
- 2 - 1: STOP_WRAP, CONT_ONESHT

- Counter Sync-In
  - 0 = disable
  - 1 = enable

- Re-arm (capture mode only)
  - 0 = no effect
  - 1 = arm sequence

- Continuous/One-Shot (capture mode only)
  - 0 = continuous mode
  - 1 = one-shot mode

- Sync-Out Select
  - 00 = sync-in to sync-out
  - 01 = CTR = PRD event generates sync-out
  - 1X = disable

- Time Stamp Counter Stop
  - 0 = stop
  - 1 = run

- Stop Value for One-Shot Mode/ Wrap Value for Continuous Mode (capture mode only)
  - 00 = stop/wrap after capture event 1
  - 01 = stop/wrap after capture event 2
  - 10 = stop/wrap after capture event 3
  - 11 = stop/wrap after capture event 4
The capture unit interrupts offer immediate CPU notification of externally captured events. In situations where this is not required, the interrupts can be masked and flag testing/polling can be used instead. This offers increased flexibility for resource management. For example, consider a servo application where a capture unit is being used for low-speed velocity estimation via a pulsing sensor. The velocity estimate is not used until the next control law calculation is made, which is driven in real-time using a timer interrupt. Upon entering the timer interrupt service routine, software can test the capture interrupt flag bit. If sufficient servo motion has occurred since the last control law calculation, the capture interrupt flag will be set and software can proceed to compute a new velocity estimate. If the flag is not set, then sufficient motion has not occurred and some alternate action would be taken for updating the velocity estimate. As a second example, consider the case where two successive captures are needed before a computation proceeds (e.g. measuring the width of a pulse). If the width of the pulse is needed as soon as the pulse ends, then the capture interrupt is the best option. However, the capture interrupt will occur after each of the two captures, the first of which will waste a small number of cycles while the CPU is interrupted and then determines that it is indeed only the first capture. If the width of the pulse is not needed as soon as the pulse ends, the CPU can check, as needed, the capture registers to see if two captures have occurred, and proceed from there.

![eCAP Interrupt Enable Register](image-url)
What is an Incremental Quadrature Encoder?

A digital (angular) position sensor

photo sensors spaced $\theta/4$ deg. apart
slots spaced $\theta$ deg. apart
light source (LED)

Incremental Optical Encoder

Quadrature Output from Photo Sensors

The eQEP circuit, when enabled, decodes and counts the quadrature encoded input pulses. The QEP circuit can be used to interface with an optical encoder to get position and speed information from a rotating machine.

How is Position Determined from Quadrature Signals?

Position resolution is $\theta/4$ degrees

Increment counter
Decrement counter

Quadrature Decoder State Machine

((00) (11) (10) (01))

Ch. A
Ch. B

Illegal Transitions; generate phase error interrupt
eQEP Module Block Diagram

- **Quadrature Capture**: Monitors the quadrature clock to indicate proper operation of the motion control system.
- **Measure the elapsed time between the unit position events; used for low speed measurement.**
- **Quadrature Decoder**: Generate the direction and clock for the position counter in quadrature count mode.
- **Watchdog**: Monitors the quadrature clock to indicate proper operation of the motion control system.
- **Position/Counter Compare**: Generate a sync output and/or interrupt on a position compare match.

**eQEP Module Connections**

- **32-Bit Unit Time-Base**: Generate periodic interrupts for velocity calculations.
- **SYCLKOUT**: Generate a sync output and/or interrupt on a position compare match.
- **Quadrature Capture**: Measure the elapsed time between the unit position events; used for low speed measurement.
- **Quadrature Decoder**: Generate the direction and clock for the position counter in quadrature count mode.
- **Watchdog**: Monitors the quadrature clock to indicate proper operation of the motion control system.
Lab 7: Control Peripherals

**Objective**

The objective of this lab is to become familiar with the programming and operation of the control peripherals and their interrupts. ePWM1A will be setup to generate a 2 kHz, 25% duty cycle symmetric PWM waveform. The waveform will then be sampled with the on-chip analog-to-digital converter and displayed using the graphing feature of Code Composer Studio. Next, eCAP1 will be setup to detect the rising and falling edges of the waveform. This information will be used to determine the width of the pulse and duty cycle of the waveform. The results of this step will be viewed numerically in a memory window.

**Procedure**

**Open the Project**

1. A project named Lab7 has been created for this lab. Open the project by clicking on Project ➔ Import Existing CCS/CCE Eclipse Project. The “Import” window will open then click Browse... next to the “Select root directory” box. Navigate to: C:\C28x\Labs\Lab7\Project and click OK. Then click Finish to import the project. All build options have been configured the same as the previous lab. The files used in this lab are:
Note: The ECap_7_8_9_10_12.c file will be added and used with eCAP1 to detect the rising and falling edges of the waveform in the second part of this lab exercise.

Setup Shared I/O and ePWM1

2. Edit Gpio.c and adjust the shared I/O pin in GPIO0 for the PWM1A function.

3. In EPwm_7_8_9_10_12.c, setup ePWM1 to implement the PWM waveform as described in the objective for this lab. The following registers need to be modified: TBCTL (set clock prescales to divide-by-1, no software force, sync and phase disabled), TBPRD, CMPA, CMPCTL (load on 0 or PRD), and AQCTLA (set on up count and clear on down count for output A). Software force, deadband, PWM chopper and trip action has been disabled. (Hint – notice the last steps enable the timer count mode and enable the clock to the ePWM module). Either calculate the values for TBPRD and CMPA (as a challenge) or make use of the global variable names and values that have been set using #define in the beginning of Lab.h file. Notice that ePWM2 has been initialized earlier in the code for the ADC lab. Save your work and close the modified files.

Build and Load

4. Click the “Build” button and watch the tools run in the Console window. Check for errors in the Problems window.

5. Click the “Debug” button (green bug). The “Debug Perspective” view should open, the program will load automatically, and you should now be at the start of main().

Run the Code – PWM Waveform

6. Open a memory window to view some of the contents of the ADC results buffer. The address label for the ADC results buffer is AdcBuf in the “Data” memory page. We will be running our code in real-time mode, and we will need to have the memory window continuously refresh.

7. Using a connector wire provided, connect the PWM1A (pin # GPIO-00) to ADCINA0 (pin # ADC-A0) on the Docking Station.

8. Run the code (real-time mode) using the Script function: Scripts → Realtime Emulation Control → Run_Realtime_with_Reset. Watch the window update. Verify that the ADC result buffer contains the updated values.
9. Open and setup a graph to plot a 48-point window of the ADC results buffer. Click: Tools ➔ Graph ➔ Single Time and set the following values:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acquisition Buffer Size</td>
<td>48</td>
</tr>
<tr>
<td>DSP Data Type</td>
<td>16-bit unsigned integer</td>
</tr>
<tr>
<td>Sampling Rate (Hz)</td>
<td>48000</td>
</tr>
<tr>
<td>Start Address</td>
<td>AdcBuf</td>
</tr>
<tr>
<td>Display Data Size</td>
<td>48</td>
</tr>
<tr>
<td>Time Display Unit</td>
<td>μs</td>
</tr>
</tbody>
</table>

Select OK to save the graph options.

10. The graphical display should show the generated 2 kHz, 25% duty cycle symmetric PWM waveform. The period of a 2 kHz signal is 500 μs. You can confirm this by measuring the period of the waveform using the “measurement marker mode” graph feature. Disable continuous refresh for the graph before taking the measurements. Right-click on the graph and select Measurement Marker Mode. Move the mouse to the first measurement position and left-click. Again, right-click on the graph and select Measurement Marker Mode. Move the mouse to the second measurement position and left-click. The graph will automatically calculate the difference between the two values taken over a complete waveform period. When done, clear the measurement points by right-clicking on the graph and select Remove All Measurement Marks. Then enable continuous refresh for the graph.

**Frequency Domain Graphing Feature of Code Composer Studio**

11. Code Composer Studio also has the ability to make frequency domain plots. It does this by using the PC to perform a Fast Fourier Transform (FFT) of the DSP data. Let's make a frequency domain plot of the contents in the ADC results buffer (i.e. the PWM waveform).

Click: Tools ➔ Graph ➔ FFT Magnitude and set the following values:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acquisition Buffer Size</td>
<td>48</td>
</tr>
<tr>
<td>DSP Data Type</td>
<td>16-bit unsigned integer</td>
</tr>
<tr>
<td>Sampling Rate (Hz)</td>
<td>48000</td>
</tr>
<tr>
<td>Start Address</td>
<td>AdcBuf</td>
</tr>
<tr>
<td>Data Plot Style</td>
<td>Bar</td>
</tr>
<tr>
<td>FFT Order</td>
<td>10</td>
</tr>
</tbody>
</table>
Select OK to save the graph options.

12. On the plot window, hold the mouse left-click key and move the marker line to observe the frequencies of the different magnitude peaks. Do the peaks occur at the expected frequencies?

13. Fully halt the CPU (real-time mode) by using the Script function:Scripts → Realtime Emulation Control → Full_Halt.

**Setup eCAP1 to Measure Width of Pulse**

The first part of this lab exercise generated a 2 kHz, 25% duty cycle symmetric PWM waveform which was sampled with the on-chip analog-to-digital converter and displayed using the graphing feature of Code Composer Studio. Next, eCAP1 will be setup to detect the rising and falling edges of the waveform. This information will be used to determine the period and duty cycle of the waveform. The results of this step will be viewed numerically in a memory window and can be compared to the results obtained using the graphing features of Code Composer Studio.

14. Switch to the “C/C++ Perspective” view by clicking the C/C++ icon in the upper right-hand corner. Add the following file to the project from C:\C28x\Labs\Lab7\Files: ECap_7_8_9_10_12.c Check your files list to make sure the file is there.

15. In Main_7.c, add code to call the InitECap() function. There are no passed parameters or return values, so the call code is simply:

   InitECap();

16. Edit Gpio.c and adjust the shared I/O pin in GPIO5 for the ECAP1 function.

17. Open and inspect the eCAP1 interrupt service routine (ECAP1_INT_ISR) in the file DefaultIsr_7.c. Notice that PwmDuty is calculated by CAP2 – CAP1 (rising to falling edge) and that PwmPeriod is calculated by CAP3 – CAP1 (rising to rising edge).

18. In ECap_7_8_9_10_12.c, setup eCAP1 to calculate PWM_duty and PWM_period. The following registers need to be modified: ECCTL2 (continuous mode, re-arm disable, and sync disable), ECCTL1 (set prescale to divide-by-1, configure capture event polarity without resetting the counter), and ECEINT (enable desired eCAP interrupt).

19. Using the “PIE Interrupt Assignment Table” find the location for the eCAP1 interrupt “ECAP1_INT” and fill in the following information:

   PIE group #:_________    # within group:_________

   This information will be used in the next step.

20. Modify the end of ECap_7_8_9_10_12.c to do the following:
   - Enable the “ECAP1_INT” interrupt in the PIE (Hint: use the PieCtrlRegs structure)
   - Enable the appropriate core interrupt in the IER register
Build and Load

21. Save all changes to the files and click the “Build” button. Select Yes to “Reload the program automatically”. Switch back to the “Debug Perspective” view by clicking the Debug icon in the upper right-hand corner.

Run the Code – Pulse Width Measurement

22. Open a memory window to view the address label PwmPeriod. (Type &PwmPeriod in the address box). The address label PwmDuty (address &PwmDuty) should appear in the same memory window.

23. Set the memory window properties format to “32-Bit Unsigned Integer”.

24. Using the connector wire provided, connect the PWM1A (pin # GPIO-00) to ECAP1 (pin # GPIO-05) on the Docking Station.

25. Run the code (real-time mode) by using the Script function: Scripts → Realtime Emulation Control → Run_Realtime_with_Reset. Notice the values for PwmDuty and PwmPeriod.

26. Fully halt the CPU (real-time mode) by using the Script function: Scripts → Realtime Emulation Control → Full_Halt.

Questions:

• How do the captured values for PwmDuty and PwmPeriod relate to the compare register CMPA and time-base period TBPRD settings for ePWM1A?
• What is the value of PwmDuty in memory?
• What is the value of PwmPeriod in memory?
• How does it compare with the expected value?

Terminate Debug Session and Close Project

27. Terminate the active debug session using the Terminate All button. This will close the debugger and return CCS to the “C/C++ Perspective” view.

28. Next, close the project by right-clicking on Lab7 in the C/C++ Projects window and select Close Project.

End of Exercise
Introduction

In this module, numerical concepts will be explored. One of the first considerations concerns multiplication – how does the user store the results of a multiplication, when the process of multiplication creates results larger than the inputs. A similar concern arises when considering accumulation – especially when long summations are performed. Next, floating-point concepts will be explored and IQmath will be described as a technique for implementing a “virtual floating-point” system to simplify the design process.

The IQmath Library is a collection of highly optimized and high precision mathematical functions used to seamlessly port floating-point algorithms into fixed-point code. These C/C++ routines are typically used in computationally intensive real-time applications where optimal execution speed and high accuracy is needed. By using these routines a user can achieve execution speeds considerably faster than equivalent code written in standard ANSI C language. In addition, by incorporating the ready-to-use high precision functions, the IQmath library can shorten significantly a DSP application development time. (The IQmath user's guide is included in the application zip file, and can be found in the /docs folder once the file is extracted and installed).

Learning Objectives

- Integers and Fractions
- IEEE-754 Floating-Point
- IQmath
- Format Conversion of ADC Results
Module Topics

Numerical Concepts

Module Topics

Numbering System Basics .................................................................................................................................. 8-1
  Binary Numbers ........................................................................................................................................... 8-3
  Two's Complement Numbers ...................................................................................................................... 8-3
  Integer Basics .......................................................................................................................................... 8-4
  Sign Extension Mode ................................................................................................................................. 8-5

Binary Multiplication .................................................................................................................................... 8-6

Binary Fractions ........................................................................................................................................... 8-8
  Representing Fractions in Binary .............................................................................................................. 8-8
  Fraction Basics ......................................................................................................................................... 8-8
  Multiplying Binary Fractions .................................................................................................................... 8-9

Fraction Coding .......................................................................................................................................... 8-11

Fractional vs. Integer Representation ......................................................................................................... 8-12

Floating-Point ............................................................................................................................................. 8-13

IQmath .......................................................................................................................................................... 8-16
  IQ Fractional Representation .................................................................................................................... 8-16
  Traditional “Q” Math Approach .................................................................................................................. 8-17
  IQmath Approach .................................................................................................................................... 8-19

IQmath Library ............................................................................................................................................. 8-24

Converting ADC Results into IQ Format .................................................................................................... 8-26

AC Induction Motor Example ....................................................................................................................... 8-28

IQmath Summary .......................................................................................................................................... 8-34

Lab 8: IQmath & Floating-Point FIR Filter ................................................................................................. 8-35
Numbering System Basics

Given the ability to perform arithmetic processes (addition and multiplication) with the C28x, it is important to understand the underlying mathematical issues which come into play. Therefore, we shall examine the numerical concepts which apply to the C28x and, to a large degree, most processors.

Binary Numbers

The binary numbering system is the simplest numbering scheme used in computers, and is the basis for other schemes. Some details about this system are:

- It uses only two values: 1 and 0
- Each binary digit, commonly referred to as a bit, is one “place” in a binary number and represents an increasing power of 2.
- The least significant bit (LSB) is to the right and has the value of 1.
- Values are represented by setting the appropriate 1’s in the binary number.
- The number of bits used determines how large a number may be represented.

Examples:

\[ \begin{align*}
0110_2 &= (0 \times 8) + (1 \times 4) + (1 \times 2) + (0 \times 1) = 6_{10} \\
11110_2 &= (1 \times 16) + (1 \times 8) + (1 \times 4) + (1 \times 2) + (0 \times 1) = 30_{10}
\end{align*} \]

Two's Complement Numbers

Notice that binary numbers can only represent positive numbers. Often it is desirable to be able to represent both positive and negative numbers. The two's complement numbering system modifies the binary system to include negative numbers by making the most significant bit (MSB) negative. Thus, two's complement numbers:

- Follow the binary progression of simple binary except that the MSB is negative — in addition to its magnitude
- Can have any number of bits — more bits allow larger numbers to be represented

Examples:

\[ \begin{align*}
0110_2 &= (0 \times -8) + (1 \times 4) + (1 \times 2) + (0 \times 1) = 6_{10} \\
11110_2 &= (1 \times -16) + (1 \times 8) + (1 \times 4) + (1 \times 2) + (0 \times 1) = -2_{10}
\end{align*} \]

The same binary values are used in these examples for two's complement as were used above for binary. Notice that the decimal value is the same when the MSB is 0, but the decimal value is quite different when the MSB is 1.

Two operations are useful in working with two's complement numbers:

- The ability to obtain an additive inverse of a value
- The ability to load small numbers into larger registers (by sign extending)
To load small two's complement numbers into larger registers:

The MSB of the original number must carry to the MSB of the number when represented in the larger register.

1. Load the small number “right justified” into the larger register.
2. Copy the sign bit (the MSB) of the original number to all unfilled bits to the left in the register (sign extension).

Consider our two previous values, copied into an 8-bit register:

**Examples:**

<table>
<thead>
<tr>
<th>Original No.</th>
<th>0 1 1 0₂</th>
<th>= 6₁₀</th>
<th>1 1 1 1 0₂</th>
<th>= -2₁₀</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Load low</td>
<td>0 1 1 0</td>
<td></td>
<td>1 1 1 1 0</td>
<td></td>
</tr>
<tr>
<td>2. Sign Extend</td>
<td>0 0 0 0 1 1 0</td>
<td>= 4 + 2 = 6</td>
<td>1 1 1 1 1 1 0</td>
<td>= -128 + 64 + ... + 2 = -2</td>
</tr>
</tbody>
</table>

**Integer Basics**

<table>
<thead>
<tr>
<th>±2ⁿ⁻¹ ...</th>
<th>2³</th>
<th>2²</th>
<th>2¹</th>
<th>2⁰</th>
</tr>
</thead>
</table>

- **Unsigned Binary Integers**
  \[0100b = (0\times2^3)+(1\times2^2)+(0\times2^1)+(0\times2^0) = 4\]
  \[1101b = (1\times2^3)+(1\times2^2)+(0\times2^1)+(1\times2^0) = 13\]

- **Signed Binary Integers (2’s Complement)**
  \[0100b = (0\times-2^3)+(1\times2^2)+(0\times2^1)+(0\times2^0) = 4\]
  \[1101b = (1\times-2^3)+(1\times2^2)+(0\times2^1)+(1\times2^0) = -3\]
Sign Extension Mode

The C28x can operate on either unsigned binary or two's complement operands. The “Sign Extension Mode” (SXM) bit, present within a status register of the C28x, identifies whether or not the sign extension process is used when a value is brought into the accumulator. It is good programming practice to always select the desired SXM at the beginning of a module to assure the proper mode.

What is Sign Extension?

- When moving a value from a narrowed width location to a wider width location, the sign bit is extended to fill the width of the destination
- Sign extension applies to signed numbers only
- It keeps negative numbers negative!
- Sign extension controlled by SXM bit in ST0 register; When SXM = 1, sign extension happens automatically

4 bit Example: Load a memory value into the ACC

<table>
<thead>
<tr>
<th>memory</th>
<th>1101</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load and sign extend</td>
<td></td>
</tr>
<tr>
<td>ACC</td>
<td>1111 1101</td>
</tr>
</tbody>
</table>

\[
\text{memory } 1101 = -2^3 + 2^2 + 2^0 = -3
\]
\[
\text{ACC } 1111 \text{ 1101} = -2^7 + 2^6 + 2^5 + 2^4 + 2^3 + 2^2 + 2^0 = -128 + 64 + 32 + 16 + 8 + 4 + 1 = -3
\]
Binary Multiplication

Now that you understand two's complement numbers, consider the process of multiplying two two's complement values. As with “long hand” decimal multiplication, we can perform binary multiplication one “place” at a time, and sum the results together at the end to obtain the total product.

**Note:** This is not the method the C28x uses in multiplying numbers — it is merely a way of observing how binary numbers work in arithmetic processes.

The C28x uses 16-bit operands and a 32-bit accumulator. For the sake of clarity, consider the example below where we shall investigate the use of 4-bit values and an 8-bit accumulation:

### Integer Multiplication (signed)

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0100</td>
<td>4</td>
</tr>
<tr>
<td>x 1101</td>
<td>x -3</td>
</tr>
<tr>
<td>0000 0100</td>
<td></td>
</tr>
<tr>
<td>0000000</td>
<td></td>
</tr>
<tr>
<td>000100</td>
<td></td>
</tr>
<tr>
<td>11100</td>
<td></td>
</tr>
<tr>
<td>11110100</td>
<td></td>
</tr>
</tbody>
</table>

**Accumulator** 11110100

**Data Memory** ?

In this example, consider the following:

- What are the two input values, and the expected result?
- Why are the “partial products” shifted left as the calculation continues?
- Why is the final partial product “different” than the others?
- What is the result obtained when adding the partial products?
- How shall this result be loaded into the accumulator?
- How shall we fill the remaining bit? Is this value still the expected one?
- How can the result be stored back to memory? What problems arise?
Note: With two’s complement multiplication, the leading “1” in the second multiplicand is a sign bit. If the sign bit is “1”, then take the 2’s complement of the first multiplicand. Additionally, each partial product must be sign-extended for correct computation.

Note: All of the above questions except the final one are addressed in this module. The last question may have several answers:

- Store the lower accumulator to memory. What problem is apparent using this method in this example?
- Store the upper accumulator back to memory. Wouldn't this create a loss of precision, and a problem in how to interpret the results later?
- Store both the upper and lower accumulator to memory. This solves the above problems, but creates some new ones:
  - Extra code space, memory space, and cycle time are used
  - How can the result be used as the input to a subsequent calculation? Is such a condition likely (consider any “feedback” system)?

From this analysis, it is clear that integers do not behave well when multiplied. Might some other type of number system behave better? Is there a number system where the results of a multiplication are bounded?
Binary Fractions

Given the problems associated with integers and multiplication, consider the possibilities of using fractional values. Fractions do not grow when multiplied, therefore, they remain representable within a given word size and solve the problem. Given the benefit of fractional multiplication, consider the issues involved with using fractions:

- How are fractions represented in two's complement?
- What issues are involved when multiplying two fractions?

Representing Fractions in Binary

In order to represent both positive and negative values, the two's complement process will again be used. However, in the case of fractions, we will not set the LSB to 1 (as was the case for integers). When one considers that the range of fractions is from -1 to ~+1, and that the only bit which conveys negative information is the MSB, it seems that the MSB must be the “negative ones position.” Since binary representation is based on powers of two, it follows that the next bit would be the “one-halves” position, and that each following bit would have half the magnitude again. Considering, as before, a 4-bit model, we have the representation shown in the following example.

\[
\begin{array}{cccc}
1 & 0 & 1 & 1 \\
-1 & 1/2 & 1/4 & 1/8
\end{array}
\]

= -1 + 1/4 + 1/8 = -5/8

Fraction Basics

Fractions have the nice property that fraction \times fraction = fraction
Multiplying Binary Fractions

When the C28x performs multiplication, the process is identical for all operands, integers or fractions. Therefore, the user must determine how to interpret the results. As before, consider the 4-bit multiply example:

<table>
<thead>
<tr>
<th>Fraction Multiplication</th>
</tr>
</thead>
<tbody>
<tr>
<td>0100 \times 1101</td>
</tr>
<tr>
<td>00000100</td>
</tr>
<tr>
<td>00000000</td>
</tr>
<tr>
<td>000100</td>
</tr>
<tr>
<td>11100</td>
</tr>
<tr>
<td>11110100</td>
</tr>
</tbody>
</table>

\[ 1/2 \times -3/8 = -3/16 \]

As before, consider the following:

- What are the two input values and the expected result?
- As before, “partial products” are shifted left and the final is negative.
- How is the result (obtained when adding the partial products) read?
- How shall this result be loaded into the accumulator?
- How shall we fill the remaining bit? Is this value still the expected one?
- How can the result be stored back to memory? What problems arise?

To “read” the results of the fractional multiply, it is necessary to locate the binary point (the base 2 equivalent of the base 10 decimal point). Start by identifying the location of the binary point in the input values. The MSB is an integer and the next bit is 1/2, therefore, the binary point would be located between them. In our example, therefore, we would have three bits to the right of the binary point in each input value. For ease of description, we can refer to these as “Q3” numbers, where Q refers to the number of places to the right of the point.

When multiplying numbers, the Q values add. Thus, we would (mentally) place a binary point above the sixth LSB. We can now calculate the “Q6” result more readily.
As with integers, the results are loaded low and the MSB is a sign extension of the seventh bit. If this value were loaded into the accumulator, we could store the results back to memory in a variety of ways:

- Store both low and high accumulator values back to memory. This offers maximum detail, but has the same problems as with integer multiply.
- Store only the high (or low) accumulator back to memory. This creates a potential for a memory littered with varying Q-types.
- Store the upper accumulator shifted to the left by 1. This would store values back to memory in the same Q format as the input values, and with equal precision to the inputs. How shall the left shift be performed? Here’s three methods:
  - Explicit shift (C or assembly code)
  - Shift on store (assembly code)
  - Use Product Mode shifter (assembly code)
**Fraction Coding**

Although COFF tools recognize values in integer, hex, binary, and other forms, they understand only integer, or non-fractional values. To use fractions within the C28x, it is necessary to describe them as though they were integers. This turns out to be a very simple trick. Consider the following number lines:

<table>
<thead>
<tr>
<th>Fraction</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>~1</td>
<td>0x7FFF</td>
</tr>
<tr>
<td>½</td>
<td>0x4000</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>-½</td>
<td>0xC000</td>
</tr>
<tr>
<td>-1</td>
<td>0x8000</td>
</tr>
</tbody>
</table>

Multiplying a fraction by 32K (32768), a normalized fraction is created, which can be passed through the COFF tools as an integer. Once in the C28x, the normalized fraction looks and behaves exactly as a fraction. Thus, when using fractional constants in a C28x program, the coder first multiplies the fraction by 32768, and uses the resulting integer (rounded to the nearest whole value) to represent the fraction.

The following is a simple, but effective method for getting fractions past the assembler:

1. Express the fraction as a decimal number (drop the decimal point).
2. Multiply by 32768.
3. Divide by the proper multiple of 10 to restore the decimal position.

**Examples:**

- To represent 0.62: \(32768 \times 62 / 100\)
- To represent 0.1405: \(32768 \times 1405 / 10000\)

This method produces a valid number accurate to 16 bits. You will not need to do the math yourself, and changing values in your code becomes rather simple.
Fractional vs. Integer Representation

<table>
<thead>
<tr>
<th>Integer vs. Fractions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Range</strong></td>
</tr>
<tr>
<td>Integer</td>
</tr>
<tr>
<td>Fraction</td>
</tr>
</tbody>
</table>

- **Integers grow when you multiply them**
- **Fractions have limited range**
  - Fractions can still grow when you add them
  - Scaling an application is time consuming

Are there any other alternatives?

The C28x accumulator, a 32-bit register, adds extra range to integer calculations, but this becomes a problem in storing the results back to 16-bit memory.

Conversely, when using fractions, the extra accumulator bits increase precision, which helps minimize accumulative errors. Since any number is accurate (at best) to ± one-half of a LSB, summing two of these values together would yield a worst case result of 1 LSB error. Four summations produce two LSBs of error. By 256 summations, eight LSBs are “noisy.” Since the accumulator holds 32 bits of information, and fractional results are stored from the high accumulator, the extra range of the accumulator is a major benefit in noise reduction for long sum-of-products type calculations.
Floating-Point

**IEEE-754 Single Precision Floating-Point**

```
| 31 | 30 | 29 | 28 | 27 | 26 | 25 | 24 | 23 | 22 | 21 | 20 | 19 | 18 | 17 | 16 | 15 | 14 | 13 | 12 | 11 | 10 | 9  | 8  | 7  | 6  | 5  | 4  | 3  | 2  | 1  | 0  |
|-----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|
| s   | eeee | fffffffffffffff |
```

- **1 bit sign**
- **8 bit exponent**
- **23 bit mantissa (fraction)**

- **Case 1:** if `e = 255` and `f ≠ 0`, then `v = NaN`
- **Case 2:** if `e = 255` and `f = 0`, then `v = \((-1)^s\)\text{infinity}`
- **Case 3:** if `0 < e < 255`, then `v = \((-1)^s\)\text{2}^{(e-127)}\text{1.f}`
- **Case 4:** if `e = 0` and `f ≠ 0`, then `v = \((-1)^s\)\text{2}^{(-126)}\text{0.f}`
- **Case 5:** if `e = 0` and `f = 0`, then `v = \((-1)^s\)\text{0}`

**Example:** `0\times41200000 = 0` 100 0001 0 010 0000 0000 ... 0000 b

```
<table>
<thead>
<tr>
<th>s</th>
<th>e</th>
<th>f</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>130</td>
<td>2.26</td>
</tr>
</tbody>
</table>
```

⇒ **Case 3**

\[
v = (-1)^s \times 2^{(130-127)} \times 1.25 = 10.0
\]

**Advantage ⇒** Exponent gives large dynamic range

**Disadvantage ⇒** Precision of a number depends on its exponent

---

**Number Line Insight**

**Floating-Point:**

- **Non-uniform distribution**
  - Precision greatest near zero
  - Less precision the further you get from zero
Using Floating-Point

- Note: You must be using a C28x Delfino device with hardware floating-point support!
- Selecting a floating-point device variant when creating a new CCS project automatically adds the FPU RTS library and selects 'fpu32' support in build configuration settings

- Adds the floating-point RTS library(s) to the CCS project
  - standard RTS lib (required)
    - rts2800_fpu32.lib
    - comes with compiler
  - fast RTS lib (optional)
    - C28x_FPU_FastRTS.lib
    - on TI web, #SPRC664
    - improved performance
    - **Strongly Recommended**
- Selects 'fpu32' support in CCS build configuration settings

```c
#define AdcFsVoltage float(3.0)    // ADC full scale voltage
float Result;                       // ADC result
void main(void)
{
    // Convert unsigned 16-bit result to 32-bit float.  Gives value of 0 to 4095.
    // Scale result by 1/4096.  Gives value of 0 to -1.
    // Scale result by AdcFsVoltage.  Gives value of 0 to -3.0.
    Result = (AdcFsVoltage/4096.0)*(float)AdcMirror.ADCRESULT0;
}
```

Compiler will pre-compute at build-time.
No runtime division!

Getting the ADC Result into Floating-Point Format

AdcMirror. ADCRESULTx

ASM: II16TOF32

C: (float)

32-bit float

31 15 0

00000000000000000000000000000000

#define AdcFsVoltage float(3.0)    // ADC full scale voltage
float Result;                       // ADC result
void main(void)
{
    // Convert unsigned 16-bit result to 32-bit float.  Gives value of 0 to 4095.
    // Scale result by 1/4096.  Gives value of 0 to -1.
    // Scale result by AdcFsVoltage.  Gives value of 0 to -3.0.
    Result = (AdcFsVoltage/4096.0)*(float)AdcMirror.ADCRESULT0;
}
```

Compiler will pre-compute at build-time.
No runtime division!
Floating-Point Pros and Cons

◆ Advantages
  • Easy to write code
  • No scaling required

◆ Disadvantages
  • Somewhat higher device cost
  • May offer insufficient precision for some calculations due to 23 bit mantissa and the influence of the exponent

What if you don’t have the luxury of using a floating-point C28x device?
IQmath

Implementing complex digital control algorithms on a Digital Signal Processor (DSP), or any other DSP capable processor, typically come across the following issues:

- Algorithms are typically developed using floating-point math
- Floating-point devices are more expensive than fixed-point devices
- Converting floating-point algorithms to a fixed-point device is very time consuming
- Conversion process is one way and therefore backward simulation is not always possible

The design may initially start with a simulation (i.e. MatLab) of a control algorithm, which typically would be written in floating-point math (C or C++). This algorithm can be easily ported to a floating-point device, however because of cost reasons most likely a 16-bit or 32-bit fixed-point device would be used in many target systems.

The effort and skill involved in converting a floating-point algorithm to function using a 16-bit or 32-bit fixed-point device is quite significant. A great deal of time (many days or weeks) would be needed for reformatting, scaling and coding the problem. Additionally, the final implementation typically has little resemblance to the original algorithm. Debugging is not an easy task and the code is not easy to maintain or document.

IQ Fractional Representation

A new approach to fixed-point algorithm development, termed “IQmath”, can greatly simplify the design development task. This approach can also be termed “virtual floating-point” since it looks like floating-point, but it is implemented using fixed-point techniques.

| Advantage | Precision same for all numbers in an IQ format |
| Disadvantage | Limited dynamic range compared to floating-point |

**IQ Fractional Representation**

-2^1 + 2^{-1} + \ldots + 2^1 + 2^0 \cdot 2^{-1} + 2^{-2} + \ldots + 2^{-Q}

**Example:**

I8Q24 Example: 0x41200000

- 0100 0001 . 0010 0000 0000 0000 0000 b
- 2^6 + 2^0 + 2^{-3} = 65.125
The IQmath approach enables the seamless portability of code between fixed and floating-point devices. This approach is applicable to many problems that do not require a large dynamic range, such as motor or digital control applications.

**Number Line Insight**

**Distributions**

*Floating-Point: non-uniform distribution (variable precision)*

```
+∞ 0  -∞
```

*IQ Fractions: uniform distribution (same precision everywhere)*

```
+∞ 0  -∞
```

- Both floating-point and IQ formats have $2^{32}$ possible values on the number line
- It’s how each distributes these values that differs

**Traditional “Q” Math Approach**

**Traditional 32-bit “Q” Math Approach**

$y = mx + b$

```
I16   Q48
```

```
I16   Q48
```

```
<< 24  Align Decimal Point for Add
```

```
I16   Q48
```

```
>> 24  Align Decimal Point for Store
```

in C:

```
Y = ((int64) M * (int64) X + (int64) B << Q) >> Q;
```

Note: Requires support for 64-bit integer data type in compiler
The traditional approach to performing math operations, using fixed-point numerical techniques can be demonstrated using a simple linear equation example. The floating-point code for a linear equation would be:

```c
float Y, M, X, B;
Y = M * X + B;
```

For the fixed-point implementation, assume all data is 32-bits, and that the "Q" value, or location of the binary point, is set to 24 fractional bits (Q24). The numerical range and resolution for a 32-bit Q24 number is as follows:

<table>
<thead>
<tr>
<th>Q value</th>
<th>Min Value</th>
<th>Max Value</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q24</td>
<td>$-2^{32-24} = -128.000,000,000$</td>
<td>$2^{32-24} - \frac{1}{2^{24}} = 127.999,999,94$</td>
<td>$\frac{1}{2^{24}} = 0.000,000,06$</td>
</tr>
</tbody>
</table>

The C code implementation of the linear equation is:

```c
int32 Y, M, X, B; // numbers are all Q24
Y = ((int64) M * (int64) X + (int64) B << 24) >> 24;
```

Compared to the floating-point representation, it looks quite cumbersome and has little resemblance to the floating-point equation. It is obvious why programmers prefer using floating-point math.

The slide shows the implementation of the equation on a processor containing hardware that can perform a 32x32 bit multiplication, 64-bit addition and 64-bit shifts (logical and arithmetic) efficiently.

The basic approach in traditional fixed-point "Q" math is to align the binary point of the operands that get added to or subtracted from the multiplication result. As shown in the slide, the multiplication of M and X (two Q24 numbers) results in a Q48 value that is stored in a 64-bit register. The value B (Q24) needs to be scaled to a Q48 number before addition to the M*X value (low order bits zero filled, high order bits sign extended). The final result is then scaled back to a Q24 number (arithmetic shift right) before storing into Y (Q24). Many programmers may be familiar with 16-bit fixed-point "Q" math that is in common use. The same example using 16-bit numbers with 15 fractional bits (Q15) would be coded as follows:

```c
int16 Y, M, X, B; // numbers are all Q15
Y = ((int32) M * (int32) X + (int32) B << 15) >> 15;
```

In both cases, the principal methodology is the same. The binary point of the operands that get added to or subtracted from the multiplication result must be aligned.
In the "IQmath" approach, rather than scaling the operands, which get added to or subtracted from the multiplication result, we do the reverse. The multiplication result binary point is scaled back such that it aligns to the operands, which are added to or subtracted from it. The C code implementation of this is given by the linear equation below:

```c
int32 Y, M, X, B;
Y = ((int64) M * (int64) X) >> 24 + B;
```

The slide shows the implementation of the equation on a processor containing hardware that can perform a 32x32 bit multiply, 32-bit addition/subtraction and 64-bit logical and arithmetic shifts efficiently.

The key advantage of this approach is shown by what can then be done with the C and C++ compiler to simplify the coding of the linear equation example.

Let's take an additional step and create a multiply function in C that performs the following operation:

```c
int32 _IQ24mpy(int32 M, int32 X) { return ((int64) M * (int64) X) >> 24; }
```

The linear equation can then be written as follows:

```c
Y = _IQ24mpy(M, X) + B;
```

Already we can see a marked improvement in the readability of the linear equation.
Using the operator overloading features of C++, we can overload the multiplication operand "*" such that when a particular data type is encountered, it will automatically implement the scaled multiply operation. Let’s define a data type called "iq" and assign the linear variables to this data type:

```cpp
iq Y, M, X, B // numbers are all Q24
```

The overloading of the multiply operand in C++ can be defined as follows:

```cpp
iq operator*(const iq &M, const iq &X){return((int64)M*(int64) X) >> 24;}
```

Then the linear equation, in C++, becomes:

```cpp
Y = M * X + B;
```

This final equation looks identical to the floating-point representation. It looks "natural". The four approaches are summarized in the table below:

<table>
<thead>
<tr>
<th>Math Implementations</th>
<th>Linear Equation Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>32-bit floating-point math in C</td>
<td>Y = M * X + B;</td>
</tr>
<tr>
<td>32-bit fixed-point &quot;Q&quot; math in C</td>
<td>Y = ((int64) M * (int64) X) + (int64) B &lt;&lt; 24) &gt;&gt; 24;</td>
</tr>
<tr>
<td>32-bit IQmath in C</td>
<td>Y = _IQ24mpy(M, X) + B;</td>
</tr>
<tr>
<td>32-bit IQmath in C++</td>
<td>Y = M * X + B;</td>
</tr>
</tbody>
</table>

Essentially, the mathematical approach of scaling the multiplier operand enables a cleaner and a more "natural" approach to coding fixed-point problems. For want of a better term, we call this approach "IQmath" or can also be described as "virtual floating-point".
**IQmath Approach**

**Multiply Operation**

\[ Y = ((i64) M \times (i64) X) >> Q + B; \]

Redefine the multiply operation as follows:

\[ _{IQmpy}(M, X) == ((i64) M \times (i64) X) >> Q \]

This simplifies the equation as follows:

\[ Y = _{IQmpy}(M, X) + B; \]

C28x compiler supports "_IQmpy" intrinsic; assembly code generated:

| MOVL XT, @M |
| IMPYL P, XT, @X | ; P = low 32-bits of M*X |
| QMPYL ACC, XT, @X | ; ACC = high 32-bits of M*X |
| LSL64 ACC, P, #(32-Q) | ; ACC = ACC: P << 32-Q |
| ADDL ACC, @B | ; (same as P = ACC: P >> Q) |
| MOVTL @Y, ACC | ; Add B |

; 7 Cycles

---

**IQmath Approach**

It looks like floating-point!

**Floating-Point**

```c
float Y, M, X, B;
Y = M * X + B;
```

**Traditional Fix-Point Q**

```c
long Y, M, X, B;
Y = ((i64) M * (i64) X + (i64) B << Q)) >> Q;
```

**“IQmath” In C**

```c
_iq Y, M, X, B;
Y = _IQmpy(M, X) + B;
```

**“IQmath” In C++**

```c
iq Y, M, X, B;
Y = M * X + B;
```

"IQmath" code is easy to read!
The basic "IQmath" approach was adopted in the creation of a standard math library for the Texas Instruments TMS320C28x DSP fixed-point processor. This processor contains efficient hardware for performing 32x32 bit multiply, 64-bit shifts (logical and arithmetic) and 32-bit add/subtract operations, which are ideally suited for 32 bit "IQmath".

Some enhancements were made to the basic "IQmath" approach to improve flexibility. They are:

Setting of GLOBAL_Q Parameter Value: Depending on the application, the amount of numerical resolution or dynamic range required may vary. In the linear equation example, we used a Q value of 24 (Q24). There is no reason why any value of Q can't be used. In the "IQmath" library, the user can set a GLOBAL_Q parameter, with a range of 1 to 30 (Q1 to Q30). All functions used in the program will use this GLOBAL_Q value. For example:

```
#define GLOBAL_Q 18  // set in "IQmathLib.h" file
_iq Y, M, X, B;
Y = _IQmpy(M, X) + B;  // all values are in Q = 18
```

The user can also explicitly specify the Q value to use:

```
#define GLOBAL_Q 20
_iq20 Y, M, X, B;
Y = _IQ20mpy(M, X) + B;  // all values are in Q = 20
```

The Q value must be consistent for all expressions in the same line of code.

### IQmath Approach

**GLOBAL_Q simplification**

User selects “Global Q” value for the whole application based on the required dynamic range or resolution, for example:

<table>
<thead>
<tr>
<th>GLOBAL_Q</th>
<th>Max Val</th>
<th>Min Val</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>28</td>
<td>7.999 999 996</td>
<td>-8.000 000 000</td>
<td>0.000 000 004</td>
</tr>
<tr>
<td>24</td>
<td>127.999 999 94</td>
<td>-128.000 000 00</td>
<td>0.000 000 06</td>
</tr>
<tr>
<td>20</td>
<td>2047.999 999</td>
<td>-2048.000 000</td>
<td>0.000 001</td>
</tr>
</tbody>
</table>

---

8 - 22 C2000 Delfino Workshop - Numerical Concepts
IQmath Provides Compatibility Between Floating-Point and Fixed-Point

1) Develop any mathematical function

\[ Y = _\text{IQmpy}(M, X) + B; \]

2) Select math type in IQmathLib.h

\[
\begin{align*}
\text{#if MATH_TYPE == IQ_MATH} & \quad \text{#if MATH_TYPE == FLOAT_MATH} \\
Y &= _\text{IQmpy}(M, X) \\
Y &= (\text{float})M \times (\text{float})X + (\text{float})B;
\end{align*}
\]

3) Compiler automatically converts to:

Compile & Run on Fixed-Point F282xx

Compile & Run on Floating-Point F283xx *

All “IQmath” operations have an equivalent floating-point operation

* Can also compile floating-point code on any floating-point compiler (e.g., PC, Matlab, fixed-point w/ RTS lib, etc.)


Selecting FLOAT_MATH or IQ_MATH Mode: As was highlighted in the introduction, we would ideally like to have a single source code that can execute on a floating-point or fixed-point target device simply by recompiling the code. The "IQmath" library supports this by setting a mode, which selects either IQ_MATH or FLOAT_MATH. This operation is performed by simply redefining the function in a header file. For example:

```
#if MATH_TYPE == IQ_MATH
#define _IQmpy(M , X) _IQmpy(M , X)
#elif MATH_TYPE == FLOAT_MATH
#define _IQmpy(M , X) (float) M * (float) X
#endif
```

Essentially, the programmer writes the code using the "IQmath" library functions and the code can be compiled for floating-point or "IQmath" operations.
IQmath Library

IQmath Library: Math & Trig Functions

<table>
<thead>
<tr>
<th>Operation</th>
<th>Floating-Point</th>
<th>“IQmath” in C</th>
<th>“IQmath” in C++</th>
</tr>
</thead>
<tbody>
<tr>
<td>constant</td>
<td>( A = 1.2345 )</td>
<td>( _{\text{iq}} A, B; )</td>
<td>( _{\text{iq}} A, B; )</td>
</tr>
<tr>
<td>multiply</td>
<td>( A \times B )</td>
<td>( _{\text{IQmpy}(A, B)} )</td>
<td>( _{\text{IQmpy}(A, B)} )</td>
</tr>
<tr>
<td>divide</td>
<td>( A / B )</td>
<td>( _{\text{IQdiv}(A, B)} )</td>
<td>( A / B )</td>
</tr>
<tr>
<td>add</td>
<td>( A + B )</td>
<td>( A + B )</td>
<td>( A + B )</td>
</tr>
<tr>
<td>subtract</td>
<td>( A - B )</td>
<td>( A - B )</td>
<td>( A - B )</td>
</tr>
<tr>
<td>boolean</td>
<td>( &gt;, &gt;=, &lt;, &lt;=, ==,</td>
<td>, &amp;,&amp;,</td>
<td></td>
</tr>
<tr>
<td>trig and power functions</td>
<td>( \sin(A),\cos(A) )</td>
<td>( _{\text{IQsin}(A)}, _{\text{IQcos}(A)} )</td>
<td>( _{\text{IQsin}(A)}, _{\text{IQcos}(A)} )</td>
</tr>
<tr>
<td></td>
<td>( \sin(A<em>2\pi),\cos(A</em>2\pi) )</td>
<td>( _{\text{IQsinPU}(A)}, _{\text{IQcosPU}(A)} )</td>
<td>( _{\text{IQsinPU}(A)}, _{\text{IQcosPU}(A)} )</td>
</tr>
<tr>
<td></td>
<td>( \text{atan}(A),\text{atan2}(A,B) )</td>
<td>( _{\text{IQatan}(A)}, _{\text{IQatan2}(A,B)} )</td>
<td>( _{\text{IQatan}(A)}, _{\text{IQatan2}(A,B)} )</td>
</tr>
<tr>
<td></td>
<td>( \sqrt(A),1/\sqrt(A) )</td>
<td>( _{\text{IQsqrt}(A)}, _{\text{IQisqrt}(A)} )</td>
<td>( _{\text{IQsqrt}(A)}, _{\text{IQisqrt}(A)} )</td>
</tr>
<tr>
<td>saturation</td>
<td>if(( A &gt; \text{Pos} )) ( A = \text{Pos} ) if(( A &lt; \text{Neg} )) ( A = \text{Neg} )</td>
<td>( _{\text{IQsat}(A,\text{Pos},\text{Neg})} )</td>
<td>( _{\text{IQsat}(A,\text{Pos},\text{Neg})} )</td>
</tr>
</tbody>
</table>

Accuracy of functions/operations approx ~28 to ~31 bits

Additionally, the "IQmath" library contains DSP library modules for filters (FIR & IIR) and Fast Fourier Transforms (FFT & IFFT).

IQmath Library: Conversion Functions

<table>
<thead>
<tr>
<th>Operation</th>
<th>Floating-Point</th>
<th>“IQmath” in C</th>
<th>“IQmath” in C++</th>
</tr>
</thead>
<tbody>
<tr>
<td>iq to iqN</td>
<td>( A )</td>
<td>( _{\text{IQtoIQN}(A)} )</td>
<td>( _{\text{IQtoIQN}(A)} )</td>
</tr>
<tr>
<td>iqN to iq</td>
<td>( A )</td>
<td>( _{\text{IQtoIQ}(A)} )</td>
<td>( _{\text{IQtoIQ}(A)} )</td>
</tr>
<tr>
<td>integer(iq)</td>
<td>(long) ( A )</td>
<td>( _{\text{IQint}(A)} )</td>
<td>( _{\text{IQint}(A)} )</td>
</tr>
<tr>
<td>fraction(iq)</td>
<td>( A ) (long)</td>
<td>( _{\text{IQfrac}(A)} )</td>
<td>( _{\text{IQfrac}(A)} )</td>
</tr>
<tr>
<td>iq = iq*long</td>
<td>( A ) (float) ( B )</td>
<td>( _{\text{IQmpy}(A,B)} )</td>
<td>( _{\text{IQmpy}(A,B)} )</td>
</tr>
<tr>
<td>integer(iq*long)</td>
<td>(long) ( A ) (float) ( B )</td>
<td>( _{\text{IQmpy}(A,B)} )</td>
<td>( _{\text{IQmpy}(A,B)} )</td>
</tr>
<tr>
<td>fraction(iq*long)</td>
<td>(long) ( A ) (float) ( B )</td>
<td>( _{\text{IQmpy}(A,B)} )</td>
<td>( _{\text{IQmpy}(A,B)} )</td>
</tr>
<tr>
<td>qN to iq</td>
<td>( A )</td>
<td>( _{\text{QNtoIQ}(A)} )</td>
<td>( _{\text{QNtoIQ}(A)} )</td>
</tr>
<tr>
<td>iq to qN</td>
<td>( A )</td>
<td>( _{\text{IQtoQN}(A)} )</td>
<td>( _{\text{IQtoQN}(A)} )</td>
</tr>
<tr>
<td>string to iq</td>
<td>( \text{atof}(\text{char}) )</td>
<td>( _{\text{atolQ}(\text{char})} )</td>
<td>( _{\text{atolQ}(\text{char})} )</td>
</tr>
<tr>
<td>IQ to float</td>
<td>( A )</td>
<td>( _{\text{IQtoF}(A)} )</td>
<td>( _{\text{IQtoF}(A)} )</td>
</tr>
<tr>
<td>IQ to ASCII</td>
<td>( \text{sprintf}(A,B,C) )</td>
<td>( _{\text{IQto}(A,B,C)} )</td>
<td>( _{\text{IQto}(A,B,C)} )</td>
</tr>
</tbody>
</table>

IQmath.lib > contains library of math functions
IQmathLib.h > C header file
IQmathCPP.h > C++ header file
16 vs. 32 Bits
The "IQmath" approach could also be used on 16-bit numbers and for many problems, this is sufficient resolution. However, in many control cases, the user needs to use many different "Q" values to accommodate the limited resolution of a 16-bit number.

With DSP devices like the TMS320C28x processor, which can perform 16-bit and 32-bit math with equal efficiency, the choice becomes more of productivity (time to market). Why bother spending a whole lot of time trying to code using 16-bit numbers when you can simply use 32-bit numbers, pick one value of "Q" that will accommodate all cases and not worry about spending too much time optimizing.

Of course there is a concern on data RAM usage if numbers that could be represented in 16 bits all use 32 bits. This is becoming less of an issue in today's processors because of the finer technology used and the amount of RAM that can be cheaply integrated. However, in many cases, this problem can be mitigated by performing intermediate calculations using 32-bit numbers and converting the input from 16 to 32 bits and converting the output back to 16 bits before storing the final results. In many problems, it is the intermediate calculations that require additional accuracy to avoid quantization problems.
Converting ADC Results into IQ Format

Getting the ADC Result into IQ Format

As you may recall, the converted values of the ADC can be placed in the upper 12 bit of the
RESULT0 register (when not using AdcMirror register). Before these values are filtered using
the IQmath library, they need to be put into the IQ format as a 32-bit long. For uni-polar ADC
inputs (i.e., 0 to 3 V inputs), a conversion to global IQ format can be achieved with:

\[
\text{IQresult\_unipolar} = \text{IQmpy}(_\text{IQ}(3.0), \text{IQ12toIQ}(_\text{iq}(\text{AdcRegs.ADCRESULT0})))
\]

How can we modify the above to recover bi-polar inputs, for example +/−1.5 volts? One could do
the following to offset the +1.5V analog biasing applied to the ADC input:

\[
\text{IQresult\_bipolar} = \text{IQmpy}(_\text{IQ}(3.0), \text{IQ12toIQ}(_\text{iq}(\text{AdcRegs.ADCRESULT0}))) - \text{IQ}(1.5)
\]

However, one can see that the largest intermediate value the equation above could reach is 3.0.
This means that it cannot be used with an IQ data type of IQ30 (IQ30 range is −2 < x < 2). Since
the IQmath library supports IQ types from IQ1 to IQ30, this could be an issue in some applica-
tions.

The following clever approach supports IQ types from IQ1 to IQ30:

\[
\text{IQresult\_bipolar} = \text{IQmpy}(_\text{IQ}(1.5), \text{IQ15toIQ}(_\text{iq}((\text{int16}) (\text{AdcRegs.ADCRESULT0} \oplus 0x8000))))
\]

The largest intermediate value that this equation could reach is 1.5. Therefore, IQ30 is easily
supported.
Can a Single ADC Interface Code Line be Written for IQmath and Floating-Point?

```c
#if MATH_TYPE == IQ_MATH
    #define AdcFsVoltage _IQ(3.0)           // ADC full scale voltage
#else  // MATH_TYPE is FLOAT_MATH
    #define AdcFsVoltage _IQ(3.0/4096.0)    // ADC full scale voltage
#endif

_iq Result;                                   // ADC result

void main(void)
{
    Result = _IQmpy(AdcFsVoltage, _IQ12toIQ( (_iq)AdcMirror.ADCRESULT0));
}
```

FLOAT_MATH

behavior: * does nothing float
AC Induction Motor Example

One of the more complex motor control algorithms

Sensorless, ACI induction machine direct rotor flux control
Goal: motor speed estimation & alpha-axis stator current estimation

The "IQmath" approach is ideally suited for applications where a large numerical dynamic range is not required. Motor control is an example of such an application (audio and communication algorithms are other applications). As an example, the IQmath approach has been applied to the sensor-less direct field control of an AC induction motor. This is probably one of the most challenging motor control problems and as will be shown later, requires numerical accuracy greater than 16-bits in the control calculations.

The above slide is a block diagram representation of the key control blocks and their interconnections. Essentially this system implements a "Forward Control" block for controlling the d-q axis motor current using PID controllers and a "Feedback Control" block using back emf's integration with compensated voltage from current model for estimating rotor flux based on current and voltage measurements. The motor speed is simply estimated from rotor flux differentiation and open-loop slip computation. The system was initially implemented on a "Simulator Test Bench" which uses a simulation of an "AC Induction Motor Model" in place of a real motor. Once working, the system was then tested using a real motor on an appropriate hardware platform.

Each individual block shown in the slide exists as a stand-alone C/C++ module, which can be interconnected to form the complete control system. This modular approach allows reusability and portability of the code. The next few slides show the coding of one particular block, PARK Transform, using floating-point and "IQmath" approaches in C:
The complete system was coded using "IQmath". Based on analysis of coefficients in the system, the largest coefficient had a value of 33.3333. This indicated that a minimum dynamic range of 7 bits (+/-64 range) was required. Therefore, this translated to a GLOBAL_Q value of 32-7 = 25 (Q25). Just to be safe, the initial simulation runs were conducted with GLOBAL_Q = 24 (Q24).
value. The plots start from a step change in reference speed from 0.0 to 0.5 and 1024 samples are taken.

The speed eventually settles to the desired reference value and the stator current exhibits a clean and stable oscillation. The block diagram slide shows at which points in the control system the plots are taken from.

What’s Happening Here?
Equal Precision in the Computation Region

Floating-Point:

I8Q24 Fractions:

Same precision as I8Q24

In the region where these particular computations occur, the precision of single-precision floating-point just happens to equal the precision of the I8Q24 format.

So, both produce similar results!
AC Induction Motor Example
GLOBAL_Q = 27, system unstable

IQmath: speed

IQmath: current

AC Induction Motor Example
GLOBAL_Q = 16, system unstable

IQmath: speed

IQmath: current
With the ability to select the GLOBAL_Q value for all calculations in the "IQmath", an experiment was conducted to see what maximum and minimum Q value the system could tolerate before it became unstable. The results are tabulated in the slide below:

<table>
<thead>
<tr>
<th>Q range</th>
<th>Stability Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q31 to Q27</td>
<td>Unstable (not enough dynamic range)</td>
</tr>
<tr>
<td>Q26 to Q19</td>
<td>Stable</td>
</tr>
<tr>
<td>Q18 to Q0</td>
<td>Unstable (not enough resolution, quantization problems)</td>
</tr>
</tbody>
</table>

The above indicates that, the AC induction motor system that we simulated requires a minimum of 7 bits of dynamic range (+/-64) and requires a minimum of 19 bits of numerical resolution (+/-0.000002). This confirms our initial analysis that the largest coefficient value being 33.33333 required a minimum dynamic range of 7 bits. As a general guideline, users using IQmath should examine the largest coefficient used in the equations and this would be a good starting point for setting the initial GLOBAL_Q value. Then, through simulation or experimentation, the user can reduce the GLOBAL_Q until the system resolution starts to cause instability or performance degradation. The user then has a maximum and minimum limit and a safe approach is to pick a midpoint.

What the above analysis also confirms is that this particular problem does require some calculations to be performed using greater than 16 bit precision. The above example requires a minimum of $7 + 19 = 26$ bits of numerical accuracy for some parts of the calculations. Hence, if one was implementing the AC induction motor control algorithm using a 16 bit fixed-point DSP, it would require the implementation of higher precision math for certain portions. This would take more cycles and programming effort.

The great benefit of using GLOBAL_Q is that the user does not necessarily need to go into details to assign an individual Q for each variable in a whole system, as is typically done in conventional fixed-point programming. This is time consuming work. By using 32-bit resolution and the "IQmath" approach, the user can easily evaluate the overall resolution and quickly implement a typical digital motor control application without quantization problems.
AC Induction Motor Example

Performance comparisons

<table>
<thead>
<tr>
<th>Benchmark</th>
<th>C28x C floating-point std. RTS lib (150 MHz)</th>
<th>C28x C floating-point fast RTS lib (150 MHz)</th>
<th>C28x C IQmath v1.4d (150 MHz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>B1: ACI module cycles</td>
<td>401</td>
<td>401</td>
<td>625</td>
</tr>
<tr>
<td>B2: Feedforward control cycles</td>
<td>421</td>
<td>371</td>
<td>403</td>
</tr>
<tr>
<td>B3: Feedback control cycles</td>
<td>2336</td>
<td>792</td>
<td>1011</td>
</tr>
<tr>
<td>Total control cycles (B2+B3)</td>
<td>2757</td>
<td>1163</td>
<td>1414</td>
</tr>
<tr>
<td>% of available MHz used (20 kHz control loop)</td>
<td>36.8%</td>
<td>15.5%</td>
<td>18.9%</td>
</tr>
</tbody>
</table>

Notes: C28x compiled on codegen tools v5.0.0, -g (debug enabled), -o3 (max. optimization)
fast RTS lib v1.0beta1
IQmath lib v1.4d

Using the profiling capabilities of the respective DSP tools, the table above summarizes the number of cycles and code size of the forward and feedback control blocks.

The MIPS used is based on a system sampling frequency of 20 kHz, which is typical of such systems.
IQmath Summary

IQmath Approach Summary

“IQmath” + fixed-point processor with 32-bit capabilities =

- Seamless portability of code between fixed and floating-point devices
  - User selects target math type in “IQmathLib.h” file
    - #if MATH_TYPE == IQ_MATH
    - #if MATH_TYPE == FLOAT_MATH
- One source code set for simulation vs. target device
- Numerical resolution adjustability based on application requirement
  - Set in “IQmathLib.h” file
    - #define GLOBAL_Q 18
  - Explicitly specify Q value
    - _iq20 X, Y, Z;
- Numerical accuracy without sacrificing time and cycles
- Rapid conversion/porting and implementation of algorithms

IQmath library is freeware - available from TI DSP website

The IQmath approach, matched to a fixed-point processor with 32x32 bit capabilities enables the following:

- Seamless portability of code between fixed and floating-point devices
- Maintenance and support of one source code set from simulation to target device
- Adjustability of numerical resolution (Q value) based on application requirement
- Implementation of systems that may otherwise require floating-point device
- Rapid conversion/porting and implementation of algorithms
Lab 8: IQmath & Floating-Point FIR Filter

Objective

The objective of this lab is to become familiar with IQmath and floating-point programming. In the previous lab, ePWM1A was setup to generate a 2 kHz, 25% duty cycle symmetric PWM waveform. The waveform was then sampled with the on-chip analog-to-digital converter. In this lab the sampled waveform will be passed through an FIR filter and displayed using the graphing feature of Code Composer Studio. The filter math type (IQmath and floating-point) will be selected in the “IQmathLib.h” file.

Procedure

Open the Project

1. A project named Lab8 has been created for this lab. Open the project by clicking on Project ➔ Import Existing CCS/CCE Eclipse Project. The “Import” window will open then click Browse... next to the “Select root directory” box. Navigate to: C:\C28x\Labs\Lab8\Project and click OK. Then click Finish to import the project. All build options have been configured the same as the previous lab. The files used in this lab are:
Lab 8: IQmath & Floating-Point FIR Filter

Project Build Options

2. Setup the build options by right-clicking on Lab8 in the C/C++ Projects window and select Properties. Then select the “C/C++ Build” Category. Be sure that the Tool Settings tab is selected.

3. We need to setup the include search path to include the IQmath header file. Under “C2000 Compiler” select “Include Options”. In the box that opens click the Add icon (first icon with green plus sign). Then in the “Add directory path” window type:

$\{PROJECT_ROOT\}/.../IQmath/include

Click OK to include the search path.

4. Next, we need to setup the library search path to include the IQmath library. Under “C2000 Linker” select “File Search Path”. In the top box click the Add icon. Then in the “Add file path” window type:

$\{PROJECT_ROOT\}/.../IQmath/lib/IQmath.lib

Click OK to include the library file.

In the bottom box click the Add icon. In the “Add directory path” window type:

$\{PROJECT_ROOT\}/.../IQmath/lib

Click OK to include the library search path.

Finally, select OK to save and close the build options window.

Include IQmathLib.h

5. In the C/C++ Projects window edit Lab.h and uncomment the line that includes the IQmathLib.h header file. Next, in the Function Prototypes section, uncomment the function prototype for IQssfir(), the IQ math single-sample FIR filter function. In the Global Variable References section uncomment the four _iq references, and comment out the reference to AdcBuf[ADC_BUF_LEN]. Save the changes and close the file.
Inspect Lab_8.cmd

6. Open and inspect Lab_8.cmd. First, notice that a section called “IQmath” is being linked to L0123SARAM. The IQmath section contains the IQmath library functions (code). Second, notice that a section called “IQmathTables” is being linked to the IQTABLES with a TYPE = NOLOAD modifier after its allocation. The IQmath tables are used by the IQmath library functions. The NOLOAD modifier allows the linker to resolve all addresses in the section, but the section is not actually placed into the .out file. This is done because the section is already present in the device ROM (you cannot load data into ROM after the device is manufactured!). The tables were put in the ROM by TI when the device was manufactured. All we need to do is link the section to the addresses where it is known to already reside (the tables are the very first thing in the BOOT ROM, starting at address 0x3FE000). Close the inspected file.

Select a Global IQ value

7. In the C/C++ Projects window under the Includes folder open: C:\C28x\Labs\IQmath\include\IQmathLib.h. Confirm that the GLOBAL_Q type (near beginning of file) is set to a value of 24. If it is not, modify as necessary:

```c
#define GLOBAL_Q 24
```

Recall that this Q type will provide 8 integer bits and 24 fractional bits. Dynamic range is therefore \(-128 \leq x \leq +128\), which is sufficient for our purposes in the workshop.

Notice that the math type is defined as IQmath by:

```c
#define MATH_TYPE IQ_MATH
```

Close the file.

IQmath Single-Sample FIR Filter

8. Open and inspect DefaultIsr_8.c. Notice that the ADCINT_ISR calls the IQmath single-sample FIR filter function, IQssfir(). The filter coefficients have been defined in the beginning of Main_8.c. Also, as discussed in the lecture for this module, the ADC results are read with the following instruction:

```c
*AdcBufPtr = _IQmpy(ADC_FS_VOLTAGE,
                   _IQ12toIQ((_iq)AdcMirror.ADCRESULT0));
```

The value of ADC_FS_VOLTAGE will be discussed in the next lab step.

9. Open and inspect Lab.h. Notice that, as discussed in the lecture for this module, ADC_FS_VOLTAGE is defined as:

```c
#if MATH_TYPE == IQ_MATH
   #define ADC_FS_VOLTAGE _IQ(3.0)
#else       // MATH_TYPE is FLOAT_MATH
   #define ADC_FS_VOLTAGE _IQ(3.0/4096.0)
#endif
```
10. Open and inspect the IQssfir() function in Filter.c. This is a simple, non-optimized coding of a basic IQmath single-sample FIR filter. Close the inspected files.

Build and Load

11. Click the “Build” button and watch the tools run in the Console window. Check for errors in the Problems window.

12. Click the “Debug” button (green bug). The “Debug Perspective” view should open, the program will load automatically, and you should now be at the start of main().

Run the Code – Filtered Waveform

13. Open a memory window to view some of the contents of the filtered ADC results buffer. The address label for the filtered ADC results buffer is AdcBufFiltered in the “Data” memory page. Set the format to 32-Bit Signed Integer. Right-click in the memory window, select Configure... and set the Q-Value to 24 (which matches the IQ format being used for this variable). Then click OK to save the setting. We will be running our code in real-time mode, and will need to have the window continuously refresh.

Note: For the next step, check to be sure that the jumper wire connecting PWM1A (pin # GPIO-00) to ADCINA0 (pin # ADC-A0) is in place on the Docking Station.

14. Run the code in real-time mode using the Script function: Scripts → Realtime Emulation Control → Run_Realtime_with_Reset, and watch the memory window update. Verify that the ADC result buffer contains updated values.

15. Open and setup a dual-time graph to plot a 48-point window of the filtered and unfiltered ADC results buffer. Click: Tools → Graph → Dual Time and set the following values:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acquisition Buffer Size</td>
<td>48</td>
</tr>
<tr>
<td>DSP Data Type</td>
<td>32-bit signed integer</td>
</tr>
<tr>
<td>Q Value</td>
<td>24</td>
</tr>
<tr>
<td>Sampling Rate (Hz)</td>
<td>48000</td>
</tr>
<tr>
<td>Start Address A</td>
<td>AdcBufFiltered</td>
</tr>
<tr>
<td>Start Address B</td>
<td>AdcBuf</td>
</tr>
<tr>
<td>Display Data Size</td>
<td>48</td>
</tr>
<tr>
<td>Time Display Unit</td>
<td>μs</td>
</tr>
</tbody>
</table>

Select OK to save the graph options.
16. The graphical display should show the generated FIR filtered 2 kHz, 25% duty cycle symmetric PWM waveform in the Dual Time A display and the unfiltered waveform generated in the previous lab exercise in the Dual Time B display. Notice the shape and phase differences between the waveform plots (the filtered curve has rounded edges, and lags the unfiltered plot by several samples). The amplitudes of both plots should run from 0 to 3.0.

17. Open and setup two (2) frequency domain plots – one for the filtered and another for the unfiltered ADC results buffer. Click: Tools → Graph → FFT Magnitude and set the following values:

<table>
<thead>
<tr>
<th></th>
<th>GRAPH #1</th>
<th>GRAPH #2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acquisition Buffer Size</td>
<td>48</td>
<td>48</td>
</tr>
<tr>
<td>DSP Data Type</td>
<td>32-bit signed integer</td>
<td>32-bit signed integer</td>
</tr>
<tr>
<td>Q Value</td>
<td>24</td>
<td>24</td>
</tr>
<tr>
<td>Sampling Rate (Hz)</td>
<td>48000</td>
<td>48000</td>
</tr>
<tr>
<td>Start Address</td>
<td>AdcBufFiltered</td>
<td>AdcBuf</td>
</tr>
<tr>
<td>Data Plot Style</td>
<td>Bar</td>
<td>Bar</td>
</tr>
<tr>
<td>FFT Order</td>
<td>10</td>
<td>10</td>
</tr>
</tbody>
</table>

Select OK to save the graph options.

18. The graphical displays should show the frequency components of the filtered and unfiltered 2 kHz, 25% duty cycle symmetric PWM waveforms. Notice that the higher frequency components are reduced using the Low-Pass FIR filter in the filtered graph as compared to the unfiltered graph.

19. Fully halt the CPU (real-time mode) by using the Script function: Scripts → Realtime Emulation Control → Full_Halt.

**Changing Math Type to Floating-Point**

20. Switch to the “C/C++ Perspective” view by clicking the C/C++ icon in the upper right-hand corner. In the C/C++ Projects window under the Includes folder open: C:\C28x\Labs\IQmath\include\IQmathLib.h. Edit IQmathLib.h to define the math type as floating-point. Change #define

    #define   MATH_TYPE      IQ_MATH

    to:

    #define   MATH_TYPE      FLOAT_MATH

    Save the change to the IQmathLib.h and close the file.
Build and Load

21. Click the “Build” button. Select Yes to “Reload the program automatically”. Switch back to the “Debug Perspective” view by clicking the Debug icon in the upper right-hand corner.

Run the Code – Floating-Point Filtered Waveform

22. Change the dual-time and FFT Magnitude graphs to display 32-bit floating-point rather than 32-bit signed integer. Click the “Show the Graph Properties” icon for each graph and change the DSP Data Type to 32-bit floating-point.

23. Run the code (real-time mode) by using the Script function: Scripts ➔ Realtime Emulation Control ➔ Run_Realtime_with_Reset.

24. The graphical display should show the generated FIR filtered 2 kHz, 25% duty cycle symmetric PWM waveform in the Dual Time A display and the unfiltered waveform in the Dual Time B display. The FFT Magnitude graphical displays should show the frequency components of the filtered and unfiltered 2 kHz, 25% duty cycle symmetric PWM waveforms.

25. Fully halt the CPU (real-time mode) by using the Script function: Scripts ➔ Realtime Emulation Control ➔ Full_Halt.

Terminate Debug Session and Close Project

26. Terminate the active debug session using the Terminate All button. This will close the debugger and return CCS to the “C/C++ Perspective” view.

27. Next, close the project by right-clicking on Lab8 in the C/C++ Projects window and select Close Project.

End of Exercise
Lab 8 Reference: Low-Pass FIR Filter

Bode Plot of Digital Low-Pass FIR Filter

Coefficients: \([1/16, 4/16, 6/16, 4/16, 1/16]\)

Sample Rate: 48 kHz
Lab 8: IQmath & Floating-Point FIR Filter
Direct Memory Access Controller

Introduction

This module explains the operation of the direct memory access (DMA) controller. The DMA provides a hardware method of transferring data between peripherals and/or memory without intervention from the CPU, thus freeing up bandwidth for other system functions. The DMA has six channels with independent PIE interrupts.

Learning Objectives

- Understand the operation of the Direct Memory Access (DMA) controller
- Show how to use the DMA to transfer data between peripherals and/or memory without intervention from the CPU
Module Topics

Direct Memory Access Controller .............................................................................................................. 9-1

Module Topics........................................................................................................................................ 9-2

Direct Memory Access (DMA) .................................................................................................................. 9-3
Basic Operation .................................................................................................................................... 9-4
DMA Examples ....................................................................................................................................... 9-6
DMA Priority Modes ............................................................................................................................... 9-9
DMA Throughput ................................................................................................................................. 9-10
DMA Registers ...................................................................................................................................... 9-11

Lab 9: Servicing the ADC with DMA....................................................................................................9-15
Direct Memory Access (DMA)

DMA Triggers, Sources, and Destinations

- ADC Result 0-15
- L4 SARAM
- L5 SARAM
- L6 SARAM
- L7 SARAM
- SEQ1INT / SEQ2INT
- MXEVTA / MREVTA
- MXEVTB / MREVTE
- XINT1-7 / 13
- TINT0 / 1 / 2
- PIE DINTCH1-6
- PWM1
- PWM2
- PWM3
- PWM4
- PWM5
- PWM6
- XINTF Zone 0, 6, 7
- McBSP-A
- McBSP-B
- L4 SARAM
- L5 SARAM
- L6 SARAM
- L7 SARAM
- SysCtrlRegs.MAPCNF.bit.MAPCNF - (re-maps PWM regs from PF1 to FF3)

DMA Definitions

- Word
  - 16 or 32 bits
  - Word size is configurable per DMA channel
- Burst
  - Consists of multiple words
  - Smallest amount of data transferred at one time
- Burst Size
  - Number of words per burst
  - Specified by BURST_SIZE register
    - 5-bit ‘N-1’ value (maximum of 32 words/burst)
- Transfer
  - Consists of multiple bursts
- Transfer Size
  - Number of bursts per transfer
  - Specified by TRANSFER_SIZE register
    - 16-bit ‘N-1’ value - exceeds any practical requirements
Basic Operation

Simplified State Machine Operation

The DMA state machine at its most basic level is two nested loops

Basic Address Control Registers

Active pointers

Pointer shadow registers copied to active pointers at start of transfer

Signed value added to active pointer after each word

Signed value added to active pointer after each burst
Direct Memory Access (DMA)

Simplified State Machine Example

3 words/burst
2 bursts/transfer

Wait for event to start/continue transfer
Read/Write Data

Moved “Burst Size” Words?

Moved “Transfer Size” Bursts?

Add Burst Step to Address Pointer

Add Transfer Step to Address Pointer

End Transfer

DMA Interrupts

Mode #1: Interrupt at start of transfer

Mode #2: Interrupt at end of transfer

Each DMA channel has its own PIE interrupt
The mode for each interrupt can be configured individually
The CHINTMODE bit in the MODE register selects the interrupt mode

Start Transfer

Wait for event to start/continue transfer
Read/Write Data

Moved “Burst Size” Words?

Moved “Transfer Size” Bursts?

Add Burst Step to Address Pointer

Add Transfer Step to Address Pointer

End Transfer
### DMA Examples

#### Simple Example

**Objective:** Move 4 words from L7 SARAM to XINTF Zone 0 and interrupt CPU at end of transfer

<table>
<thead>
<tr>
<th>Source Registers</th>
<th>Addr</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>SRC_ADDR</td>
<td>0xF000</td>
<td>0x711</td>
</tr>
<tr>
<td>SRC_ADDR_SHADOW</td>
<td>0x00004000</td>
<td>0x7222</td>
</tr>
<tr>
<td>SRC_BURST_STEP</td>
<td>0x0001</td>
<td>0x3333</td>
</tr>
<tr>
<td>SRC_TRANSFER_STEP</td>
<td>0x0003</td>
<td>0x4444</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Destination Registers</th>
<th>Addr</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DST_ADDR</td>
<td>0x00004000</td>
<td>0x0000</td>
</tr>
<tr>
<td>DST_BURST_STEP</td>
<td>0x0001</td>
<td>0x0000</td>
</tr>
<tr>
<td>DST_TRANSFER_STEP</td>
<td>0x0003</td>
<td>0x0000</td>
</tr>
</tbody>
</table>

- * Size registers are N-1

Note: This example could also have been done using 1 word/burst and 4 bursts/transfer, or 4 words/burst and 1 burst/transfer. This would affect Round-Robin progression, but not interrupts.

#### Data Binning Example

**Objective:** Bin 3 samples of 5 ADC channels, then interrupt the CPU

- **ADC Mirror Results:**
  - 3rd Conversion Sequence
    - 0x0B00 CH0
    - 0x0B01 CH1
    - 0x0B02 CH2
    - 0x0B03 CH3
    - 0x0B04 CH4

- L7 SARAM
  - CH0: 0xF000, 0xF001, 0xF002, 0xF003, 0xF004, 0xF005, 0xF006, 0xF007, 0xF008, 0xF009, 0xF00A, 0xF00B, 0xF00C, 0xF00D, 0xF00E
**Data Binning Example Register Setup**

**Objective:** Bin 3 samples of 5 ADC channels, then interrupt the CPU

**ADC Registers:**
- **ADCMAXCONV**: 0x0004 5 conversions per sequence

Other:
- ADC configured for continuous conversion,
  - SEQ_OVERRIDE bit set so that state pointer wraps after 5 conversions

**DMA Registers:**
- **BURST_SIZE**: 0x0004 5 words/burst
- **TRANSFER_SIZE**: 0x0002 3 bursts/transfer
- **SRC_ADDR_SHADOW**: 0x000000B00
- **SRC_BURST_STEP**: 0x0001
- **SRC_TRANSFER_STEP**: 0x00000B00/0x0001
- **DST_ADDR_SHADOW**: 0x0003
- **DST_BURST_STEP**: 0xFFF5 (-11)
- **DST_TRANSFER_STEP**: 0x00000B00/0x0003

**ADC Mirror Results**
- L7 SARAM

- 0xF000
- 0xF003
- 0xF006
- 0xF009
- 0xF00C
- 0xF00E

- CH0
- CH1
- CH2
- CH3
- CH4

- **DEFCC** (-4)

- **CH00x0B00**
- **0x0B01**
- **0x0B02**
- **0x0B03**
- **0x0B04**

**Objective**
- Bin 3 samples of 5 ADC channels, then interrupt the CPU

**ADCMAXCONV** 0x0004 5 conversions per sequence

**DMA Registers:**
- **BURST_SIZE**: 0x0004 5 words/burst
- **TRANSFER_SIZE**: 0x0002 3 bursts/transfer
- **SRC_ADDR_SHADOW**: 0x000000B00
- **SRC_BURST_STEP**: 0x0001
- **SRC_TRANSFER_STEP**: 0x00000B00/0x0001
- **DST_ADDR_SHADOW**: 0x0003
- **DST_BURST_STEP**: 0xFFF5 (-11)
- **DST_TRANSFER_STEP**: 0x00000B00/0x0003

**The State Machine ‘Wrap’ Function**

Provides another resource to manipulate the address pointers

**Wrap Function:**
- Reloading address pointer after specified number of bursts
- Allows a cumulative signed offset to be added each wrap

**New Registers**
- WRAP_SIZE = bursts/wrap - 1
- BEG_ADDR = Wrap beginning address
- WRAP_STEP = added to BEG_ADDR before wrapping
Ping-Pong Buffer Example

Objective: Buffer ADC ch. 0 ping-pong style, 48 samples per buffer

ADC Mirror Results

<table>
<thead>
<tr>
<th>Address</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>0xB00</td>
<td>ADCRESULT0</td>
</tr>
<tr>
<td>0xB01</td>
<td>ADCRESULT1</td>
</tr>
<tr>
<td>0xB02</td>
<td>ADCRESULT2</td>
</tr>
<tr>
<td>0xB03</td>
<td>ADCRESULT3</td>
</tr>
<tr>
<td>0xB04</td>
<td>ADCRESULT4</td>
</tr>
<tr>
<td>0xB05</td>
<td>ADCRESULT5</td>
</tr>
<tr>
<td>0xB06</td>
<td>ADCRESULT6</td>
</tr>
<tr>
<td>0xB07</td>
<td>ADCRESULT7</td>
</tr>
<tr>
<td>0xB08</td>
<td>ADCRESULT8</td>
</tr>
<tr>
<td>0xB09</td>
<td>ADCRESULT9</td>
</tr>
<tr>
<td>0xB0A</td>
<td>ADCRESULT10</td>
</tr>
<tr>
<td>0xB0B</td>
<td>ADCRESULT11</td>
</tr>
<tr>
<td>0xB0C</td>
<td>ADCRESULT12</td>
</tr>
<tr>
<td>0xB0D</td>
<td>ADCRESULT13</td>
</tr>
<tr>
<td>0xB0E</td>
<td>ADCRESULT14</td>
</tr>
<tr>
<td>0xB0F</td>
<td>ADCRESULT15</td>
</tr>
</tbody>
</table>

ADC Result Memories

<table>
<thead>
<tr>
<th>Address</th>
<th>Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>0xC140</td>
<td>ADCRESULT0</td>
</tr>
<tr>
<td>0xC141</td>
<td>ADCRESULT1</td>
</tr>
<tr>
<td>0xC142</td>
<td>ADCRESULT2</td>
</tr>
<tr>
<td>0xC143</td>
<td>ADCRESULT3</td>
</tr>
<tr>
<td>0xC144</td>
<td>ADCRESULT4</td>
</tr>
<tr>
<td>0xC145</td>
<td>ADCRESULT5</td>
</tr>
<tr>
<td>0xC146</td>
<td>ADCRESULT6</td>
</tr>
<tr>
<td>0xC147</td>
<td>ADCRESULT7</td>
</tr>
<tr>
<td>0xC148</td>
<td>ADCRESULT8</td>
</tr>
<tr>
<td>0xC149</td>
<td>ADCRESULT9</td>
</tr>
<tr>
<td>0xC14A</td>
<td>ADCRESULT10</td>
</tr>
<tr>
<td>0xC14B</td>
<td>ADCRESULT11</td>
</tr>
<tr>
<td>0xC14C</td>
<td>ADCRESULT12</td>
</tr>
<tr>
<td>0xC14D</td>
<td>ADCRESULT13</td>
</tr>
<tr>
<td>0xC14E</td>
<td>ADCRESULT14</td>
</tr>
<tr>
<td>0xC14F</td>
<td>ADCRESULT15</td>
</tr>
</tbody>
</table>

Ping-Pong Example Register Setup

Objective: Buffer ADC ch. 0 ping-pong style, 48 samples per buffer

ADC Registers:

- **ADCMAXCONV**: 0x0000 1 conversion per trigger - SEQ pointer auto wraps after 16 states

Other: All 16 Ch. selection fields configured for Ch. 0, ADC in non-continuous run mode

DMA Registers:

- **BURST_SIZE**: 0x0000 1 wordburst
- **TRANSFER_SIZE**: 0x002F 48 bursts/transfer
- **SRC_ADDR_SHADOW**: 0x00000B00 starting address since BURST_SIZE = 0
- **SRC_BURST_STEP**: don't care
- **SRC_TRANSFER_STEP**: 0x0001 starting wrap address wrap after 16 words
- **SRC_WRAP_SIZE**: 0x000F
- **SRC_WRAP_STEP**: 0x0000
- **DST_ADDR_SHADOW**: 0x00000C140 starting address** since BURST_SIZE = 0
- **DST_BURST_STEP**: don't care
- **DST_TRANSFER_STEP**: 0x0001 not using dst wrap
- **DST_WRAP_SIZE**: 0xFFFF no wrap
- **DST_WRAP_STEP**: don't care

Other: DMA configured to re-init after transfer (CONTINUOUS = 1)

* Size registers are N-1
** DST_ADDR_SHADOW must be changed between ping and pong buffer address in the DMA ISR. Typically use a relocatable symbol in your code, not a hard value.
DMA Priority Modes

Channel Priority Modes

- **Round Robin Mode:**
  - All channels have equal priority
  - After each enabled channel has transferred a burst of words, the next enabled channel is serviced in round robin fashion
- **Channel 1 High Priority Mode:**
  - Same as Round Robin except CH1 can interrupt DMA state machine
  - If CH1 trigger occurs, the current word (not the complete burst) on any other channel is completed and execution is halted
  - CH1 is serviced for complete burst
  - When completed, execution returns to previous active channel
  - This mode is intended primarily for the ADC, but can be used by any DMA event configured to trigger CH1

Priority Modes and the State Machine
DMA Throughput

4 cycles/word (5 for McBSP reads)
- 1 cycle delay to start each burst
- 1 cycle delay returning from CH1 high priority interrupt
- 32-bit transfer doubles throughput (except McBSP, which supports 16-bit transfers only)

Example: 128 16-bit words from ADC to RAM
8 bursts * [(4 cycles/word * 16 words/burst) + 1] = 520 cycles

Example: 64 32-bit words from ADC to RAM
8 bursts * [(4 cycles/word * 8 words/burst) + 1] = 264 cycles

DMA vs. CPU Access Arbitration

- DMA has priority over CPU
  - If a multi-cycle CPU access is already in progress (e.g. XINTF), DMA stalls until current CPU access finishes
  - The DMA will interrupt back-to-back CPU accesses
- Can the CPU be locked out?
  - Generally No!
  - DMA is multi-cycle transfer; CPU will sneak in an access when the DMA is accessing the other end of the transfer (e.g. while DMA accesses destination location, the CPU can access the source location)
DMA Registers

<table>
<thead>
<tr>
<th>Register</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMACTRL</td>
<td>DMA Control Register</td>
</tr>
<tr>
<td>PRIORITYCTRL1</td>
<td>Priority Control Register 1</td>
</tr>
<tr>
<td>MODE</td>
<td>Mode Register</td>
</tr>
<tr>
<td>CONTROL</td>
<td>Control Register</td>
</tr>
<tr>
<td>BURST_SIZE</td>
<td>Burst Size Register</td>
</tr>
<tr>
<td>BURST_COUNT</td>
<td>Burst Count Register</td>
</tr>
<tr>
<td>SRC_BURST_STEP</td>
<td>Source Burst Step Size Register</td>
</tr>
<tr>
<td>DST_BURST_STEP</td>
<td>Destination Burst Step Size Register</td>
</tr>
<tr>
<td>TRANSFER_SIZE</td>
<td>Transfer Size Register</td>
</tr>
<tr>
<td>TRANSFER_COUNT</td>
<td>Transfer Count Register</td>
</tr>
<tr>
<td>SRC_TRANSFER_STEP</td>
<td>Source Transfer Step Size Register</td>
</tr>
<tr>
<td>DST_TRANSFER_STEP</td>
<td>Destination Transfer Step Size Register</td>
</tr>
<tr>
<td>SRC_ADDR_SHADOW</td>
<td>Shadow Source Address Pointer Register</td>
</tr>
<tr>
<td>SRC_ADDR</td>
<td>Active Source Address Pointer Register</td>
</tr>
<tr>
<td>DST_ADDR_SHADOW</td>
<td>Shadow Destination Address Pointer Register</td>
</tr>
<tr>
<td>DST_ADDR</td>
<td>Active Destination Address Pointer Register</td>
</tr>
</tbody>
</table>

For a complete list of registers refer to the DMA Module Reference Guide

**DMA Control Register**

DmaRegs.DMACTRL

Hard Reset
0 = writes ignored (always reads back 0)
1 = reset DMA module

Priority Reset
0 = writes ignored (always reads back 0)
1 = reset state-machine after any pending burst transfer complete
Priority Control Register 1

DmaRegs.PRIORITYCTRL1

<table>
<thead>
<tr>
<th>15 - 1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>reserved</td>
<td>CH1PRIORITY</td>
</tr>
</tbody>
</table>

DMA CH1 Priority
0 = same priority as other channels
1 = highest priority channel

Mode Register

DmaRegs.CHx.MODE

Upper Register:

<table>
<thead>
<tr>
<th>15</th>
<th>14</th>
<th>13</th>
<th>12</th>
<th>11</th>
<th>10</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHINTE</td>
<td>DATASIZE</td>
<td>SYNCSSEL</td>
<td>SYMCE</td>
<td>CONTINUOUS</td>
<td>ONESHOT</td>
</tr>
</tbody>
</table>

Channel Interrupt
0 = disable
1 = enable

Sync Mode Select
0 = SRC wrap counter
1 = DST wrap counter

One Shot Mode
0 = one burst transfer per trigger
1 = subsequent burst transfers occur without additional trigger

Data Size Mode
0 = 16-bit transfer
1 = 32-bit transfer

Sync Enable (PERINTSEL)
0 = ADCSYNC ignored
1 = ADCSYNC event

Continuous Mode
0 = DMA stops
1 = DMA re-initializes
### Mode Register

**DmaRegs.CHx.MODE**

#### Lower Register:
- **Channel Interrupt Generation**
  - 0 = at beginning of transfer
  - 1 = at end of transfer

<table>
<thead>
<tr>
<th>Value</th>
<th>Interrupt</th>
<th>Sync</th>
<th>Peripheral</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>none</td>
<td>none</td>
<td>none</td>
</tr>
<tr>
<td>1</td>
<td>SEQ1INT</td>
<td>ADCSYNC</td>
<td>ADC</td>
</tr>
<tr>
<td>2</td>
<td>SEQ2INT</td>
<td>none</td>
<td>ADC</td>
</tr>
<tr>
<td>3</td>
<td>XINT1</td>
<td>none</td>
<td>Ext. Int.</td>
</tr>
<tr>
<td>4</td>
<td>XINT2</td>
<td>none</td>
<td>Ext. Int.</td>
</tr>
<tr>
<td>5</td>
<td>XINT3</td>
<td>none</td>
<td>Ext. Int.</td>
</tr>
<tr>
<td>6</td>
<td>XINT4</td>
<td>none</td>
<td>Ext. Int.</td>
</tr>
<tr>
<td>7</td>
<td>XINT5</td>
<td>none</td>
<td>Ext. Int.</td>
</tr>
<tr>
<td>8</td>
<td>XINT6</td>
<td>none</td>
<td>Ext. Int.</td>
</tr>
</tbody>
</table>

#### Peripheral Interrupt Source Select

<table>
<thead>
<tr>
<th>Value</th>
<th>Interrupt</th>
<th>Sync</th>
<th>Peripheral</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>XINT7</td>
<td>none</td>
<td>Ext. Int.</td>
</tr>
<tr>
<td>10</td>
<td>XINT13</td>
<td>none</td>
<td>Ext. Int.</td>
</tr>
<tr>
<td>11</td>
<td>TINT0</td>
<td>none</td>
<td>CPU Timer</td>
</tr>
<tr>
<td>12</td>
<td>TINT1</td>
<td>none</td>
<td>CPU Timer</td>
</tr>
<tr>
<td>13</td>
<td>TINT2</td>
<td>none</td>
<td>CPU Timer</td>
</tr>
<tr>
<td>14</td>
<td>MXEVTA</td>
<td>none</td>
<td>McBSP-A</td>
</tr>
<tr>
<td>15</td>
<td>MREVTA</td>
<td>none</td>
<td>McBSP-A</td>
</tr>
<tr>
<td>16</td>
<td>MXEVTB</td>
<td>none</td>
<td>McBSP-B</td>
</tr>
<tr>
<td>17</td>
<td>MREVVB</td>
<td>none</td>
<td>McBSP-B</td>
</tr>
</tbody>
</table>

#### Overflow Enable
- 0 = disable
- 1 = enable

### Control Register

**DmaRegs.CHx.CONTROL**

#### Upper Register:
- **Overflow Flag**
  - 0 = no overflow
  - 1 = overflow
- **Burst Status**
  - 0 = no activity
  - 1 = servicing burst
- **Sync Error**
  - 0 = no error
  - 1 = ADCSYNC error
- **Sync Flag**
  - 0 = no sync event
  - 1 = ADCSYNC event

<table>
<thead>
<tr>
<th>Value</th>
<th>Run Status</th>
<th>Transfer Status</th>
<th>Peripheral Interrupt Trigger Flag</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0 = disabled</td>
<td>0 = no activity</td>
<td>0 = no interrupt event trigger</td>
</tr>
<tr>
<td>1</td>
<td>1 = enabled</td>
<td>1 = transferring</td>
<td>1 = interrupt event trigger</td>
</tr>
</tbody>
</table>

* = read-only
Control Register
DmaRegs.CHx.CONTROL

Lower Register:

- **Error Clear**
  - 0 = no effect
  - 1 = clear SYNCERR

- **Sync Force**
  - 0 = no effect
  - 1 = sets SYNCFLG

- **Peripheral Interrupt Force**
  - 0 = no effect
  - 1 = sets event and PERINTFLG

- **Sync Clear**
  - 0 = no effect
  - 1 = clear SYNCFLG

- **Peripheral Interrupt Clear**
  - 0 = no effect
  - 1 = clears event and PERINTFLG

- **Soft Reset**
  - 0 = no effect
  - 1 = default state

- **Run**
  - 0 = no effect
  - 1 = run

- **Halt**
  - 0 = no effect
  - 1 = halt
Lab 9: Servicing the ADC with DMA

Objective

The objective of this lab is to become familiar with operation of the DMA. In the previous lab, the CPU was used to store the ADC conversion result in the memory buffer during the ADC ISR. In this lab the DMA will be configured to transfer the results directly from the ADC result registers to the memory buffer. ADC channel A0 will be buffered ping-pong style with 48 samples per buffer. As an operational test, the filtered 2 kHz, 25% duty cycle symmetric PWM waveform (ePWM1A) will be displayed using the graphing feature of Code Composer Studio.

Procedure

Open the Project

1. A project named Lab9 has been created for this lab. Open the project by clicking on Project ➔ Import Existing CCS/CCE Eclipse Project. The “Import” window will open then click Browse... next to the “Select root directory” box. Navigate to: C:\C28x\Labs\Lab9\Project and click OK. Then click Finish to import the project. All build options have been configured the same as the previous lab. The files used in this lab are:
Inspect Lab_9.cmd

2. Open and inspect Lab_9.cmd. Notice that a section called “dmaMemBufs” is being linked to L4SARAM. This section links the destination buffer for the DMA transfer to a DMA accessible memory space.

Setup DMA Initialization

The DMA controller needs to be configured to buffer ADC channel A0 ping-pong style with 48 samples per buffer. All 16 input channel selection sequences in the autosequencer need to be set to channel A0. One conversion will be performed per trigger with the ADC operating in non-continuous run mode. The autosequencer pointer will automatically wrap after 16 conversions.

3. Open Adc_9_10_12.c and notice that the ADCMAXCONV register has been set to perform one conversion per trigger. Also, the ADC input channel select sequencing control registers (ADCCHSELSEQx) have all been set to convert channel A0.

4. Edit Dma.c to implement the DMA operation as described in the objective for this lab exercise. Configure the DMA Channel 1 Mode Register (MODE) so that the ADC SEQ1INT is the peripheral interrupt source. Enable the channel interrupt and interrupt trigger with the interrupt generation at the start of transfer. Configure for 16-bit data transfers with one burst per trigger and auto re-initialization at the end of the transfer. Disable the ADC sync. In the DMA Channel 1 Control Register (CONTROL) clear the error, sync and peripheral interrupt bits and enable the channel to run.

5. Open Main_9.c and add a line of code in main() to call the InitDma() function. There are no passed parameters or return values. You just type

   InitDma();

   at the desired spot in main().

Setup PIE Interrupt for DMA

Recall that ePWM2 is triggering the ADC at a 48 kHz rate. In the previous lab exercise, the ADC generated an interrupt to the CPU, and the CPU implemented the FIR filter in the ADC ISR. For this lab exercise, the ADC is instead triggering the DMA, and the DMA will generate an interrupt to the CPU. The CPU will implement the FIR filter in the DMA ISR.
6. Edit Adc_9_10_12.c to comment out the code used to enable the ADC interrupt. This is no longer being used. The DMA interrupt will be used instead.

7. Using the “PIE Interrupt Assignment Table” find the location for the DMA Channel 1 interrupt “DINTCH1” and fill in the following information:

   PIE group #: __________ # within group: __________

   This information will be used in the next step.

8. Modify the end of Dma.c to do the following:
   - Enable the “DINTCH1” interrupt in the PIE (Hint: use the PieCtrlRegs structure)
   - Enable the appropriate core interrupt in the IER register

9. Open and inspect DefaultIsr_9_10_12a.c. Notice that this file contains the DMA interrupt service routine. Save and close all modified files.

**Build and Load**

10. Click the “Build” button and watch the tools run in the Console window. Check for errors in the Problems window.

11. Click the “Debug” button (green bug). The “Debug Perspective” view should open, the program will load automatically, and you should now be at the start of main().

**Run the Code – Test the DMA Operation**

**Note:** For the next step, check to be sure that the jumper wire connecting PWM1A (pin # GPIO-00) to ADCINA0 (pin # ADC-A0) is in place on the Docking Station.

12. Run the code in real-time mode using the Script function: Scripts → Realtime Emulation Control → Run_Realtime_with_Reset, and watch the memory window update. Verify that the ADC result buffer contains updated values.

13. Setup a dual-time graph of the filtered and unfiltered ADC results buffer. Click:

   Tools → Graph → Dual Time and set the following values:
<table>
<thead>
<tr>
<th>Table: Servicing the ADC with DMA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acquisition Buffer Size</td>
</tr>
<tr>
<td>DSP Data Type</td>
</tr>
<tr>
<td>Sampling Rate (Hz)</td>
</tr>
<tr>
<td>Start Address – A</td>
</tr>
<tr>
<td>Start Address – B</td>
</tr>
<tr>
<td>Display Data Size</td>
</tr>
<tr>
<td>Time Display Unit</td>
</tr>
</tbody>
</table>

14. The graphical display should show the filtered PWM waveform in the Dual Time A display and the unfiltered waveform in the Dual Time B display. You should see that the results match the previous lab exercise.

15. Fully halt the CPU (real-time mode) by using the Script function: Scripts → Realtime Emulation Control → Full_Halt.

**Terminate Debug Session and Close Project**

16. Terminate the active debug session using the Terminate All button. This will close the debugger and return CCS to the “C/C++ Perspective” view.

17. Next, close the project by right-clicking on Lab9 in the C/C++ Projects window and select Close Project.

End of Exercise
System Design

Introduction

This module discusses various aspects of system design. Details of the emulation and analysis block along with JTAG will be explored. Flash memory programming and the Code Security Module will be described.

Learning Objectives

<table>
<thead>
<tr>
<th>Learning Objectives</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑ Emulation and Analysis Block</td>
</tr>
<tr>
<td>☑ External Interface (XINTF)</td>
</tr>
<tr>
<td>☑ Flash Configuration and Memory Performance</td>
</tr>
<tr>
<td>☑ Flash Programming</td>
</tr>
<tr>
<td>☑ Code Security Module (CSM)</td>
</tr>
</tbody>
</table>
**Emulation and Analysis Block**

**JTAG Emulation System**
(based on IEEE 1149.1 Boundary Scan Standard)

Some Available Emulators

- **XDS510 CLASS** -
  - BlackHawk: USB2000
  - Signum System: JTAGjet-C2000
  - Spectrum Digital: XDS510LC

- **XDS100 CLASS** -
  - BlackHawk: USB100
  - Olimex: TMS320-JTAG-USB
  - Spectrum Digital: XDS100

These emulators are C2000 specific, and are much lower cost than emulators that support all TI MCU/DSP platforms (although those can certainly be used).

These emulators are much slower than the ones listed above, but are also available at a lower cost than XDS510 class and are NOT C2000 specific.

**Emulator Connections to the Device**

- **Vcc (3.3 V)**
- **GND**

= If distance between device and header is greater than 6 inches
## On-Chip Emulation Analysis Block: Capabilities

Two hardware analysis units can be configured to provide any one of the following advanced debug features:

<table>
<thead>
<tr>
<th>Analysis Configuration</th>
<th>Debug Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 Hardware Breakpoints</td>
<td>Halt on a specified instruction (for debugging in Flash)</td>
</tr>
<tr>
<td>2 Address Watchpoints</td>
<td>A memory location is getting corrupted: halt the processor when any value is written to this location</td>
</tr>
<tr>
<td>1 Address Watchpoint with Data</td>
<td>Halt program execution after a specific value is written to a variable</td>
</tr>
<tr>
<td>1 Pair Chained Breakpoints</td>
<td>Halt on a specified instruction only after some other specific routine has executed</td>
</tr>
</tbody>
</table>

---

## On-Chip Emulation Analysis Block: Hardware Breakpoints and Watchpoints

View → Breakpoints

- **Hardware Breakpoint Properties**
- **Hardware Watchpoint Properties**
On-Chip Emulation Analysis Block: Online Stack Overflow Detection

- Emulation analysis registers are accessible to code as well!
- Configure a watchpoint to monitor for writes near the end of the stack
- Watchpoint triggers maskable RTOSINT interrupt
- Works with DSP/BIOS and non-DSP/BIOS
  - See TI application report SPRA820 for implementation details

![Diagram showing stack growth and data memory](image_url)
External Interface (XINTF)

TMS320F28335 XINTF Signals

- XD(31:16): Data Bus
- XD(15:0): Data Bus
- XA(19:1): Address Bus
- XA0/XWE1: Write Enable Strobe
- XWE0: Write Enable Strobe
- XRD: Read Enable Strobe
- XR/W: Read Not Write Strobe
- XZCS0: Zone selects
- XZCS6: Zone selects
- XZCS7: Zone selects
- XREADY: Hardware wait-state support
- XCLKOUT: Shared memory support
- XHOLD: Shared memory support
- XHOLDA: Shared memory support

TMS320F28335 XINTF Memory Map

- M0 SARAM (1Kw)
- M1 SARAM (1Kw)
- PIE Vectors: (256 w)
- PF0 (6Kw)
- XINTF Zone 0 (4Kw)
- reserved
- PF 1 (4Kw)
- PF 2 (4Kw)
- L0 SARAM (4Kw)
- L1 SARAM (4Kw)
- L2 SARAM (4Kw)
- L3 SARAM (4Kw)
- reserved
- L4 SARAM (4Kw)
- L5 SARAM (4Kw)
- L6 SARAM (4Kw)
- L7 SARAM (4Kw)
- reserved
- reserved
- User OTP (1Kw)
- reserved
- reserved
- Flash (256Kw)
- FLASH (256Kw)
- Passwords (8w)
- reserved
- Boot ROM (8Kw)
- reserved
- reserved
- FLASH, ADC CAL, Flash regs in PF0

TMS320F28335 XINTF Signals

- XD(31:16): Data Bus
- XD(15:0): Data Bus
- XA(19:1): Address Bus
- XA0/XWE1: Write Enable Strobe
- XWE0: Write Enable Strobe
- XRD: Read Enable Strobe
- XR/W: Read Not Write Strobe
- XZCS0: Zone selects
- XZCS6: Zone selects
- XZCS7: Zone selects
- XREADY: Hardware wait-state support
- XCLKOUT: Shared memory support
- XHOLD: Shared memory support
- XHOLDA: Shared memory support

External Interface (XINTF)
Basic 16-bit Memory Interface

Basic 32-bit Memory Interface
XINTF Timings

- Three external zones: 0, 6, 7
- Each zone has separate read and write timings
- XREADY signal can be used to extend ACTIVE phase

Read Timing

XINTF Clocking

- Specify read timing and write timing separately, for each zone:
  - Lead: 1-3 XTIMCLK Cycles
  - Active: 0-7 XTIMCLK Cycles
  - Trail: 0-3 XTIMCLK Cycles

- Each zone has a X2TIMING bit that can double the timing values (both read and write affected)
**XINTF Registers**

<table>
<thead>
<tr>
<th>Name</th>
<th>Address</th>
<th>Size (x16)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XTIMING0</td>
<td>0x00 B20</td>
<td>2</td>
<td>XINTF Zone 0 Timing Register</td>
</tr>
<tr>
<td>XTIMING6</td>
<td>0x00 B2C</td>
<td>2</td>
<td>XINTF Zone 6 Timing Register</td>
</tr>
<tr>
<td>XTIMING7</td>
<td>0x00 B2E</td>
<td>2</td>
<td>XINTF Zone 7 Timing Register</td>
</tr>
<tr>
<td>XINTCNF2</td>
<td>0x00 B34</td>
<td>2</td>
<td>XINTF Configuration Register</td>
</tr>
<tr>
<td>XBANK</td>
<td>0x00 B38</td>
<td>1</td>
<td>XINTF Bank Control Register</td>
</tr>
<tr>
<td>XRESET</td>
<td>0x00 B3D</td>
<td>1</td>
<td>XINTF Reset Register</td>
</tr>
</tbody>
</table>

- XTIMINGx specifies read and write timings (lead, active, trail), interface size (16 or 32 bit), X2TIMING, XREADY usage
- XINTCNF2 selects SYSCLKOUT/1 or SYSCLKOUT/2 as fundamental clock speed XTIMCLK (for lead, active, trail), XHOLD control, write buffer control
- XBANK specifies the number of XTIMCLK cycles to add between two specified zone (bank switching)
- XRESET used to do a hard reset in case where CPU detects a stuck XREADY during a DMA transfer

**XINTF Configuration Example**

XINTCNF2 Example (XCLKOUT often only used during debug to check clocking)

```plaintext
XintfRegs.XINTCNF2.bit.XTIMCLK = 0;  // XTIMCLK = SYSCLKOUT/1
XintfRegs.XINTCNF2.bit.CLKOFF = 0;   // XCLKOUT enabled
XintfRegs.XINTCNF2.bit.CLKMODE = 0;  // XCLKOUT = XTIMCLK/1
```

Zone 0 write and read timings example:

```plaintext
XintfRegs.XTIMING0.bit.X2TIMING = 0;  // Timing scale factor = 1
XintfRegs.XTIMING0.bit.XSIZE = 3;     // 16-bit interface
XintfRegs.XTIMING0.bit.USEREADY = 0;  // Not using HW wait-states
XintfRegs.XTIMING0.bit.XRDLEAD = 1;
XintfRegs.XTIMING0.bit.XRDACTIVE = 2;
XintfRegs.XTIMING0.bit.XRDTRAIL = 0;
XintfRegs.XTIMING0.bit.XWRLEAD = 1;
XintfRegs.XTIMING0.bit.XWRACTIVE = 1;
XintfRegs.XTIMING0.bit.XWRTRAIL = 1;
```

Bank switching example: Suppose the external device in zone 7 is slow getting off the bus; Add 3 additional cycles when switching from zone 7 to another zone to avoid bus contention

```plaintext
XintfRegs.XBANK.bit.BANK = 7;    // Select Zone 7
XintfRegs.XBANK.bit.BCYC = 3;    // Add 3 XTIMCLK cycles
```
Flash Configuration and Memory Performance

Basic Flash Operation

- Flash is arranged in pages of 128 words
- Wait states are specified for consecutive accesses within a page, and random accesses across pages
- OTP has random access only
- Must specify the number of SYSCLKOUT wait-states; Reset defaults are maximum value (15)
- Flash configuration code should not be run from the Flash memory

Flash configuration code:

<table>
<thead>
<tr>
<th>Field</th>
<th>Offset</th>
<th>Width</th>
<th>Bits</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FlashRegs.FBANKWAIT reserved</td>
<td>8-7</td>
<td>12</td>
<td>15</td>
<td>PAGEWAIT</td>
</tr>
<tr>
<td>FlashRegs.FBANKWAIT reserved</td>
<td>4-3</td>
<td>10</td>
<td>15</td>
<td>RANDWAIT</td>
</tr>
<tr>
<td>FlashRegs.FOTPWAIT reserved</td>
<td>15-11</td>
<td>16</td>
<td>15</td>
<td>OTPWAIT</td>
</tr>
</tbody>
</table>

*** Refer to the F2833x datasheet for detailed numbers ***

For 150 MHz, PAGEWAIT = 5, RANDWAIT = 5, OTPWAIT = 8
For 100 MHz, PAGEWAIT = 3, RANDWAIT = 3, OTPWAIT = 5

Speeding Up Code Execution in Flash

Flash Pipelining (for code fetch only)

- Flash Pipeline Enable
  - 0 = disable (default)
  - 1 = enable

Flash configuration code:

<table>
<thead>
<tr>
<th>Field</th>
<th>Offset</th>
<th>Width</th>
<th>Bits</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FlashRegs.FOPT.bit.ENPIPE reserved</td>
<td>15</td>
<td>16</td>
<td>15</td>
<td>ENPIPE</td>
</tr>
</tbody>
</table>

16 or 32 dispatched
### Code Execution Performance

- **Assume 150 MHz SYSCLKOUT, 16-bit instructions**
  
  (80% of instructions are 16 bits wide – Rest are 32 bits)

#### Internal RAM: 150 MIPS

Fetch up to 32-bits every cycle

\[
1 \text{ instruction/cycle} \times 150 \text{ MHz} = 150 \text{ MIPS}
\]

#### Flash (w/ pipelining): 100 MIPS

- RANDWAIT = 5
- Fetch 64 bits every 6 cycles

\[
4 \text{ instructions/6 cycles} \times 150 \text{ MHz} = 100 \text{ MIPS}
\]

PC discontinuity will degrade this

#### 32-bit External SRAM (10 or 12 ns): 75 MIPS

- XRDLEAD=1, XRDACTIVE=2, XRDTRAIL=0
- Fetch 32 bits every 4 cycles

\[
2 \text{ instructions/4 cycles} \times 150 \text{ MHz} = 75 \text{ MIPS}
\]

RPT will increase this

#### 16-bit External SRAM (10 or 12 ns): 37.5 MIPS

- XRDLEAD=1, XRDACTIVE=2, XRDTRAIL=0
- Fetch 16 bits every 4 cycles

\[
1 \text{ instruction/4 cycles} \times 150 \text{ MHz} = 37.5 \text{ MIPS}
\]

RPT will increase this

### Data Access Performance

**(150 MHz SYSCLKOUT)**

<table>
<thead>
<tr>
<th>Memory</th>
<th>16-bit access (words/cycle)</th>
<th>32-bit access (words/cycle)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal RAM</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Flash</td>
<td>0.167</td>
<td>0.167</td>
<td>RANDWAIT = 5, Flash is read only!</td>
</tr>
<tr>
<td>ext. RAM (10 or 12 ns)</td>
<td>32-bit</td>
<td>0.5</td>
<td>0.25</td>
</tr>
<tr>
<td></td>
<td>16-bit</td>
<td>0.25</td>
<td>XRDLEAD = 1, XRDACTIVE = 2, XRDTRAIL = 0</td>
</tr>
</tbody>
</table>

- Internal RAM has best data performance – put time critical data here
- External RAM can generally outperform the flash for data access, but increases cost and power consumption
- Flash performance usually sufficient for most constants and tables
- Note that the flash instruction fetch pipeline will also stall during a flash data access
Other Flash Configuration Registers
FlashRegs.name

<table>
<thead>
<tr>
<th>Address</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x00 0A80</td>
<td>FOPT</td>
<td>Flash option register</td>
</tr>
<tr>
<td>0x00 0A82</td>
<td>FPWR</td>
<td>Flash power modes registers</td>
</tr>
<tr>
<td>0x00 0A83</td>
<td>FSTATUS</td>
<td>Flash status register</td>
</tr>
<tr>
<td>0x00 0A84</td>
<td>FSTDBYWAIT</td>
<td>Flash sleep to standby wait register</td>
</tr>
<tr>
<td>0x00 0A85</td>
<td>FACTIVEWAIT</td>
<td>Flash standby to active wait register</td>
</tr>
<tr>
<td>0x00 0A86</td>
<td>FBANKWAIT</td>
<td>Flash read access wait state register</td>
</tr>
<tr>
<td>0x00 0A87</td>
<td>FOTPWAIT</td>
<td>OTP read access wait state register</td>
</tr>
</tbody>
</table>

- **FPWR**: Save power by putting Flash/OTP to ‘Sleep’ or ‘Standby’ mode; Flash will automatically enter active mode if a Flash/OTP access is made.
- **FSTATUS**: Various status bits (e.g. PWR mode)
- **FSTDBYWAIT, FACTIVEWAIT**: Specify # of delay cycles during wake-up from sleep to standby, and from standby to active, respectively. The delay is needed to let the flash stabilize. *Leave these registers set to their default maximum value.*

See the "TMS320x2833x System Control and Interrupts Reference Guide," SPRUFB0, for more information.
Flash Programming

Flash Programming Basics

- The DSP CPU itself performs the flash programming
- The CPU executes Flash utility code from RAM that reads the Flash data and writes it into the Flash
- We need to get the Flash utility code and the Flash data into RAM

Flash Programming Basics

- Sequence of steps for Flash programming:

<table>
<thead>
<tr>
<th>Algorithm</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Erase</td>
<td>- Set all bits to zero, then to one</td>
</tr>
<tr>
<td>2. Program</td>
<td>- Program selected bits with zero</td>
</tr>
<tr>
<td>3. Verify</td>
<td>- Verify flash contents</td>
</tr>
</tbody>
</table>

- Minimum Erase size is a sector (32Kw or 16Kw)
- Minimum Program size is a bit!
- Important not to lose power during erase step: If CSM passwords happen to be all zeros, the CSM will be permanently locked!
- Chance of this happening is quite small! (Erase step is performed sector by sector)
Flash Programming Utilities

- **JTAG Emulator Based**
  - Code Composer Studio on-chip Flash programmer
  - BlackHawk Flash utilities (requires Blackhawk emulator)
  - Elprotronic FlashPro2000
  - Spectrum Digital SDFlash JTAG (requires SD emulator)
  - Signum System Flash utilities (requires Signum emulator)

- **SCI Serial Port Bootloader Based**
  - Code-Skin (http://www.code-skin.com)
  - Elprotronic FlashPro2000

- **Production Test/Programming Equipment Based**
  - BP Micro programmer
  - Data I/O programmer

- **Build your own custom utility**
  - Can use any of the ROM bootloader methods
  - Can embed flash programming into your application
  - Flash API algorithms provided by TI

* TI web has links to all utilities (http://www.ti.com/c2000)

---

**CCS On-Chip Flash Programmer**

- On-Chip Flash programmer is integrated into the CCS debugger

*Images showing CCS On-Chip Flash Programmer interface.*
Code Security Module (CSM)

* Access to the following on-chip memory is restricted:

- Flash Registers
  - 0x008000 - L0 SARAM (4Kw)
  - 0x009000 - L1 SARAM (4Kw)
  - 0x00A000 - L2 SARAM (4Kw)
  - 0x00B000 - L3 SARAM (4Kw)

- Dual Mapped
  - 0x300000 - FLASH (256Kw)
  - 0x340000 - T256 Bit Password
  - 0x380400 - OTP (1Kw)
  - 0x3F8000 - L0 SARAM (4Kw)
  - 0x3F9000 - L1 SARAM (4Kw)
  - 0x3FA000 - L2 SARAM (4Kw)
  - 0x3FB000 - L3 SARAM (4Kw)

- Flash Registers
  - 0x000A80 - CSM Password

* Data reads and writes from restricted memory are only allowed for code running from restricted memory

* All other data read/write accesses are blocked:
  - JTAG emulator/debugger, ROM bootloader, code running in external memory or unrestricted internal memory

**CSM Password**

- 128-bit user defined password is stored in Flash

- 128-bit KEY registers are used to lock and unlock the device
  - Mapped in memory space 0x00 0AE0 – 0x00 0AE7
  - Registers “EALLOW” protected
## Code Security Module (CSM)

### CSM Registers

**Key Registers – accessible by user; EALLOW protected**

<table>
<thead>
<tr>
<th>Address</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x00 0AE0</td>
<td>KEY0</td>
<td>Low word of 128-bit Key register</td>
</tr>
<tr>
<td>0x00 0AE1</td>
<td>KEY1</td>
<td>2(^{nd}) word of 128-bit Key register</td>
</tr>
<tr>
<td>0x00 0AE2</td>
<td>KEY2</td>
<td>3(^{rd}) word of 128-bit Key register</td>
</tr>
<tr>
<td>0x00 0AE3</td>
<td>KEY3</td>
<td>4(^{th}) word of 128-bit Key register</td>
</tr>
<tr>
<td>0x00 0AE4</td>
<td>KEY4</td>
<td>5(^{th}) word of 128-bit Key register</td>
</tr>
<tr>
<td>0x00 0AE5</td>
<td>KEY5</td>
<td>6(^{th}) word of 128-bit Key register</td>
</tr>
<tr>
<td>0x00 0AE6</td>
<td>KEY6</td>
<td>7(^{th}) word of 128-bit Key register</td>
</tr>
<tr>
<td>0x00 0AE7</td>
<td>KEY7</td>
<td>High word of 128-bit Key register</td>
</tr>
<tr>
<td>0x00 0AEF</td>
<td>CSMSCR</td>
<td>CSM status and control register</td>
</tr>
</tbody>
</table>

**PWL in memory – reserved for passwords only**

<table>
<thead>
<tr>
<th>Address</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x33 FFF8</td>
<td>PWL0</td>
<td>Low word of 128-bit password</td>
</tr>
<tr>
<td>0x33 FFF9</td>
<td>PWL1</td>
<td>2(^{nd}) word of 128-bit password</td>
</tr>
<tr>
<td>0x33 FFFA</td>
<td>PWL2</td>
<td>3(^{rd}) word of 128-bit password</td>
</tr>
<tr>
<td>0x33 FFFB</td>
<td>PWL3</td>
<td>4(^{th}) word of 128-bit password</td>
</tr>
<tr>
<td>0x33 FFFC</td>
<td>PWL4</td>
<td>5(^{th}) word of 128-bit password</td>
</tr>
<tr>
<td>0x33 FFFD</td>
<td>PWL5</td>
<td>6(^{th}) word of 128-bit password</td>
</tr>
<tr>
<td>0x33 FFFE</td>
<td>PWL6</td>
<td>7(^{th}) word of 128-bit password</td>
</tr>
<tr>
<td>0x33 FFFF</td>
<td>PWL7</td>
<td>High word of 128-bit password</td>
</tr>
</tbody>
</table>

### Locking and Unlocking the CSM

- **The CSM is always locked after reset**
- **To unlock the CSM:**
  - Perform a dummy read of each PWL (passwords in the flash)
  - Write the correct password to each KEY register
- **Passwords are all 0xFFFF on new devices**
  - When passwords are all 0xFFFF, only a read of each PWL is required to unlock the device
  - The bootloader does these dummy reads and hence unlocks devices that do not have passwords programmed
CSM Caveats

- Never program all the PWL’s as 0x0000
  - Doing so will permanently lock the CSM
- Flash addresses 0x33FF80 to 0x33FFF5, inclusive, must be programmed to 0x0000 to securely lock the CSM
- Remember that code running in unsecured RAM cannot access data in secured memory
  - Don’t link the stack to secured RAM if you have any code that runs from unsecured RAM
- Do not embed the passwords in your code!
  - Generally, the CSM is unlocked only for debug
  - Code Composer Studio can do the unlocking

CSM Password Match Flow

Start

Flash device secure after reset or runtime

Do dummy reads of PWL 0x33 FFF8 – 0x33 FFFF

Is PWL = all 0s?

Yes

Device permanently locked

No

Is PWL = all Fs?

Yes

Write password to KEY registers 0x00 0AE0 – 0x00 0AE7 (EALLOW) protected

Correct password?

Yes

Device unlocked

User can access on-chip secure memory

No
Lab 10: Programming the Flash

Objective

The objective of this lab is to program and execute code from the on-chip flash memory. The TMS320F28335 device has been designed for standalone operation in an embedded system. Using the on-chip flash eliminates the need for external non-volatile memory or a host processor from which to bootload. In this lab, the steps required to properly configure the software for execution from internal flash memory will be covered.

Lab 10: Programming the Flash

Objective:
- Program system into Flash Memory
- Learn use of CCS Flash Plug-in
- **DO NOT PROGRAM PASSWORDS**

Procedure

Open the Project

1. A project named Lab10 has been created for this lab. Open the project by clicking on Project ➔ Import Existing CCS/CCE Eclipse Project. The “Import” window will open then click Browse... next to the “Select root directory” box. Navigate to: C:\C28x\Labs\Lab10\Project and click OK. Then click Finish to import the project. All build options have been configured the same as the previous lab. The files used in this lab are:
Link Initialized Sections to Flash

Initialized sections, such as code and constants, must contain valid values at device power-up. Stand-alone operation of an F28335 embedded system means that no emulator is available to initialize the device RAM. Therefore, all initialized sections must be linked to the on-chip flash memory.

Each initialized section actually has two addresses associated with it. First, it has a LOAD address which is the address to which it gets loaded at load time (or at flash programming time). Second, it has a RUN address which is the address from which the section is accessed at runtime. The linker assigns both addresses to the section. Most initialized sections can have the same LOAD and RUN address in the flash. However, some initialized sections need to be loaded to flash, but then run from RAM. This is required, for example, if the contents of the section needs to be modified at runtime by the code.

2. Open and inspect the linker command file Lab_10.cmd. Notice that a memory block named FLASH_ABCDEFGH has been created at origin = 0x300000, length = 0x03FF80 on Page 0. This flash memory block length has been selected to avoid conflicts with other required flash memory spaces. See the reference slide at the end of this lab exercise for further details showing the address origins and lengths of the various memory blocks used.

3. Edit Lab_10.cmd to link the following compiler sections to on-chip flash memory block FLASH_ABCDEFGH:

**Compiler Sections:**

<table>
<thead>
<tr>
<th>.text</th>
<th>.cinits</th>
<th>.const</th>
<th>.econst</th>
<th>.pinit</th>
<th>.switch</th>
</tr>
</thead>
</table>

4. In Lab_10.cmd notice that the section named “IQmath” is an initialized section that needs to load to and run from flash. Previously the “IQmath” section was linked to L0123SARAM. Edit Lab_10.cmd so that this section is now linked to FLASH_ABCDEFGH. Save your work and close the file.
**Copying Interrupt Vectors from Flash to RAM**

The interrupt vectors must be located in on-chip flash memory and at power-up needs to be copied to the PIE RAM as part of the device initialization procedure. The code that performs this copy is located in InitPieCtrl(). The C-compiler runtime support library contains a memory copy function called `memcpy()` which will be used to perform the copy.

5. Open and inspect `InitPieCtrl()` in `PieCtrl_5_6_7_8_9_10.c`. Notice the `memcpy()` function used to initialize (copy) the PIE vectors. At the end of the file a structure is used to enable the PIE.

**Initializing the Flash Control Registers**

The initialization code for the flash control registers cannot execute from the flash memory (since it is changing the flash configuration!). Therefore, the initialization function for the flash control registers must be copied from flash (load address) to RAM (run address) at runtime. The memory copy function `memcpy()` will again be used to perform the copy. The initialization code for the flash control registers `InitFlash()` is located in the `Flash.c` file.

6. Add `Flash.c` to the project.

7. Open and inspect `Flash.c`. The C compiler CODE SECTION pragma is used to place the `InitFlash()` function into a linkable section named “secureRamFuncs”.

8. The “secureRamFuncs” section will be linked using the user linker command file `Lab_10.cmd`. Open and inspect `Lab_10.cmd`. The “secureRamFuncs” will load to flash (load address) but will run from L0123SARAM (run address). Also notice that the linker has been asked to generate symbols for the load start, load end, and run start addresses.

While not a requirement from a MCU hardware or development tools perspective (since the C28x MCU has a unified memory architecture), historical convention is to link code to program memory space and data to data memory space. Therefore, notice that for the L0123SARAM memory we are linking “secureRamFuncs” to, we are specifying “PAGE = 0” (which is program memory).

9. Open and inspect `Main_10.c`. Notice that the memory copy function `memcpy()` is being used to copy the section “secureRamFuncs”, which contains the initialization function for the flash control registers.

10. Add a line of code in `main()` to call the `InitFlash()` function. There are no passed parameters or return values. You just type

    `InitFlash();`

    at the desired spot in `main()`.
Code Security Module and Passwords

The CSM module provides protection against unwanted copying (i.e. pirating!) of your code from flash, OTP memory, and the L0, L1, L2 and L3 RAM blocks. The CSM uses a 128-bit password made up of 8 individual 16-bit words. They are located in flash at addresses 0x33FFF8 to 0x33FFFF. During this lab, dummy passwords of 0xFFFF will be used – therefore only dummy reads of the password locations are needed to unsecure the CSM. **DO NOT PROGRAM ANY REAL PASSWORDS INTO THE DEVICE.** After development, real passwords are typically placed in the password locations to protect your code. We will not be using real passwords in the workshop.

The CSM module also requires programming values of 0x0000 into flash addresses 0x33FF80 through 0x33FFF5 in order to properly secure the CSM. Both tasks will be accomplished using a simple assembly language file Passwords.asm.

11. Add Passwords.asm to the project.

12. Open and inspect Passwords.asm. This file specifies the desired password values (**DO NOT CHANGE THE VALUES FROM 0xFFFF**) and places them in an initialized section named “passwords”. It also creates an initialized section named “csm_rsvd” which contains all 0x0000 values for locations 0x33FF80 to 0x33FFF5 (length of 0x76).

13. Open Lab_10.cmd and notice that the initialized sections for “passwords” and “csm_rsvd” are linked to memories named PASSWORDS and CSM_RSVD, respectively.

Executing from Flash after Reset

The F28335 device contains a ROM bootloader that will transfer code execution to the flash after reset. When the boot mode selection pins are set for “Jump to Flash” mode, the bootloader will branch to the instruction located at address 0x33FFF6 in the flash. An instruction that branches to the beginning of your program needs to be placed at this address. Note that the CSM passwords begin at address 0x33FFF8. There are exactly two words available to hold this branch instruction, and not coincidentally, a long branch instruction “LB” in assembly code occupies exactly two words. Generally, the branch instruction will branch to the start of the C-environment initialization routine located in the C-compiler runtime support library. The entry symbol for this routine is _c_int00. Recall that C code cannot be executed until this setup routine is run. Therefore, assembly code must be used for the branch. We are using the assembly code file named CodeStartBranch.asm.

14. Open and inspect CodeStartBranch.asm. This file creates an initialized section named “codestart” that contains a long branch to the C-environment setup routine. This section needs to be linked to a block of memory named BEGIN_FLASH.

15. In the earlier lab exercises, the section “codestart” was directed to the memory named BEGIN_M0. Edit Lab_10.cmd so that the section “codestart” will be directed to BEGIN_FLASH. Save your work and close the opened files.

16. The controlCARD or Docking Station needs to be configured for “Jump to Flash” boot mode. Move the “2833x Boot Mode” controlCARD switch SW2 positions 1, 2, 3 and 4.
to the “1 – on” position (all switches up) or the Docking Station jumpers 84, 85, 86 and 87 to the “1” position (all jumpers to the left side) to accomplish this. Details of the jumper positions can be found in Appendix A. These jumpers control the pullup/down resistor on the GPIO84, GPIO85, GPIO86 and GPIO87 pins, which are the pins sampled by the bootloader to determine the boot mode. (For additional information on configuring the “Jump to Flash” boot mode see the TMS320x2833x Boot ROM Reference Guide).

Build – Lab.out

17. Click the “Build” button to generate the Lab.out file to be used with the CCS Flash Programmer. Check for errors in the Problems window.

CCS On-Chip Flash Programmer

In CCS (version 4.x) the on-chip flash programmer is integrated into the debugger. When the program is loaded CCS will automatically determine which sections reside in flash memory based on the linker command file. CCS will then program these sections into the on-chip flash memory. Additionally, in order to effectively debug with CCS, the symbolic debug information (e.g., symbol and label addresses, source file links, etc.) will automatically load so that CCS knows where everything is in your code.

Clicking the “Debug” button in the C/C++ Perspective will automatically launch the debugger, connect to the target, and program the flash memory in a single step.

18. Program the flash memory by clicking the “Debug” button (green bug). As soon as the “Progress Information” box opens, if needed select “Details” in order to watch the programming operation and status. After successfully programming the flash memory the “Progress Information” box will close.

19. Flash programming options are configured with the “On-Chip Flash” control panel. Open the control panel by clicking:

Tools → On-Chip Flash

Scroll the control panel and notice the various options that can be selected. You will see that specific actions such as “Erase Flash” can be performed.

The CCS on-chip flash programmer was automatically configured to use the Delfino™ ControlCARD on-board 30 MHz oscillator as the device clock during programming. Notice the “Clock Configuration” settings has the OSCCLK set to 30 MHz, the DIVSEL set to /2, and the PLLCR value set to 10. Recall that the PLL is divided by two, which gives a SYSCLKOUT of 150 MHz.

The flash programmer should be set for “Erase, Program, Verify” and all boxes in the “Erase Sector Selection” should be checked. We want to erase all the flash sectors.

We will not be using the on-chip flash programmer to program the “Code Security Password”. Do not modify the Code Security Password fields. They should remain as all 0xFFFF.
20. Close the “On-Chip Flash” control panel by clicking the X on the tab.

**Running the Code – Using CCS**

21. Reset the CPU. The program counter should now be at address 0x3FF9CE in the “Disassembly” window, which is the start of the bootloader in the Boot ROM.

22. Single-Step by using the <F5> key (or you can use the Step Into button on the horizontal toolbar) through the bootloader code until you arrive at the beginning of the codestart section in the CodeStartBranch.asm file. (Be patient, it will take about 125 single-steps). Notice that we have placed some code in CodeStartBranch.asm to give an option to first disable the watchdog, if selected.

23. Step a few more times until you reach the start of the C-compiler initialization routine at the symbol _c_int00.

24. Now do Target ➔ Go Main. The code should stop at the beginning of your main() routine. If you got to that point successfully, it confirms that the flash has been programmed properly, that the bootloader is properly configured for jump to flash mode, and that the codestart section has been linked to the proper address.

25. You can now RUN the CPU, and you should observe the LED on the ControlCARD blinking. Try resetting the CPU and hitting RUN (without doing all the stepping and the Go Main procedure). The LED should be blinking again.

26. Halt the CPU.

**Terminate Debug Session and Close Project**

27. Terminate the active debug session using the Terminate All button. This will close the debugger and return CCS to the “C/C++ Perspective” view.

28. Next, close the project by right-clicking on Lab10 in the C/C++ Projects window and select Close Project.

**Running the Code – Stand-alone Operation (No Emulator)**


30. Disconnect the USB cable (emulator) from the Docking Station (i.e. remove power from the ControlCARD).

31. Re-connect the USB cable to the Docking Station to power the ControlCARD. The LED should be blinking, showing that the code is now running from flash memory.

**Return Boot Mode Jumpers Back to Default Positions**

32. Remove the power to the Docking Station by disconnecting the USB cable.
33. Return the settings of the boot mode switches or jumpers back to the default positions “Jump to M0SARAM” boot mode as shown in the table below (see Appendix A for jumper position details):

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Down – 0</td>
<td>Down – 0</td>
<td>Up – 1</td>
<td>Down – 0</td>
<td>controlCARD</td>
</tr>
<tr>
<td>Right – 0</td>
<td>Right – 0</td>
<td>Left – 1</td>
<td>Right – 0</td>
<td>Docking Station</td>
</tr>
</tbody>
</table>

End of Exercise
Lab 10 Reference: Programming the Flash

### Flash Memory Section Blocks

<table>
<thead>
<tr>
<th>Address</th>
<th>Section</th>
<th>Length</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x30 0000</td>
<td>FLASH</td>
<td>0x3FF80</td>
<td>0</td>
</tr>
<tr>
<td>0x33 FF80</td>
<td>CSM_RSVD</td>
<td>0x76</td>
<td>0</td>
</tr>
<tr>
<td>0x33 FFF6</td>
<td>BEGIN_FLASH</td>
<td>0x2</td>
<td>0</td>
</tr>
<tr>
<td>0x33 FFF8</td>
<td>PASSWORDS</td>
<td>0x8</td>
<td>0</td>
</tr>
</tbody>
</table>

```
Lab_10.cmd

SECTIONS
{
    codestart  :> BEGIN_FLASH,  PAGE = 0
    passwords  :> PASSWORDS,   PAGE = 0
    csm_rsvd   :> CSM_RSVD,    PAGE = 0
}
```

### Startup Sequence from Flash Memory

1. **RESET**
2. **Boot ROM (8Kw)**
3. **FLASH (256Kw)**
4. **“rts2800_ml.lib”**
5. **“user” code sections**
   ```
   main()
   {
   ..........  
   }
   ```
Introduction

The TMS320C28x contains features that allow several methods of communication and data exchange between the C28x and other devices. Many of the most commonly used communications techniques are presented in this module.

The intent of this module is not to give exhaustive design details of the communication peripherals, but rather to provide an overview of the features and capabilities. Once these features and capabilities are understood, additional information can be obtained from various resources such as documentation, as needed. This module will cover the basic operation of the communication peripherals, as well as some basic terms and how they work.

Learning Objectives

- Serial Peripheral Interface (SPI)
- Serial Communication Interface (SCI)
- Multichannel Buffered Serial Port (McBSP)
- Inter-Integrated Circuit (I2C)
- Enhanced Controller Area Network (eCAN)

Note: Up to 1 SPI module (A), 3 SCI modules (A/B/C), 2 McBSP modules (A/B), 1 I2C module (A), and 2 eCAN modules (A/B) are available on the F2833x devices.
Module Topics

Communications..........................................................................................................................11-1

Module Topics..............................................................................................................................11-2
Communications Techniques .........................................................................................................11-3
Serial Peripheral Interface (SPI) ......................................................................................................11-4
SPI Registers ..............................................................................................................................11-7
SPI Summary ...............................................................................................................................11-8
Serial Communications Interface (SCI) ..........................................................................................11-9
Multiprocessor Wake-Up Modes ...................................................................................................11-11
SCI Registers ................................................................................................................................11-14
SCI Summary ..............................................................................................................................11-15
Multichannel Buffered Serial Port (McBSP) ...................................................................................11-16
Inter-Integrated Circuit (I2C) ........................................................................................................11-19
I2C Operating Modes and Data Formats .......................................................................................11-20
I2C Summary ..............................................................................................................................11-21
Enhanced Controller Area Network (eCAN) ...................................................................................11-22
CAN Bus and Node .......................................................................................................................11-23
Principles of Operation ................................................................................................................11-24
Message Format and Block Diagram ............................................................................................11-25
eCAN Summary ...........................................................................................................................11-26
Communications Techniques

Several methods of implementing a TMS320C28x communications system are possible. The method selected for a particular design should reflect the method that meets the required data rate at the lowest cost. Various categories of interface are available and are summarized in the learning objective slide. Each will be described in this module.

<table>
<thead>
<tr>
<th>Synchronous vs. Asynchronous</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Synchronous</strong></td>
</tr>
<tr>
<td>• Short distances (on-board)</td>
</tr>
<tr>
<td>• High data rate</td>
</tr>
<tr>
<td>• Explicit clock</td>
</tr>
<tr>
<td><strong>Asynchronous</strong></td>
</tr>
<tr>
<td>• longer distances</td>
</tr>
<tr>
<td>• Lower data rate ($\approx 1/8$ of SPI)</td>
</tr>
<tr>
<td>• Implied clock (clk/data mixed)</td>
</tr>
<tr>
<td>• Economical with reasonable performance</td>
</tr>
</tbody>
</table>

Serial ports provide a simple, hardware-efficient means of high-level communication between devices. Like the GPIO pins, they may be used in stand-alone or multiprocessing systems.

In a multiprocessing system, they are an excellent choice when both devices have an available serial port and the data rate requirement is relatively low. Serial interface is even more desirable when the devices are physically distant from each other because the inherently low number of wires provides a simpler interconnection.

Serial ports require separate lines to implement, and they do not interfere in any way with the data and address lines of the processor. The only overhead they require is to read/write new words from/to the ports as each word is received/transmitted. This process can be performed as a short interrupt service routine under hardware control, requiring only a few cycles to maintain.

The C28x family of devices have both synchronous and asynchronous serial ports. Detailed features and operation will be described next.
Serial Peripheral Interface (SPI)

The SPI module is a synchronous serial I/O port that shifts a serial bit stream of variable length and data rate between the C28x and other peripheral devices. During data transfers, one SPI device must be configured as the transfer MASTER, and all other devices configured as SLAVES. The master drives the transfer clock signal for all SLAVES on the bus. SPI communications can be implemented in any of three different modes:

- MASTER sends data, SLAVES send dummy data
- MASTER sends data, one SLAVE sends data
- MASTER sends dummy data, one SLAVE sends data

In its simplest form, the SPI can be thought of as a programmable shift register. Data is shifted in and out of the SPI through the SPIDAT register. Data to be transmitted is written directly to the SPIDAT register, and received data is latched into the SPIBUF register for reading by the CPU. This allows for double-buffered receive operation, in that the CPU need not read the current received data from SPIBUF before a new receive operation can be started. However, the CPU must read SPIBUF before the new operation is complete of a receiver overrun error will occur. In addition, double-buffered transmit is not supported: the current transmission must be complete before the next data character is written to SPIDAT or the current transmission will be corrupted.

The Master can initiate a data transfer at any time because it controls the SPICLK signal. The software, however, determines how the Master detects when the Slave is ready to broadcast.

**SPI Data Flow**

- Simultaneous transmits and receive
- SPI Master provides the clock signal
**SPI Transmit / Receive Sequence**

1. Slave writes data to be sent to its shift register (SPIDAT)

2. Master writes data to be sent to its shift register (SPIDAT or SPITXBUF)

3. Completing Step 2 automatically starts SPICLK signal of the Master

4. MSB of the Master’s shift register (SPIDAT) is shifted out, and LSB of the Slave’s shift register (SPIDAT) is loaded

5. Step 4 is repeated until specified number of bits are transmitted

6. SPIDAT register is copied to SPIRXBUF register

7. SPI INT Flag bit is set to 1

8. An interrupt is asserted if SPI INT ENA bit is set to 1

9. If data is in SPITXBUF (either Slave or Master), it is loaded into SPIDAT and transmission starts again as soon as the Master’s SPIDAT is loaded
Since data is shifted out of the SPIDAT register MSB first, transmission characters of less than 16 bits must be left-justified by the CPU software prior to be written to SPIDAT.

Received data is shifted into SPIDAT from the left, MSB first. However, the entire sixteen bits of SPIDAT is copied into SPIBUF after the character transmission is complete such that received characters of less than 16 bits will be right-justified in SPIBUF. The non-utilized higher significance bits must be masked-off by the CPU software when it interprets the character. For example, a 9 bit character transmission would require masking-off the 7 MSB’s.

SPI Data Character Justification

- Programmable data length of 1 to 16 bits
- Transmitted data of less than 16 bits must be left justified
  - MSB transmitted first
- Received data of less than 16 bits are right justified
- User software must mask-off unused MSB’s

![Diagram showing SPI Data Character Justification](image-url)
SPI Registers

**SPI Baud Rate Register**

```
SPI Baud Rate Register
SpiRegs.SPIBRR
```

<table>
<thead>
<tr>
<th>15-7</th>
<th>6-0</th>
</tr>
</thead>
<tbody>
<tr>
<td>reserved</td>
<td>SPI BIT RATE</td>
</tr>
</tbody>
</table>

Need to set this only when in master mode!

- For SPIBRR = 3 to 127: \( \text{SPI Baud Rate} = \frac{\text{LSPCLK}}{(\text{SPIBRR} + 1)} \) bits/sec
- For SPIBRR = 0, 1, or 2: \( \text{SPI Baud Rate} = \frac{\text{LSPCLK}}{4} \) bits/sec

From the above equations, one can compute

Maximum data rate = 25 Mbps @ 100 MHz

**Character Length Determination:** The Master and Slave must be configured for the same transmission character length. This is done with bits 0, 1, 2 and 3 of the configuration control register (SPICCR.3-0). These four bits produce a binary number, from which the character length is computed as binary + 1 (e.g. SPICCR.3-0 = 0010 gives a character length of 3).
### Select SPI Registers

- **Configuration Control** \( \text{SpiRegs.SPICCR} \)
  - Reset, Clock Polarity, Loopback, Character Length
- **Operation Control** \( \text{SpiRegs.SPICTL} \)
  - Overrun Interrupt Enable, Clock Phase, Interrupt Enable
  - Master / Slave Transmit enable
- **Status** \( \text{SpiRegs.SPIST} \)
  - RX Overrun Flag, Interrupt Flag, TX Buffer Full Flag
- **FIFO Transmit** \( \text{SpiRegs.SPIFFTX} \)
- **FIFO Receive** \( \text{SpiRegs.SPIFFRX} \)
  - FIFO Enable, FIFO Reset
  - FIFO Over-flow flag, Over-flow Clear
  - Number of Words in FIFO (FIFO Status)
  - FIFO Interrupt Enable, Interrupt Status, Interrupt Clear
  - FIFO Interrupt Level (Number of Words in FIFO)

*Note: refer to the reference guide for a complete listing of registers*

### SPI Summary

- **Synchronous serial communications**
  - Two wire transmit or receive (half duplex)
  - Three wire transmit and receive (full duplex)
- **Software configurable as master or slave**
  - C28x provides clock signal in master mode
- **Data length programmable from 1-16 bits**
- **125 different programmable baud rates**
Serial Communications Interface (SCI)

The SCI module is a serial I/O port that permits Asynchronous communication between the C28x and other peripheral devices. The SCI transmit and receive registers are both double-buffered to prevent data collisions and allow for efficient CPU usage. In addition, the C28x SCI is a full duplex interface which provides for simultaneous data transmit and receive. Parity checking and data formatting is also designed to be done by the port hardware, further reducing software overhead.

**SCI Pin Connections**

(Full Duplex Shown)

 SCI Device #1

- TX FIFO_0
- TX FIFO_15
- Transmitter-data buffer register
- 8
- Transmitter shift register
- Receiver shift register
- Receiver-data buffer register
- RX FIFO_0
- RX FIFO_15

 SCI Device #2

- TX FIFO_0
- TX FIFO_15
- Transmitter-data buffer register
- 8
- Transmitter shift register
- Receiver shift register
- Receiver-data buffer register
- RX FIFO_0
- RX FIFO_15

SCITXD

SCIRXD

SCITXD

SCIRXD
The basic unit of data is called a **character** and is 1 to 8 bits in length. Each character of data is formatted with a start bit, 1 or 2 stop bits, an optional parity bit, and an optional address/data bit. A character of data along with its formatting bits is called a **frame**. Frames are organized into groups called blocks. If more than two serial ports exist on the SCI bus, a block of data will usually begin with an address frame which specifies the destination port of the data as determined by the user’s protocol.

The start bit is a low bit at the beginning of each frame which marks the beginning of a frame. The SCI uses a NRZ (Non-Return-to-Zero) format which means that in an inactive state the SCIRX and SCITX lines will be held high. Peripherals are expected to pull the SCIRX and SCITX lines to a high level when they are not receiving or transmitting on their respective lines.

**When configuring the SCICCR, the SCI port should first be held in an inactive state.** This is done using the SW RESET bit of the SCI Control Register 1 (SCICTL1.5). Writing a 0 to this bit initializes and holds the SCI state machines and operating flags at their reset condition. The SCICCR can then be configured. Afterwards, re-enable the SCI port by writing a 1 to the SW RESET bit. At system reset, the SW RESET bit equals 0.
Serial Communications Interface (SCI)

**SCI Data Timing**

- Start bit valid if 4 consecutive SCICLK periods of zero bits after falling edge
- Majority vote taken on 4th, 5th, and 6th SCICLK cycles

```
<table>
<thead>
<tr>
<th>SCICLK</th>
<th>Majority Vote</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Internal)</td>
<td></td>
</tr>
</tbody>
</table>
```

```
<table>
<thead>
<tr>
<th>SCIRXD</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Bit</td>
<td></td>
</tr>
<tr>
<td>LSB of Data</td>
<td></td>
</tr>
<tr>
<td>Falling Edge Detected</td>
<td></td>
</tr>
</tbody>
</table>

Note: 8 SCICLK periods per data bit

Multiprocessor Wake-Up Modes

- **Multiprocessor Wake-Up Modes**
  - Allows numerous processors to be hooked up to the bus, but transmission occurs between only two of them
  - **Idle-line or Address-bit modes**
  - **Sequence of Operation**
    1. Potential receivers set SLEEP = 1, which disables RXINT except when an address frame is received
    2. All transmissions begin with an address frame
    3. Incoming address frame temporarily wakes up all SCIs on bus
    4. CPUs compare incoming SCI address to their SCI address
    5. Process following data frames only if address matches
Idle-Line Wake-Up Mode

- Idle time separates blocks of frames
- Receiver wakes up when SCIRXD high for 10 or more bit periods
- Two transmit address methods
  - Deliberate software delay of 10 or more bits
  - Set TXWAKE bit to automatically leave exactly 11 idle bits

Address-Bit Wake-Up Mode

- All frames contain an extra address bit
- Receiver wakes up when address bit detected
- Automatic setting of Addr/Data bit in frame by setting TXWAKE = 1 prior to writing address to SCITXBUF
The SCI interrupt logic generates interrupt flags when it receives or transmits a complete character as determined by the SCI character length. This provides a convenient and efficient way of timing and controlling the operation of the SCI transmitter and receiver. The interrupt flag for the transmitter is TXRDY (SCICTL2.7), and for the receiver RXRDY (SCIRXST.6). TXRDY is set when a character is transferred to TXSHF and SCITXBUF is ready to receive the next character. In addition, when both the SCIBUF and TXSHF registers are empty, the TX EMPTY flag (SCICTL2.6) is set. When a new character has been received and shifted into SCIRXBUF, the RXRDY flag is set. In addition, the BRKDT flag is set if a break condition occurs. A break condition is where the SCIRXD line remains continuously low for at least ten bits, beginning after a missing stop bit. Each of the above flags can be polled by the CPU to control SCI operations, or interrupts associated with the flags can be enabled by setting the RX/BK INT ENA (SCICTL2.1) and/or the TX INT ENA (SCICTL2.0) bits active high.

Additional flag and interrupt capability exists for other receiver errors. The RX ERROR flag is the logical OR of the break detect (BRKDT), framing error (FE), receiver overrun (OE), and parity error (PE) bits. RX ERROR high indicates that at least one of these four errors has occurred during transmission. This will also send an interrupt request to the CPU if the RX ERR INT ENA (SCICTL1.6) bit is set.
Serial Communications Interface (SCI)

**SCI Registers**

**SCI Baud Rate Registers**

![Baud Rate Registers Diagram]

Baud Rate Determination: The values in the baud-select registers (SCIHBAUD and SCILBAUD) concatenate to form a 16 bit number that specifies the baud rate for the SCI.

- For BRR = 1 to 65535:  
  \[ \text{SCI Baud Rate} = \frac{LSPCLK}{(BRR + 1) \times 8} \text{ bits/sec} \]

- For BRR = 0:  
  \[ \text{SCI Baud Rate} = \frac{LSPCLK}{16} \text{ bits/sec} \]

Max data rate = 6.25 Mbps @ 100 MHz

Note that the CLKOUT for the SCI module is one-half the CPU clock rate.
Serial Communications Interface (SCI)

Select SCI Registers

- **Control 1** `SciRegs.SCICTL1`
  - Reset, Transmitter / Receiver Enable
  - TX Wake-up, Sleep, RX Error Interrupt Enable

- **Control 2** `SciRegs.SPICTL2`
  - TX Buffer Full / Empty Flag, TX Ready Interrupt Enable
  - RX Break Interrupt Enable

- **Receiver Status** `SciRegs.SCRXST`
  - Error Flag, Ready Flag, Break-Detect Flag, Framing Error Detect Flag, Parity Error Flag, RX Wake-up Detect Flag

- **FIFO Transmit** `SciRegs.SCIFTX`
- **FIFO Receive** `SciRegs.SCIFRX`
  - FIFO Enable, FIFO Reset
  - FIFO Over-flow flag, Over-flow Clear
  - Number of Words in FIFO (FIFO Status)
  - FIFO Interrupt Enable, Interrupt Status, Interrupt Clear
  - FIFO Interrupt Level (Number of Words in FIFO)

Note: refer to the reference guide for a complete listing of registers

SCI Summary

- Asynchronous communications format
- 65,000+ different programmable baud rates
- Two wake-up multiprocessor modes
  - Idle-line wake-up & Address-bit wake-up
- Programmable data word format
  - 1 to 8 bit data word length
  - 1 or 2 stop bits
  - even/odd/no parity
- Error Detection Flags
  - Parity error; Framing error; Overrun error; Break detection
- Transmit FIFO and receive FIFO
- Individual interrupts for transmit and receive
Multichannel Buffered Serial Port (McBSP)

McBSP Block Diagram

CPU

Peripheral / DMA Bus

DXR2 TX Buffer

16

XSR2

16

DRR2 RX Buffer

16

Peripheral / DMA Bus

DXR1 TX Buffer

16

XSR1

16

DRR1 RX Buffer

16

RSR2

16

RBR2 Register

16

MDXx

MFSXx

MCLKXx

MDRx

MCLKRx

MFSRx

Definition: Bit and Word

CLK

FS

D

a1 a0

b7 b6 b5 b4 b3 b2 b1 b0

Bit

Word

◆ “Bit” - one data bit per serial clock period
◆ “Word” or “channel” contains number of bits (8, 12, 16, 20, 24, 32)
**Definition: Word and Frame**

- **Frame** - contains one or multiple words
- Number of words per frame: 1-128

---

**Multi-Channel Selection**

- Allows multiple channels (words) to be independently selected for transmit and receive (e.g. only enable Ch0, 5, 27 for receive, then process via CPU)
- The McBSP keeps time sync with all channels, but only “listens” or “talks” if the specific channel is enabled (reduces processing/bus overhead)
- Multi-channel mode controlled primarily via two registers:
  - Multi-channel Control Reg
  - Rec/Xmt Channel Enable Regs
  - Up to 128 channels can be enabled/disabled
Multichannel Buffered Serial Port (McBSP)

McBSP Summary

- Independent clocking and framing for transmit and receive
- Internal or external clock and frame sync
- Data size of 8, 12, 16, 20, 24, or 32 bits
- TDM mode - up to 128 channels
  - Used for T1/E1 interfacing
- $\mu$-law and A-law companding
- SPI mode
- Direct Interface to many codecs
- Can be serviced by the DMA
Inter-Integrated Circuit (I2C)

- Philips I2C-bus specification compliant, version 2.1
- Data transfer rate from 10 kbps up to 400 kbps
- Each device can be considered as a Master or Slave
- Master initiates data transfer and generates clock signal
- Device addressed by Master is considered a Slave
- Multi-Master mode supported
- Standard Mode – send exactly n data values (specified in register)
- Repeat Mode – keep sending data values (use software to initiate a stop or new start condition)

Inter-Integrated Circuit (I2C) Block Diagram
## I2C Operating Modes and Data Formats

### I2C Operating Modes

<table>
<thead>
<tr>
<th>Operating Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slave-receiver mode</td>
<td>Module is a slave and receives data from a master (all slaves begin in this mode)</td>
</tr>
<tr>
<td>Slave-transmitter mode</td>
<td>Module is a slave and transmits data to a master (can only be entered from slave-receiver mode)</td>
</tr>
<tr>
<td>Master-receiver mode</td>
<td>Module is a master and receives data from a slave (can only be entered from master-transmit mode)</td>
</tr>
<tr>
<td>Master-transmitter mode</td>
<td>Module is a master and transmits to a slave (all masters begin in this mode)</td>
</tr>
</tbody>
</table>

### I2C Serial Data Formats

#### 7-Bit Addressing Format

```
1 1 7 1 1 1 n 1 n 1 1
S  Slave Address  R/W  ACK  Data  ACK  Data  ACK  P
```

#### 10-Bit Addressing Format

```
1 1 7 1 1 8 1 n 1 1 1
S  11110AA  R/W  ACK  AAAAAAAA  ACK  Data  ACK  P
```

#### Free Data Format

```
1 1 n 1 n 1 n 1 1
S  Data  ACK  Data  ACK  Data  ACK  P
```

- **R/W** = 0 – master writes data to addressed slave
- **R/W** = 1 – master reads data from the slave
- **n** = 1 to 8 bits
- **S** = Start (high-to-low transition on SDA while SCL is high)
- **P** = Stop (low-to-high transition on SDA while SCL is high)
I2C Arbitration

- Arbitration procedure invoked if two or more master-transmitters simultaneously start transmission
  - Procedure uses data presented on serial data bus (SDA) by competing transmitters
  - First master-transmitter which drives SDA high is overruled by another master-transmitter that drives SDA low
  - Procedure gives priority to the data stream with the lowest binary value

![Diagram showing I2C Arbitration](image)

I2C Summary

- Compliance with Philips I2C-bus specification (version 2.1)
- 7-bit and 10-bit addressing modes
- Configurable 1 to 8 bit data words
- Data transfer rate from 10 kbps up to 400 kbps
- Transmit FIFO and receive FIFO
CAN does not use physical addresses to address stations. Each message is sent with an identifier that is recognized by the different nodes. The identifier has two functions – it is used for message filtering and for message priority. The identifier determines if a transmitted message will be received by CAN modules and determines the priority of the message when two or more nodes want to transmit at the same time.
The MCU communicates to the CAN Bus using a transceiver. The CAN bus is a twisted pair wire and the transmission rate depends on the bus length. If the bus is less than 40 meters the transmission rate is capable up to 1 Mbit/second.
### Principles of Operation

- Data messages transmitted are identifier based, not address based.
- Content of message is labeled by an identifier that is unique throughout the network.
  - (e.g. rpm, temperature, position, pressure, etc.)
- All nodes on network receive the message and each performs an acceptance test on the identifier.
- If message is relevant, it is processed (received); otherwise it is ignored.
- Unique identifier also determines the priority of the message.
  - (lower the numerical value of the identifier, the higher the priority)
- When two or more nodes attempt to transmit at the same time, a non-destructive arbitration technique guarantees messages are sent in order of priority and no messages are lost.

### Non-Destructive Bitwise Arbitration

- Bus arbitration resolved via arbitration with wired-AND bus connections.
  - Dominate state (logic 0, bus is high)
  - Recessive state (logic 1, bus is low)

![Non-Destructive Bitwise Arbitration Diagram]
Message Format and Block Diagram

CAN Message Format

- Data is transmitted and received using Message Frames
- 8 byte data payload per message
- Standard and Extended identifier formats

- **Standard Frame: 11-bit Identifier (CAN v2.0A)**

```
SOF 11-bit Identifier RTR ID DLC 0...8 Bytes Data CRC ACK EOF
```

- **Extended Frame: 29-bit Identifier (CAN v2.0B)**

```
SOF 11-bit Identifier RTR ID1 18-bit Identifier DLC 0...8 Bytes Data CRC ACK EOF
```

The MCU CAN module is a full CAN Controller. It contains a message handler for transmission and reception management, and frame storage. The specification is CAN 2.0B Active – that is, the module can send and accept standard (11-bit identifier) and extended frames (29-bit identifier).

eCAN Block Diagram
The CAN controller module contains 32 mailboxes for objects of 0 to 8-byte data lengths:
- configurable transmit/receive mailboxes
- configurable with standard or extended identifier

The CAN module mailboxes are divided into several parts:
- MID – contains the identifier of the mailbox
- MCF (Message Control Field) – contains the length of the message (to transmit or receive) and the RTR bit (Remote Transmission Request – used to send remote frames)
- MDL and MDH – contains the data

The CAN module contains registers which are divided into five groups. These registers are located in data memory from 0x006000 to 0x0061FF. The five register groups are:
- Control & Status Registers
- Local Acceptance Masks
- Message Object Time Stamps
- Message Object Timeout
- Mailboxes

**eCAN Summary**

<table>
<thead>
<tr>
<th>eCAN Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>✦ Fully compliant with CAN standard v2.0B</td>
</tr>
<tr>
<td>✦ Supports data rates up to 1 Mbps</td>
</tr>
<tr>
<td>✦ Thirty-two mailboxes</td>
</tr>
<tr>
<td>✦ Configurable as receive or transmit</td>
</tr>
<tr>
<td>✦ Configurable with standard or extended identifier</td>
</tr>
<tr>
<td>✦ Programmable receive mask</td>
</tr>
<tr>
<td>✦ Uses 32-bit time stamp on messages</td>
</tr>
<tr>
<td>✦ Programmable interrupt scheme (two levels)</td>
</tr>
<tr>
<td>✦ Programmable alarm time-out</td>
</tr>
<tr>
<td>✦ Programmable wake-up on bus activity</td>
</tr>
<tr>
<td>✦ Self-test mode</td>
</tr>
</tbody>
</table>
Introduction

This module discusses the basic features of using DSP/BIOS in a system. Scheduling threads, periodic functions, and the use of real-time analysis tools will be demonstrated, in addition to programming the flash with DSP/BIOS.

Learning Objectives

<table>
<thead>
<tr>
<th>Learning Objectives</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to DSP/BIOS</td>
</tr>
<tr>
<td>DSP/BIOS Configuration Tool</td>
</tr>
<tr>
<td>Scheduling DSP/BIOS Threads</td>
</tr>
<tr>
<td>Periodic Functions</td>
</tr>
<tr>
<td>Real-Time Analysis Tools</td>
</tr>
</tbody>
</table>
Module Topics

DSP/BIOS

Module Topics

Introduction to DSP/BIOS

DSP/BIOS Configuration Tool

Scheduling DSP/BIOS Threads

Periodic Functions

Real-Time Analysis Tools

Lab 12: DSP/BIOS
Introduction to DSP/BIOS

What is DSP/BIOS?

- A full-featured, scalable real-time kernel
  - System configuration tools
  - Preemptive multi-threading scheduler
  - Real-time analysis tools

Why Use DSP/BIOS?

- Helps Manage complex system resources
  - no need to develop or maintain a “home-brew” kernel
  - faster time to market
- Efficient debugging of real-time applications
  - Real-Time Analysis
- Create robust applications
  - industry proven kernel technology
- Reduce cost of software maintenance
  - code reuse and standardized software
- Integrated with Code Composer Studio IDE
  - requires no runtime license fees
  - fully supported by TI
- Uses minimal Mips and Memory (2-8Kw)
  - scalable – use only what is needed
  - easily fits in limited memory space
DSP/BIOS Configuration Tool

The DSP/BIOS Configuration Tool (often called Config Tool or GUI Tool or GUI) creates and modifies a system file called the Text Configuration File (.tcf). If we talk about using .tcf files, we’re also talking about using the Config Tool.

DSP/BIOS Configuration Tool (file .tcf)

- **System Setup Tools**
  - Handles memory configuration (builds .cmd file), run-time support libraries, interrupt vectors, system setup and reset, etc.

- **Real-Time Analysis Tools**
  - Allows application to run uninterrupted while displaying debug data

- **Real-Time Scheduler**
  - Preemptive thread manager
  - Kernel configures DSP/BIOS scheduling

- **Real-Time I/O**
  - Allows two way communication between threads or between target and PC host

The GUI (graphical user interface) simplifies system design by:
- Automatically including the appropriate runtime support libraries
- Automatically handles interrupt vectors and system reset
- Handles system memory configuration (builds .cmd file)
- When a .tcf file is saved, the Config Tool generates 5 additional files:

<table>
<thead>
<tr>
<th>Filename</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.tcf</td>
<td>Text Configuration File</td>
</tr>
<tr>
<td>.cfg.c.c</td>
<td>C code created by Config Tool</td>
</tr>
<tr>
<td>.cfg.s28</td>
<td>ASM code created by Config Tool</td>
</tr>
<tr>
<td>.cfg.cmd</td>
<td>Linker command file</td>
</tr>
<tr>
<td>.cfg.h</td>
<td>header file for *cfg.c.c</td>
</tr>
<tr>
<td>.cfg.h28</td>
<td>header file for *cfg.s28</td>
</tr>
</tbody>
</table>

When you add a .tcf file to your project, CCS automatically adds the C and assembly (.s28) files and the linker command file (.cmd) to the project under the Generated Files folder.
1. Creating a New Memory Region (Using MEM)

First, to create a specific memory area, open up the .tcf file, right-click on the Memory Section Manager and select “Insert MEM”. Give this area a unique name and then specify its base and length. Once created, you can place sections into it (shown in the next step).

Memory Section Manager (MEM)

- Generates the main linker command file for your code project
  - Create memories
  - Place sections
- To create a new memory area:
  - Right-click on MEM and select insert memory
  - Enter your choice of a name for the memory
  - Right-click on the memory, and select Properties
    - fill in base, length, space
2. Placing Sections – MEM Manager Properties

The configuration tool makes it easy to place sections. The predefined compiler sections that were described earlier each have their own drop-down menu to select one of the memory regions you defined (in step 1).

![Memory Section Manager Properties](image)

- **To place a section into a memory area:**
  - Right-click on MEM and select Properties
  - Select the desired tab (e.g. Compiler)
  - Select the memory you would like to link each section to
3. **PIE Interrupts – HWI Interrupts**

The configuration tools is also used to assign the interrupt vectors. The vectors are placed into a section named `.hwi_vec`. The memory manager (MEM) links this section to the proper location in memory.

**Hardware Interrupt Manager (HWI)**

- Config Tool used to assign interrupt vectors
- Vectors are placed in the section `.hwi_vec`
- Use MEM manager to link `.hwi_vec` to the proper memory
4. Running the Linker

Creating the Linker Command File (via .tcf)

When you have finished creating memory regions and allocating sections into these memory areas (i.e. when you save the .tcf file), the CCS configuration tool creates five files. One of the files is BIOS’a cfg.cmd file — a linker command file.

Files Created by the Configuration Tool

- Config tool generates five different files
- .cmd file is generated from your MEM settings
- Vectors put into *cfg_c.c

This file contains two main parts, MEMORY and SECTIONS. (Though, if you open and examine it, it’s not quite as nicely laid out as shown above.)

Running the Linker

The linker’s main purpose is to link together various object files. It combines like-named input sections from the various object files and places each new output section at specific locations in memory. In the process, it resolves (provides actual addresses for) all of the symbols described in your code. The linker can create two outputs, the executable (.out) file and a report which describes the results of linking (.map).

Note: The linker gets run automatically when you BUILD or REBUILD your project.
Scheduling DSP/BIOS Threads

### DSP/BIOS Thread Types

<table>
<thead>
<tr>
<th>Priority</th>
<th>HWI (Hardware Interrupts)</th>
<th>SWI (Software Interrupts)</th>
<th>TSK (Tasks)</th>
<th>IDL (Background)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Used to implement ‘urgent’ part of real-time event</td>
<td>Use SWI to perform HWI ‘follow-up’ activity</td>
<td>Use TSK to run different programs concurrently under separate contexts</td>
<td>Runs when no service routines are pending</td>
</tr>
<tr>
<td></td>
<td>Triggered by hardware interrupt</td>
<td>SWI’s are ‘posted’ by software</td>
<td>TSK’s enabled by posting ‘semaphore’ (a signal)</td>
<td>Runs as an infinite loop, like traditional while loop</td>
</tr>
<tr>
<td></td>
<td>HWI priorities fixed in hardware</td>
<td>Multiple SWIs at each of 15 priority levels</td>
<td></td>
<td>All BIOS data transfers to host occur here</td>
</tr>
</tbody>
</table>

---

### Enabling DSP/BIOS in main()

```c
void main(void)
{
    //*** Initialization
    ... 
    //*** Enable global interrupts
    // asm(" CLRC INTM");

    //*** Main Loop
    // while(1);

    } //end of main()
```

- BIOS will enable global interrupts for you
- Must delete the endless loop at end of main()
  - main() returns to BIOS and goes to the IDLE thread, allowing BIOS to schedule events, transfer data to the host, etc.
  - An endless loop in main() will keep BIOS from running
Scheduling DSP/BIOS Threads

Using Hardware Interrupts - HWI

- **Interrupt priority fixed by hardware**

![Image of Hardware Interrupts - HWI](image)

The HWI Dispatcher

- For non-BIOS code, use the `interrupt` keyword to declare an ISR
  - tells the compiler to perform context save/restore

```c
interrupt void MyHwi(void)
{
}
```

- For DSP/BIOS code, use the **Dispatcher** to perform the save/restore
  - Remove the interrupt keyword from the MyHwi()
  - Check the “Use Dispatcher” box when you configure the interrupt vector in the DSP/BIOS configuration tool
  - This is necessary if you want to use any DSP/BIOS functionality inside the ISR

![Image of The HWI Dispatcher](image)
Scheduling DSP/BIOS Threads

Using Software Interrupts - SWI

- Make each algorithm an independent software interrupt
- SWI scheduling is handled by DSP/BIOS
  - HWI function triggered by hardware
  - SWI function triggered by software
    e.g. a call to SWI_post()
- Why use a SWI?
  - No limitation on number of SWIs, and priorities for SWIs are user-defined
  - SWI can be scheduled by hardware or software event(s)
  - Defer processing from HWI to SWI

SWI Properties
Managing SWI Priority

- Drag and Drop SWIs to change priority
- Equal priority SWIs run in the order that they are posted

Priority Based Thread Scheduling

HWI 2 (highest)
HWI 1
SWI 3
SWI 2
SWI 1
MAIN
IDLE (lowest)

User sets the priority...BIOS does the scheduling

User sets the priority...BIOS does the scheduling

```c
c
SWI_post(&swi2);
c
```
Using Tasks (TSK)

SWI vs. TSK

- Similar to hardware interrupt, but triggered by SWI_post()
- SWIs must run to completion
- All SWI's use system stack
- faster context switching
- smaller code size

- SEM_post() readies the TSK which pends on an event
- TSKs can be terminated by S/W
- Each TSK has its own stack
- slower context switching
- larger code size
Periodic Functions

Using Periodic Functions - PRD

- Periodic functions are a special type of SWI that are triggered by DSP/Bios.
- Periodic functions run at a user specified rate: e.g. LED blink requires 0.5 Hz.
- Use the CLK Manager to specify the DSP/Bios CLK rate in microseconds per "tick".
- Use the PRD Manager to specify the period (for the function) in ticks.
- Allows multiple periodic functions with different rates.

Creating a Periodic Function

- Similar diagrams for specifying periodic functions with different rates.
Real-Time Analysis Tools

Built-in Real-Time Analysis Tools

- Gather data on target (3-10 CPU cycles)
- Send data during BIOS IDL (100s of cycles)
- Format data on host (1000s of cycles)
- Data gathering does NOT stop target CPU

CPU Load graph and CPU Load Data

- Shows amount of CPU horsepower being consumed
Real-Time Analysis Tools

Built-in Real-Time Analysis Tools

Statistics Data
- Profile routines w/o halting the CPU

Printf Logs
- Send debug msgs to host
- Doesn’t halt the DSP
- Deterministic, low DSP cycle count
- More efficient than traditional printf()

LOG_printf(&trace, “LedSwiCount = %u”, LedSwiCount++);
Lab 12: DSP/BIOS

Objective

The objective of this lab is to become familiar with DSP/BIOS. In this lab exercise, we will make use of the DSP/BIOS configuration tool, implement a software interrupt (SWI) and periodic function (PRD), program the DSP/BIOS project into the flash, and explore the built-in real-time analysis tools. The DSP/BIOS configuration tool creates a text configuration file (*.tcf) and generates a linker command file (*.cfg.cmd). This generated linker command file is functionally equivalent to the linker command file previously used. The memory area of the lab linker command file will be deleted; however, part of the sections area will be used to link sections that are not part of DSP/BIOS. In the lab files we will change the DMA HWI (DINTCH1_ISR) to a SWI and replace the LED blink routine with a periodic function. The steps required to properly configure the software for execution from internal flash memory will be covered. Features of the real-time analysis tools, such as the CPU Load Graph, Message Log, Statistics View, and RTA Control Panel will be demonstrated.

Lab 12: DSP/BIOS

Objective:
- Use DSP/BIOS Configuration Tool to:
  - Handle system memory & interrupt vectors
  - Create a .tcf file
  - Change DMA DINTCH1_ISR HWI to SWI
  - Replace LED blink routine with a Periodic Function
  - Program system into Flash Memory

Procedure

Create a New Project

1. Create a new project (File → New → CCS Project) and name it Lab12. Uncheck the “Use default location” box. Click the Browse... button and navigate to:
   C:\C28x\Labs\Lab12\Project

Click OK and then click Next.
2. In the next window that appears set the “Project Type” to “C2000” and leave the “Debug” and “Release” boxes checked. Click Next.

3. In the next window, “Additional Project Settings” select Next.

4. In the next window the CCS project settings are selected. Set the “Device Variant” using the pull-down list to “TMS320F28335”. Then using the pull-down list change the “Linker Command File” to “<none>”. Finally, set the “Runtime Support Library” to “<none>”. The DSP/BIOS configuration tool supplies its own RTS library. Click Next.

5. The last window selects the “Project Templates”. Click the plus sign (+) to the left of “DSP/BIOS v5.xx Examples” and select “Empty Example”. Click Finish.

6. Right-click on Lab12 in the C/C++ Projects window and add the following files to the project (Add Files to Project…) from C:\C28x\Labs\Lab12\Files:

   Adc_9_10_12.c  Flash.c
   CodeStartBranch.asm  Gpio.c
   DefaultIsr_12.c  Lab.h
   DelayUs.asm  Lab_12.cmd
   Dma.c  Main_12.c
   DSP2833x_GlobalVariableDefs.c  Passwords.asm
   DSP2833x_Headers_BIOS.cmd  PieCtrl_12.c
   ECap_7_8_9_10_12.c  SysCtrl.c
   EPwm_7_8_9_10_12.c  Watchdog.c
   Filter.c

   Note: DSP2833x_DefaultIsr.h is not used in this project. DSP/BIOS will supply its own ISR function prototypes. Also, the labcfg.h header file will be automatically created. This is the DSP/BIOS generated include file, and is needed to allow code to access the DSP/BIOS functions and data structures.

Project Build Options

7. Setup the build options by right-clicking on Lab12 in the C/C++ Projects window and select Properties. Then select the “C/C++ Build” Category. Be sure that the Tool Settings tab is selected.

   Note that in the previous lab exercises the stack size was set by the project build options in the linker basic options category. When using DSP/BIOS the stack size is instead specified with the DSP/BIOS configuration tool. This will be taken care of when we get to that section.

8. Under the “C2000 Linker” select “Basic Options” and delete the entry for the stack size.

9. Setup the include search path to include the peripheral register header files. Under “C2000 Compiler” select “Include Options”. In the box that opens click the Add icon (first icon with green plus sign). Then in the “Add directory path” window type:

   ${PROJECT_ROOT}/../../../../DSP2833x_headers/include
Click OK to include the search path. Repeat the process to add the IQmath header file. Click the Add icon and in the “Add directory path” window type:

\${PROJECT_ROOT}/../../IQmath/include

Click OK to include the search path.

10. Next, setup the library search path to include the IQmath library. Under “C2000 Linker” select “File Search Path”. In the top box click the Add icon. Then in the “Add file path” window type:

\${PROJECT_ROOT}/../../IQmath/lib/IQmath.lib

Click OK to include the library file.

In the bottom box click the Add icon. In the “Add directory path” window type:

\${PROJECT_ROOT}/../../IQmath/lib

Click OK to include the library search path.

11. As the project is now configured, we would get a warning at build time stating that the typedef name has already been declared with the same type. This is because it has been defined twice; once in the header files and again in the include file generated by DSP/BIOS. To suppress the warning, under “C2000 Compiler” select “Diagnostics Options”. Scroll to the bottom option box – “Suppress Diagnostic (-pds)” and click the Add icon. Type in code number 303 in the enter value box then select OK.

12. Finally, select OK to save and close the build options window.

**Edit Lab.h File**

13. Edit Lab.h to *uncomment* the line that includes the labcfg.h header file. This is the DSP/BIOS generated include file, and is needed to allow code to access the DSP/BIOS functions and data structures. Next, *comment out* the line that includes the “DSP2833x_DefaultIsr.h” ISR function prototypes. DSP/BIOS will supply its own ISR function prototypes. Save and close the file.

**Inspect Lab_12.cmd**

14. We will be using the DSP/BIOS configuration tool to create a linker command file. Open and inspect Lab_12.cmd. Notice that the linker command file does not have a memory area and includes only a limited sections area. These sections are not part of DSP/BIOS and need to be included in a “user” linker command file. Close the inspected file.

**Using the DSP/BIOS Configuration Tool**

15. The text configuration file (*.tcf) created by the DSP/BIOS configuration tool controls a wide range of CCS capabilities. The .tcf file will be used to automatically create and perform memory management. Create a new .tcf file for this lab. On the menu bar click:
File \rightarrow New \rightarrow DSP/BIOS v5.xx Configuration File

A dialog box will open and name the file \texttt{Lab.tcf}. (Note – do not use the default \texttt{Lab12.tcf} file name). Click Next.

16. The next window that appears shows a number of available .tcf seed files. The seed files are used to configure many objects specific to the processor and will be invoked as the first item in your own .tcf file. Scroll the options and select the \texttt{ti.platforms.control28335} template and click Next.

17. In the next window all DSP/BIOS features should be checked and then click Finish. The Configuration Tool will open and the configuration file will be automatically added to the project.

Create New Memory Sections Using the TCF File

18. In the configuration window, left click the plus sign next to \texttt{System} and the plus sign next to \texttt{MEM}. By default, the Memory Section Manager has combined the memory space for L0, L1, L2 and L3SARAM into a single memory block called L03SARAM; and L4, L5, L6 and L7SARAM into a single memory block called L47SARAM. It has also combined M0 and M1SARAM into a single memory block called MSARAM.

19. Next, we will add some of the additional memory sections that will be needed for the lab exercises in this module. To add a memory section:

Right click on \texttt{MEM – Memory Section Manager} and select Insert MEM. Rename the newly added memory section to \texttt{BEGIN_FLASH}. Repeat the process and add the following memory sections: \texttt{CSM_RSVD}, \texttt{FPUTABLES}, \texttt{IQTABLES}, \texttt{IQTABLES2} and \texttt{PASSWORDS}. Double check and see that all six memory sections have been added.

20. Modify the base addresses, length, and space of each of the memory sections to correspond to the memory mapping shown in the table below. To modify the length, base address, and space of a memory section, right click on the memory in the configuration tool, and select Properties.

<table>
<thead>
<tr>
<th>Memory</th>
<th>Base</th>
<th>Length</th>
<th>Space</th>
</tr>
</thead>
<tbody>
<tr>
<td>BEGIN_FLASH</td>
<td>0x33 FFF6</td>
<td>0x0002</td>
<td>code</td>
</tr>
<tr>
<td>CSM_RSVD</td>
<td>0x33 FF80</td>
<td>0x0076</td>
<td>code</td>
</tr>
<tr>
<td>FPUTABLES</td>
<td>0x3F EBDC</td>
<td>0x06A0</td>
<td>code</td>
</tr>
<tr>
<td>IQTABLES</td>
<td>0x3F E000</td>
<td>0x0B50</td>
<td>code</td>
</tr>
<tr>
<td>IQTABLES2</td>
<td>0x3F EB50</td>
<td>0x008C</td>
<td>code</td>
</tr>
<tr>
<td>PASSWORDS</td>
<td>0x33 FFF8</td>
<td>0x0008</td>
<td>code</td>
</tr>
</tbody>
</table>

21. Modify the base addresses, length, and space of each of the memory sections to avoid memory conflicts with the newly added memory sections as shown in the following table:
<table>
<thead>
<tr>
<th>Memory</th>
<th>Base</th>
<th>Length</th>
<th>Space</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOTROM</td>
<td>0x3F F37C</td>
<td>0x0D44</td>
<td>code</td>
</tr>
<tr>
<td>FLASH</td>
<td>0x30 0000</td>
<td>0x3FF80</td>
<td>code</td>
</tr>
</tbody>
</table>

22. Next, modify the space setting for \texttt{L03SARAM} to be “code” and the space setting for \texttt{L47SARAM} to be “data”.

**Link Uninitialized Sections to RAM**

23. Right click on \texttt{MEM - Memory Section Manager} and select \texttt{Properties}. Select the \texttt{Compiler Sections tab} and link the following uninitialized sections into the MSARAM memory block via the pull-down boxes:

<table>
<thead>
<tr>
<th>MSARAM</th>
</tr>
</thead>
<tbody>
<tr>
<td>.bss</td>
</tr>
<tr>
<td>.ebss</td>
</tr>
</tbody>
</table>

**Link Initialized Sections to Flash**

All initialized sections must be linked to the on-chip flash memory. Each initialized section actually has two addresses associated with it. First, it has a LOAD address which is the address to which it gets loaded at load time (or at flash programming time). Second, it has a RUN address which is the address from which the section is accessed at runtime. The linker assigns both addresses to the section. Most initialized sections can have the same LOAD and RUN address in the flash. However, some initialized sections need to be loaded to flash, but then run from RAM. This is required, for example, if the contents of the section needs to be modified at runtime by the code.

24. This step assigns the RUN address of those sections that need to run from flash. Using the \texttt{MEM - Memory Section Manager} in the DSP/BIOS configuration tool link the following sections to on-chip \texttt{FLASH} memory:

<table>
<thead>
<tr>
<th>BIOS Data tab</th>
<th>BIOS Code tab</th>
<th>Compiler Sections tab</th>
</tr>
</thead>
<tbody>
<tr>
<td>.gblinit</td>
<td>.bios</td>
<td>.text</td>
</tr>
<tr>
<td></td>
<td>.sysinit</td>
<td>.switch</td>
</tr>
<tr>
<td></td>
<td>.hwi</td>
<td>.cinit</td>
</tr>
<tr>
<td></td>
<td>.rtdx_text</td>
<td>.pinit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>.econst / .const</td>
</tr>
<tr>
<td></td>
<td></td>
<td>.data</td>
</tr>
</tbody>
</table>
25. This step assigns the LOAD address of those sections that need to load to flash. Again using the MEM – Memory Section Manager in the DSP/BIOS configuration tool select the Load Address tab and check the “Specify Separate Load Addresses” box. Then set all entries to the FLASH memory block.

26. Click the BIOS Data tab and notice that the .stack section has been linked into memory. Click OK to close the window.

27. The section named “IQmath” is an initialized section that needs to load to and run from flash. This section is not linked using the DSP/BIOS configuration tool (because it is neither a standard compiler section nor a DSP/BIOS generated section). Instead, this section is linked with the user linker command file (Lab_12.cmd). Previously the “IQmath” section was linked to L03SARAM and it is now linked to FLASH.

Set the Stack Size in the TCF File

Recall in the previous lab exercise that the stack size was set using the CCS project build options. When using the DSP/BIOS configuration tool, the stack size is instead specified in the .tcf file.

28. Using the MEM – Memory Section Manager select the General tab. Set the Stack Size to 0x180. The stack size needs to be reduced from 0x200 to 0x180 because of the limited amount of space available in the RAM block on the device when using DSP/BIOS. Click OK to close the window.

Copying .hwi_vec Section from Flash to RAM

The DSP/BIOS .hwi_vec section contains the interrupt vectors. This section must be loaded to flash (load address) but run from RAM (run address). The code that performs this copy is located in InitPieCtrl(). The linker command file generated by the DSP/BIOS configuration tool generates global symbols that can be accessed by code in order to determine the load address, run address, and length of the .hwi_vec section. The RTS library contains a memory copy function called memcpy() which will be used to perform the copy.

29. Open and inspect InitPieCtrl() in PieCtrl_12.c. Notice the memcpy() function and the symbols used to initialize (copy) the .hwi_vec section.

Copying the .trcdata Section from Flash to RAM

The DSP/BIOS .trcdata section is used by CCS and DSP/BIOS for certain real-time debugging features. This section must be loaded to flash (load address) but run from RAM (run address). The linker command file generated by the DSP/BIOS configuration tool generates global symbols that can be accessed by code in order to determine the load address, run address, and length of the .trcdata section. The memory copy function memcpy() will again be used to perform the copy.

The copying of .trcdata must be performed prior to main(). This is because DSP/BIOS modifies the contents of .trcdata during DSP/BIOS initialization, which also occurs prior to main(). The DSP/BIOS configuration tool provides a user initialization function which will be used to perform the .trcdata section copy prior to both main() and DSP/BIOS initialization.
30. In the DSP/BIOS configuration file (Lab.tcf) select the Properties for the Global Settings. Check the box “Call User Init Function” and enter the UserInit() function name with a leading underscore: _UserInit. This will cause the function UserInit() to execute prior to main(). Click OK to close the window.

31. Open and inspect the file Main_12.c. Notice that the function UserInit() is used to copy the .trcdata section from its load address to its run address before main().

**Initializing the Flash Control Registers**

The initialization code for the flash control registers cannot execute from the flash memory (since it is changing the flash configuration!). Therefore, the initialization function for the flash control registers must be copied from flash (load address) to RAM (run address) at runtime. The memory copy function memcpy() will again be used to perform the copy. The initialization code for the flash control registers InitFlash() is located in the Flash.c file.

32. Open and inspect Flash.c. The C compiler CODE_SECTION pragma is used to place the InitFlash() function into a linkable section named “secureRamFuncs”.

33. Since the DSP/BIOS configuration tool does not know about user defined sections, the “secureRamFuncs” section will be linked using the user linker command file Lab_12.cmd. Open and inspect Lab_12.cmd. The “secureRamFuncs” will load to flash (load address) but will run from L03SARAM (run address). Also notice that the linker has been asked to generate symbols for the load start, load end, and run start addresses.

34. Open and inspect Main_12.c. Notice that the memory copy function memcpy() is being used to copy the section “secureRamFuncs”, which contains the initialization function for the flash control registers. Close all the inspected files.

**Setup PIE Vectors for Interrupts in the TCF File**

Next, we will setup all of the PIE interrupt vectors that will be needed for the lab exercises in this module. This will include all of the vectors used in the previous lab exercises. (Note: the PieVect.c file is not used since DSP/BIOS generates the interrupt vector table).

35. Modify the configuration file Lab.tcf to setup the PIE vector for the watchdog interrupt. Click on the plus sign (+) to the left of Scheduling and again on the plus sign (+) to the left of HWI - Hardware Interrupt Service Routine Manager. Click the plus sign (+) to the left of PIE INTERRUPTS. Locate the interrupt entry for the watchdog at PIE_INT1_8. Right click, select Properties, and type _WAKEINT_ISR (with a leading underscore) in the function field. Click OK to save.

36. Setup the PIE vector for the ADC interrupt. Locate the interrupt entry for the ADC at PIE_INT1_6. Right click, select Properties, and type _ADCINT_ISR (with a leading underscore) in the function field. Click OK to save.
37. Setup the PIE vector for the ECAPI interrupt. Locate the interrupt entry for the ECAPI at PIE_INT4_1. Right click, select Properties, and type _ECAPI_INT_ISR (with a leading underscore) in the function field. Click OK to save.

38. Setup the PIE vector for the DMA channel 1 interrupt. Locate the interrupt entry for the DMA channel 1 at PIE_INT7_1. Right click, select Properties, and type _DINTCH1_ISR (with a leading underscore) in the function field. Click OK to save.

Configuring DSP/BIOS Global Settings

39. In the configuration file Lab.tcf click on the plus sign (+) to the left of System. Right click on Global Settings and select Properties. Set the “DSP Speed in MHz (CLKOUT)” field to 150 so that it matches the processor speed. Click OK to save the value and close the properties window. This value is used by the CLK manager to calculate the register settings for the on-chip timers and provide the proper time-base for executing CLK functions. Close the configuration window and select YES to save changes to Lab.tcf.

Prepare main() for DSP/BIOS

40. Open Main_12.c and delete the inline assembly code from main() that enables global interrupts. DSP/BIOS will enable global interrupts after main().

41. In Main_12.c, remove the endless while() loop from the end of main(). When using DSP/BIOS, you must return from main(). In all DSP/BIOS programs, the main() function should contain all one-time user-defined initialization functions. DSP/BIOS will then take-over control of the software execution. Save and close the file.

Boot Mode Jumpers – Executing from Flash after Reset

42. The controlCARD or Docking Station needs to be configured for “Jump to Flash” boot mode. Move the “2833x Boot Mode” controlCARD switch SW2 positions 1, 2, 3 and 4 to the “1 – on” position (all switches up) or the Docking Station jumpers 84, 85, 86 and 87 to the “1” position (all jumpers to the left side) to accomplish this. Details of the switch and jumper positions can be found in Appendix A. These jumpers control the pullup/down resistor on the GPIO84, GPIO85, GPIO86 and GPIO87 pins, which are the pins sampled by the bootloader to determine the boot mode.

Build and Program the Flash – Lab.out

43. Click the “Build” button to generate the Lab.out file to be used with the CCS Flash Programmer. Check for errors in the Problems window.

44. Program the flash memory by clicking the “Debug” button (green bug). As soon as the “Progress Information” box opens, if needed select “Details” in order to watch the programming operation and status. After successfully programming the flash memory the “Progress Information” box will close.
45. The code should stop at the beginning of your `main()` routine. If you got to that point successfully, it confirms that the flash has been programmed properly, that the bootloader is properly configured for jump to flash mode, and that the codestart section has been linked to the proper address. As a test, run the CPU and you should observe the LED on the ControlCARD blinking, then halt the CPU.

Testing the CPU Computational Loading

It will be interesting to investigate the CPU computational burden of the various parts of our application, as well as the different pieces of DSP/BIOS that we will be using in this lab exercise. The ‘CPU Load graph’ and ‘CPU Load Data’ features of DSP/BIOS will provide a quick and easy method for doing this. We will be tabulating these results in the table that follows at various steps throughout the remainder of this lab.

**Table 12-1: CPU Computational Burden Results**

<table>
<thead>
<tr>
<th>Case #</th>
<th>Description</th>
<th>CPU Load %</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DMA processing handled in HWI. Filter inactive.</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Case #1 + filter active.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>DMA processing handled in SWI. Filter active. LED blink handled in HWI. RTA Global Host Enable disabled.</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Case #3 + LED blink handled in PRD.</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Case #4 + LOG Printf in SWI.</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Case #5 + RTA SWI Logging enabled.</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Case #6 + RTA SWI Accumulators enabled.</td>
<td></td>
</tr>
</tbody>
</table>

Run the Code – HWI() Implementation

At this point, we have modified the code so that DSP/BIOS will take control after `main()` completes. However, we have not made any other changes to the code since the previous lab. Therefore, the computations we want performed in the `DINTCH1_ISR()` (e.g., reading the ADC result, running the filter) are still taking place in the hardware ISR, or to use DSP/BIOS terminology, the HWI.

**Note:** For the next step, check to be sure that the jumper wire connecting PWM1A (pin # GPIO-00) to ADCINA0 (pin # ADC-A0) is still in place on the Docking Station.
46. Run the code in real-time mode using the Script function: Scripts → Realtime Emulation Control → Run_Realtime_with_Reset.

47. Setup a dual-time graph of the filtered and unfiltered ADC results buffer. Click: Tools → Graph → Dual Time and set the following values:

<table>
<thead>
<tr>
<th>Acquisition Buffer Size</th>
<th>48</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSP Data Type</td>
<td>32-bit floating-point</td>
</tr>
<tr>
<td>Sampling Rate (Hz)</td>
<td>48000</td>
</tr>
<tr>
<td>Start Address – A</td>
<td>AdcBufFiltered</td>
</tr>
<tr>
<td>Start Address – B</td>
<td>AdcBuf</td>
</tr>
<tr>
<td>Display Data Size</td>
<td>48</td>
</tr>
<tr>
<td>Time Display Unit</td>
<td>μs</td>
</tr>
</tbody>
</table>

Select OK to save the graph options.

48. The graphical display should show the filtered PWM waveform in the Dual Time A display and the unfiltered waveform in the Dual Time B display. The results should be the same as the previous lab.

49. Open the RTA Control Panel by clicking Tools → RTA → RTA Control Panel. In the Diagnostics row set the following six control switches to RUNTIME OFF by clicking directly to the right of the check boxes and using the pull-down options:

<table>
<thead>
<tr>
<th>SWI logs</th>
<th>PRD logs</th>
<th>CLK logs</th>
<th>TSK logs</th>
<th>SWI stats</th>
<th>PRD stats</th>
</tr>
</thead>
</table>

This disables most of the realtime analysis tools we will be using in this lab exercise. We will selectively enable them in the lab.

50. Open the CPU Load graph by clicking Tools → RTA → CPU Load. Also open the CPU Load Data window by clicking on Tools → RTA → CPU Load Data. The CPU load graph and CPU load data window displays the percentage of available CPU computing horsepower that the application is consuming. The CPU may be running ISRs, software interrupts, periodic functions, performing I/O with the host, or running any user routine. When the CPU is not executing user code, it will be idle (in the DSP/BIOS idle thread).

The graph should start updating, showing the percentage load on the CPU. Keep the CPU running to complete steps 51 through 55.

51. In Main_12.c notice that the global variable DEBUG_FILTER is used to control the FIR filter in DINTCH1_ISR(). If DEBUG_FILTER = 1, the FIR filter is called and the AdcBufFilter array is filled with the filtered data. Likewise, if DEBUG_FILTER = 0, the filter is not called and the AdcBufFilter array is filled with the unfiltered data.
52. Add the variable `DEBUG_FILTER` to the watch window. (Make sure that `continuous refresh` is enabled for the watch window). Change its value to “0” to turn off the FIR filtering. Notice the decrease in the CPU Load Graph.

53. Record the value shown in the CPU Load Data window under “Case #1” in Table 12-1.

54. Change the value of `DEBUG_FILTER` back to “1” in the watch window in order to bring the FIR filter back online. Notice the jump in the CPU Load Graph.

55. Record the value shown in the CPU Load Data window under “Case #2” in Table 12-1.

56. Fully halt the CPU in real-time mode by using the Script function: Scripts → Realtime Emulation Control → Full_Halt.

Create a SWI

57. Switch to the “C/C++ Perspective” view by clicking the C/C++ icon in the upper right-hand corner. In `Main_12.c` notice that space has been added at the end of main() for two new functions which will be used in this lab – Dma1Swi() and LedBlink(). (Space has also been provided for AdcSwi() for the optional exercise). In the next few steps, we will move part of the DINTCH1_ISR() routine from `DefaultIsr_12.c` to this space in `Main_12.c`.

58. Open `DefaultIsr_12.c` and locate the DINTCH1_ISR() routine. Move the entire contents of the DINTCH1_ISR() routine to the Dma1Swi() function in `Main_12.c` with the following exceptions:

**DO NOT MOVE:**

- The instruction used to acknowledge the PIE group interrupt
- The static local variable declaration of `GPIO34_count`
- The GPIO pin (LED) toggle code

Be sure to move all of the other static local variable declaration at the top of DINTCH1_ISR() that is used to index into the ADC buffers. *(Do not* move the static local variable declaration of `GPIO34_count`).

*Comment:* In almost all applications, the PIE group acknowledge code is left in the HWI (rather than move it to a SWI). This allows other interrupts to occur on that PIE group even if the SWI has not yet executed. On the other hand, we are leaving the GPIO and LED toggle code in the HWI just as an example. It illustrates that you can post a SWI and also do additional operations in the HWI. DSP/BIOS is extremely flexible!

59. Delete the interrupt key word from the DINTCH1_ISR. The interrupt keyword is not used when a HWI is under DSP/BIOS control. A HWI is under DSP/BIOS control when it uses any DSP/BIOS functionality, such as posting a SWI, or calling any DSP/BIOS function or macro.
Post a SWI

60. Still in `DefaultIsr_12.c` add the following `SWI_post` to the `DINTCH1_ISR()`, just after the structure used to acknowledge the PIE group:

```
SWI_post(&DMA1_swi);  // post a SWI
```

This posts a SWI that will execute the `DMA1_swi()` code you populated a few steps back in the lab. In other words, the DMA1 interrupt still executes the same code as before. However, most of that code is now in a posted SWI that DSP/BIOS will execute according to the specified scheduling priorities. Save the modified files.

Add the SWI to the TCF File

61. In the configuration file `Lab.tcf` we need to add and setup the `Dma1Swi()` SWI. Open `Lab.tcf` and click on the plus sign (+) to the left of Scheduling and again on the plus sign (+) to the left of SWI - Software Interrupt Manager.

62. Right click on SWI - Software Interrupt Manager and select Insert SWI. Rename SWI0 to `DMA1_swi` and click OK. This is just an arbitrary name. We want to differentiate the `Dma1Swi()` function itself (which is nothing but an ordinary C function) from the DSP/BIOS SWI object which we are calling `DMA1_swi`.

63. Select the Properties for `DMA1_swi` and type `_Dma1Swi` (with a leading underscore) in the function field. Click OK. This tells DSP/BIOS that it should run the function `Dma1Swi()` when it executes the `DMA1_swi` SWI.

64. We need to have the PIE for the DMA channel 1 interrupt use the dispatcher. The dispatcher will automatically perform the context save and restore, and allow the DSP/BIOS scheduler to have insight into the ISR. You may recall from an earlier lab that the DMA channel 1 interrupt is located at PIE_INT7_1.

Click on the plus sign (+) to the left of HWI - Hardware Interrupt Service Routine Manager. Click the plus sign (+) to the left of PIE INTERRUPTS. Locate the interrupt entry for the DMA channel 1: PIE_INT7_1. Right click, select Properties, and select the Dispatcher tab. Check the "Use Dispatcher" box and select OK. Close the configuration file and click YES to save changes.

Build and Load

65. Click the “Build” button to generate the `Lab.out` file and select No to “Reload the program automatically”. The `Lab.out` file needs to be programmed into flash memory.

66. Program the flash memory by clicking the “Debug” button (green bug). *(If needed select “Details” in order to watch the programming operation and status).* After successfully programming the flash memory the “Progress Information” box will close and the view will switch to the “Debug Perspective”.
Run the Code – Dma1Swi()

67. Run the code (real-time mode) using the Script function: Scripts → Realtime Emulation Control → Run_Realtime_with_Reset. Confirm that the graphical display is showing the correct results. The results should be the same as before (i.e., filtered PWM in the Dual Time A display, unfiltered PWM in the Dual Time B display).

68. Record the value shown in the CPU Load Data window under “Case #3” in Table 12-1.

69. Fully halt the CPU (real-time mode) by using the Script function: Scripts → Realtime Emulation Control → Full_Halt.

Add a Periodic Function

Recall that an instruction was used in the DINTCH1_ISR to toggle the LED on the ControlCARD. This instruction will be moved into a periodic function that will toggle the LED at the same rate.

70. Switch to the “C/C++ Perspective” view by clicking the C/C++ icon in the upper right-hand corner. In DefaultIsr_12.c locate the DINTCH1_ISR routine. Move the instruction used to toggle the LED to the LedBlink() function in Main_12.c:

```
GpioDataRegs.GPBTOGGLE.bit.GPIO34 = 1; // Toggle the pin
```

Now delete from the DINTCH1_ISR() the code used to implement the interval counter for the LED toggle (i.e., the GPIO34_count++ loop), and also delete the declaration of the GPIO34_count itself from the beginning of DINTCH1_ISR(). These are no longer needed, as DSP/BIOS will implement the interval counter for us in the periodic function configuration (next step in the lab). Save the modified files.

71. In the configuration file Lab.tcf we need to add and setup the LedBlink_PRD. Open Lab.tcf and click on the plus sign (+) to the left of Scheduling. Right click on PRD – Periodic Function Manger and select Insert PRD. Rename PRD0 to LedBlink_PRD and click OK.

72. Select the Properties for LedBlink_PRD and type _LedBlink (with a leading underscore) in the function field. This tells DSP/BIOS to run the LedBlink() function when it executes the LedBlink_PRD periodic function object.

Next, in the period (ticks) field type 500. The default DSP/BIOS system timer increments every 1 millisecond, so what we are doing is telling the DSP/BIOS scheduler to schedule the LedBlink() function to execute every 500 milliseconds. A PRD object is just a special type of SWI which gets scheduled periodically and runs in the context of the SWI level at a specified SWI priority. Click OK. Close the configuration file and click YES to save changes.
Build and Program the Flash

73. Click the “Build” button to generate the Lab.out file and select No to “Reload the program automatically”. The Lab.out file needs to be programmed into flash memory.

74. Program the flash memory by clicking the “Debug” button (green bug). *(If needed select “Details” in order to watch the programming operation and status).* After successfully programming the flash memory the “Progress Information” box will close and the view will switch to the “Debug Perspective”.

Run the Code – LedBlink_PRD

75. Run the code. Check to see if the LED on the ControlCARD is blinking.

76. Record the value shown in the CPU Load Data window under “Case #4” in Table 12-1.

77. Halt the CPU. If you would like, experiment with different period (tick) values and notice that the blink rate changes.

DSP/BIOS – Real-time Analysis Tools

The DSP/BIOS analysis tools complement the CCS environment by enabling real-time program analysis of a DSP/BIOS application. You can visually monitor an MCU application as it runs with essentially no impact on the application’s real-time performance. In CCS, the DSP/BIOS real-time analysis (RTA) tools are found on the Tools menu. Unlike traditional debugging, which is external to the executing program, DSP/BIOS program analysis requires that the target program be instrumented with analysis code. By using DSP/BIOS APIs and objects, developers automatically instrument the target for capturing and uploading real-time information to CCS using these tools.

We have actually been already using one part of the RTA tools in this lab: the CPU Load Graph and CPU Load Data window. We will now utilize two other basic items from the RTA toolbox.

78. In the next few steps the Log Event Manager will be setup to record the occurrence of an event in real-time while the program executes. We will be using LOG_printf() to write to a log buffer. The LOG_printf() function is a very efficient means of sending a message from the code to the CCS display. Unlike an ordinary C-language printf(), which can consume several hundred CPU cycles to format the data on the MCU before transmission to the CCS host PC, a LOG_printf() transmits the raw data to the host. The host then formats the data and displays it in CCS. This consumes only 10’s of cycles rather than 100’s of cycles.

Switch to the “C/C++ Perspective” view and add the following to Main_12.c at the top of the LedBlink() function just before the instruction used to toggle the LED:

```c
static Uint16 LedSwiCount=0;          // used for LOG_printf

/*** Using LOG_printf() to write to a log buffer ***/
LOG_printf(&trace, "LedSwiCount = %u", LedSwiCount++);
```
Save the modified file.

79. In the configuration file Lab.tcf we need to add and setup the trace buffer. Open Lab.tcf and click on the plus sign (+) to the left of Instrumentation and again on the plus sign (+) to the left of LOG – Event Log Manager. Right click on LOG – Event Log Manager and select Insert LOG. Rename LOG0 to trace and click OK.

80. Select the Properties for trace and confirm that the logtype is set to circular and the datatype is set to printf. Click OK. Close the configuration file and click YES to save changes.

Build and Program the Flash

81. Since the configuration file was modified, we need to rebuild the project. Click the “Build” button to generate the Lab.out file and select No to “Reload the program automatically”. The Lab.out file needs to be programmed into flash memory.

82. Program the flash memory by clicking the “Debug” button (green bug). (If needed select “Details” in order to watch the programming operation and status). After successfully programming the flash memory the “Progress Information” box will close and the view will switch to the “Debug Perspective”.

Run the Code – Realtime Analysis Tools

83. Run the code.

84. Open the Printf Logs. On the menu bar, click:

Tools → RTA → Printf Logs

The message log dialog box is displaying the commanded LOG_printf() output, i.e. the number of times (count value) that the LedSwi() has executed.

85. Record the value shown in the CPU Load Data window under “Case #5” in Table 12-1.

86. Open the Raw Logs window. On the menu bar, click:

Tools → RTA → Raw Logs

In the RTA Control Panel, set the SWI logs, PRD logs, CLK logs and TSK logs to RUNTIME ON. This enables the logging of these event types. Notice that the Raw Logs window is complete unformatted log data and is now displaying information about the execution threads being taken by your software. This window is not based on time, but the activity of events (i.e. when an event happens, such as a SWI or periodic function begins execution). Notice that the Raw Logs window simply records DSP/BIOS CLK events along with other system events (the DSP/BIOS clock periodically triggers the DSP/BIOS scheduler).
The logging of events to the Raw Logs window consumes CPU cycles, which is why the CPU Load Graph jumped as you enabled logging.

87. Record the value shown in the CPU Load Data window under “Case #6” in Table 12-1.

88. Open the Statistics Data window. On the menu bar, click:

\[ \text{Tools } \rightarrow \text{RTA } \rightarrow \text{Statistics Data} \]

Presently, the Statistics Data window is not changing with the exception of the statistics for the IDL_busyObj row (i.e., the idle loop). This is because we have it disabled in the RTA Control Panel.

In the RTA Control Panel, set the \textit{SWI stats} and \textit{PRD stats} to \texttt{RUNTIME ON}. This enables the logging of statistics to the statistics Data window. The logging of statistics consumes CPU cycles, which is why the CPU Load graph jumped as you enabled logging.

89. Record the value shown in the CPU Load Data window under “Case #7” in Table 12-1.

90. Table 12-1 should now be completely filled in. Think about the results.

91. Halt the CPU. If time permits you can proceed to the optional exercise at the end of the lab. When finished continue with the next step.

**Terminate Debug Session and Close Project**

92. Terminate the active debug session using the \texttt{Terminate All} button. This will close the debugger and return CCS to the “C/C++ Perspective” view.

93. Next, close the project by right-clicking on \texttt{Lab12} in the \texttt{C/C++ Projects} window and select \texttt{Close Project}.

**Return Boot Mode Jumpers Back to Default Positions**

94. Remove the power to the Docking Station by disconnecting the USB cable.

95. Return the settings of the boot mode switches or jumpers back to the default positions “Jump to M0SARAM” boot mode as shown in the table below (see Appendix A for jumper position details):

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Down – 0</td>
<td>Down – 0</td>
<td>Up – 1</td>
<td>Down – 0</td>
<td>controlCARD</td>
</tr>
<tr>
<td>Right – 0</td>
<td>Right – 0</td>
<td>Left – 1</td>
<td>Right – 0</td>
<td>Docking Station</td>
</tr>
</tbody>
</table>
Note: In this lab exercise only the basic features of DSP/BIOS and the real-time analysis tools have been used. For more information and details, please refer to the DSP/BIOS user’s manuals and other DSP/BIOS related training.

Optional Exercise:

Modify the lab to service the ADC without using the DMA as it was done in the Lab 8 exercise. Remove the call to the InitDma() function and enable the interrupts in the Adc.c file. Then use DSP/BIOS to convert the ADCINT_ISR HWI to SWI. Recalculate the CPU computational burden servicing the ADC without using the DMA.

A. In Main_12.c comment out the code used to call the InitDma() function.

B. In ADC_9_10_12.c uncomment the code used to enable the ADC interrupt. The ADC will now trigger the interrupt rather than the DMA.

C. In DefaultIsr_12.c locate the ADCINT_ISR() routine. Move the entire contents of the ADCINT_ISR() routine to the AdcSwi() function in Main_12.c with the following exceptions: Do Not Move – the instruction used to acknowledge the PIE group interrupt, the static local variable declaration of GPIO34_count, and the GPIO pin toggle code / LED toggle code. Be sure to move the other static local variable declaration at the top of ADCINT_ISR() that is used to index into the ADC buffers.

D. In DefaultIsr_12.c delete the interrupt key word from the ADCINT_ISR. Next delete the LED toggle code and the declaration of the GPIO34_count from the beginning of ADCINT_ISR(). This is already being done with a periodic function.

E. In DefaultIsr_12.c add the following SWI_post to the ADCINT_ISR(), just after the structure used to acknowledge the PIE group: SWI_post(&ADC_swi); //post a SWI. Save the modified files.

F. In the configuration file Lab.tcf add and setup the AdcSwi() SWI. Open Lab.tcf and click on the plus sign (+) to the left of Scheduling and again on the plus sign (+) to the left of SWI - Software Interrupt Manager.

G. Right click on SWI - Software Interrupt Manager and select Insert SWI. Rename SWIO to ADC_swi and click OK. This is just an arbitrary name to differentiate the AdcSwi() function itself (which is nothing but an ordinary C function) from the DSP/BIOS SWI object which we are calling ADC_swi.

H. Select the Properties for ADC_swi and type _AdcSwi (with a leading underscore) in the function field. Click OK. This tells DSP/BIOS that it should run the function AdcSwi() when it executes the ADC_swi SWI.

I. Next, we need to have the PIE for the ADC interrupt use the dispatcher. The dispatcher will automatically perform the context save and restore, and allow the DSP/BIOS scheduler to have insight into the ISR. You may recall from an earlier lab that the ADC interrupt is located at PIE_INT1_6.
Click on the plus sign (+) to the left of HWI - Hardware Interrupt Service Routine Manager. Click the plus sign (+) to the left of PIE INTERRUPTS. Locate the interrupt entry for the ADC: PIE_INT1_6. Right click, select Properties, and select the Dispatcher tab. Check the “Use Dispatcher” box and select OK. Close the configuration file and click YES to save changes.

J. Click the “Build” button to generate the Lab.out file and select No to “Reload the program automatically”. Next click the “Debug” button to program the flash memory.

K. Run the code in real-time mode using the Script function: Scripts → Realtime Emulation Control → Run_Realtime_with_Reset.

L. Confirm that the graphical display is showing the correct results. The results should be the same as before (i.e., filtered PWM in the Dual Time A display, unfiltered PWM in the Dual Time B display). Note that the ADC_swi is being serviced rather than the DMA1_swi.

M. Notice and compare the CPU computational burden servicing the ADC without using the DMA. The CPU load is now at 68% as compared to 17% for case #7. Also, in the Statistics Data window notice that the ADC_swi is now running rather than DMA1_swi.

N. Fully halt the CPU (real-time mode) by using the Script function: Scripts → Realtime Emulation Control → Full_Halt.

End of Optional Exercise
Lab 12 Reference: Programming the Flash

Flash Memory Section Blocks

<table>
<thead>
<tr>
<th>Base</th>
<th>Section</th>
<th>Start Address</th>
<th>Length</th>
<th>Space</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x300000</td>
<td>FLASH</td>
<td>0x300000</td>
<td>0x3FF80</td>
<td>code</td>
</tr>
<tr>
<td>0x33F80</td>
<td>CSM_RSVD</td>
<td>0x33F80</td>
<td>0x76</td>
<td>code</td>
</tr>
<tr>
<td>0x33FFF6</td>
<td>BEGIN_FLASH</td>
<td>0x33FFF6</td>
<td>0x2</td>
<td>code</td>
</tr>
<tr>
<td>0x33FFF8</td>
<td>PASSWORDS</td>
<td>0x33FFF8</td>
<td>0x8</td>
<td>code</td>
</tr>
</tbody>
</table>

Lab_12.cmd

```plaintext
SECTIONS
{
  codestart :> BEGIN_FLASH, PAGE = 0
  passwords :> PASSWORDS, PAGE = 0
  csm_rsvd  :> CSM_RSVD,    PAGE = 0
}
```

BIOS Startup Sequence from Flash Memory

1. **RESET**
2. **Boot Code**
3. **BROM vector (32w)**
4. **FLASH (256Kw)**
5. **LB**
6. **c_int00**
7. **c_int00**
8. **c_int00**
9. **return;**

BIOS code Sections

- BIOS_reset()
- BIOS_init()
- main()
- BIOS_start()
- IDL_run()

rts2800_ml.lib

"user" code sections

main()

{........
  return;
}
Table 12-2: CPU Computational Burden Results (Solution)

<table>
<thead>
<tr>
<th>Case #</th>
<th>Description</th>
<th>CPU Load %</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DMA processing handled in HWI. Filter inactive.</td>
<td>4</td>
</tr>
<tr>
<td>2</td>
<td>Case #1 + filter active.</td>
<td>15</td>
</tr>
<tr>
<td>3</td>
<td>DMA processing handled in SWI. Filter active. LED blink handled in HWI. RTA Global Host Enable disabled.</td>
<td>17</td>
</tr>
<tr>
<td>4</td>
<td>Case #3 + LED blink handled in PRD.</td>
<td>17</td>
</tr>
<tr>
<td>5</td>
<td>Case #4 + LOG_printf in SWI.</td>
<td>17</td>
</tr>
<tr>
<td>6</td>
<td>Case #5 + RTA SWI Logging enabled.</td>
<td>18</td>
</tr>
<tr>
<td>7</td>
<td>Case #6 + RTA SWI Accumulators enabled.</td>
<td>18</td>
</tr>
</tbody>
</table>
Introduction

This module contains various references to support the development process.

Learning Objectives

- TI Workshops Download Site
- Signal Processing Libraries
- TI Development Tools
- Additional Resources
  - Internet
  - Product Information Center
Module Topics

Development Support ............................................................................................................ 13-1

Module Topics .................................................................................................................. 13-2

TI Support Resources ........................................................................................................... 13-3
  C2000 Workshop Download Wiki ..................................................................................... 13-3
  controlSUITE ................................................................................................................... 13-4
  C28x Signal Processing Libraries ....................................................................................... 13-4
  Experimenter’s Kits ............................................................................................................ 13-5
  F28335 Peripheral Explorer Kit .......................................................................................... 13-6
  C2000 controlCARD Application Kits ................................................................................ 13-6
  Product Information Resources .......................................................................................... 13-7
TI Support Resources

C2000 Workshop Download Wiki

Hands-On Training for TI Embedded Processors

C2000™ 32-bit Real-time MCU Training

C2000™ Piccolo™ One-Day Workshop
- C2000™ Piccolo™ Multi-Day Workshop agenda, locations, and schedule
- Online materials and links

C2000™ Piccolo™ Multi-Day Workshop
- C2000™ Piccolo™ Multi-Day Workshop agenda, locations, and schedule
- Online materials and links

C2000™ Delfino™ Multi-Day Workshop
- TMS320F283x™ MCU Workshop agenda, locations, and schedule
- Online materials and links

C2000™ Archived Workshops
- The archived workshops are for F2837, F2407, and F2808 one-day and multi-day workshops. The F28032x™ 2-day one-day workshop is also listed here. C2000™ archived workshops

controlSUITE

C28x Signal Processing Libraries

C2000 Signal Processing Libraries

<table>
<thead>
<tr>
<th>Signal Processing Libraries &amp; Applications Software</th>
<th>Literature #</th>
</tr>
</thead>
<tbody>
<tr>
<td>AG3-1: Control with Constant V/Hz</td>
<td>SPRC194</td>
</tr>
<tr>
<td>AG3-3: Sensored Indirect Flux Vector Control</td>
<td>SPRC207</td>
</tr>
<tr>
<td>AG3-3: Sensored Indirect Flux Vector Control (simulation)</td>
<td>SPRC208</td>
</tr>
<tr>
<td>AG3-4: Sensorless Direct Flux Vector Control</td>
<td>SPRC195</td>
</tr>
<tr>
<td>AG3-4: Sensorless Direct Flux Vector Control (simulation)</td>
<td>SPRC209</td>
</tr>
<tr>
<td>PMSM3-1: Sensored Field Oriented Control using QEP</td>
<td>SPRC210</td>
</tr>
<tr>
<td>PMSM3-2: Sensorless Field Oriented Control</td>
<td>SPRC197</td>
</tr>
<tr>
<td>PMSM3-3: Sensored Field Oriented Control using Resolver</td>
<td>SPRC211</td>
</tr>
<tr>
<td>PMSM3-4: Sensorless Position Control using QEP</td>
<td>SPRC212</td>
</tr>
<tr>
<td>BLDC3-1: Sensored Trapezoidal Control using Hall Sensors</td>
<td>SPRC213</td>
</tr>
<tr>
<td>BLDC3-2: Sensorless Trapezoidal Drive</td>
<td>SPRC196</td>
</tr>
<tr>
<td>DCMOTOR: Speed &amp; Position Control using QEP without Index</td>
<td>SPRC214</td>
</tr>
<tr>
<td>Digital Motor Control Library (FIC280x)</td>
<td>SPRC215</td>
</tr>
<tr>
<td>Communications Driver Library</td>
<td>SPRC218</td>
</tr>
<tr>
<td>DSP Fast Fourier Transform (FFT) Library</td>
<td>SPRC081</td>
</tr>
<tr>
<td>DSP Filter Library</td>
<td>SPRC082</td>
</tr>
<tr>
<td>DSP Fixed-Point Math Library</td>
<td>SPRC085</td>
</tr>
<tr>
<td>DSP IQ Math Library</td>
<td>SPRC087</td>
</tr>
<tr>
<td>DSP Signal Generator Library</td>
<td>SPRC083</td>
</tr>
<tr>
<td>DSP Software Test Bench (STB) Library</td>
<td>SPRC084</td>
</tr>
<tr>
<td>C28x FPU Fast RTS Library</td>
<td>SPRC664</td>
</tr>
<tr>
<td>C2833xC2833x C/C++ Header Files and Peripheral Examples</td>
<td>SPRC530</td>
</tr>
</tbody>
</table>

Available from TI Website ⇒ http://www.ti.com/c2000
Experimenter’s Kits

**C2000 Experimenter’s Kits**
F28027, F28035, F2808, F28335

- Experimenter Kits include
  - F28027, F28035, F2808 or F28335 controlCARD
  - USB docking station
  - C2000 Applications Software CD with example code and full hardware details
  - Code Composer Studio v3.3 with code size limit of 32KB

- Docking station features
  - Access to controlCARD signals
  - Breadboard areas
  - Onboard USB JTAG Emulation
    - JTAG emulator not required

- Available through TI authorized distributors and the TI eStore

**C2834x Experimenter’s Kits**
C28343, C28346

- Experimenter Kits include
  - C2834x controlCARD
  - Docking station
  - C2000 Applications Software CD with example code and full hardware details
  - Code Composer Studio v3.3 with code size limit of 32KB
  - 5V power supply

- Docking station features
  - Access to controlCARD signals
  - Breadboard areas
  - JTAG emulator required – sold separately

- Available through TI authorized distributors and the TI eStore
F28335 Peripheral Explorer Kit

- Experimenter Kit includes
  - F28335 controlCARD
  - Peripheral Explorer baseboard
  - C2000 Applications Software CD with example code and full hardware details
  - Code Composer Studio v3.3 with code size limit of 32KB
  - 5V DC power supply
- Peripheral Explorer features
  - ADC input variable resistors
  - GPIO hex encoder & push buttons
  - eCAP infrared sensor
  - GPIO LEDs, I2C & CAN connection
  - Analog I/O (AIC+McBSP)
- JTAG emulator required – sold separately
- Available through TI authorized distributors and the TI eStore

C2000 controlCARD Application Kits

- Kits includes
  - controlCARD and application specific baseboard
  - Full version of Code Composer Studio v3.3 with 32KB code size limit
- Software download includes
  - Complete schematics, BOM, gerber files, and source code for board and all software
  - Quickstart demonstration GUI for quick and easy access to all board features
  - Fully documented software specific to each kit and application
- See www.ti.com/c2000 for more details
- Available through TI authorized distributors and the TI eStore
Product Information Resources

For More Information . . .

Internet
Website: http://www.ti.com
FAQ: http://www-k.ext.ti.com/sc/technical_support/knowledgebase.htm
- Device information
- Application notes
- Technical documentation
- my.ti.com
- News and events
- Training

Enroll in Technical Training: http://www.ti.com/sc/training

USA - Product Information Center (PIC)
Phone: 800-477-8924 or 972-644-5580
Email: support@ti.com
- Information and support for all TI Semiconductor products/tools
- Submit suggestions and errata for tools, silicon and documents

European Product Information Center (EPIC)
Web: http://www-k.ext.ti.com/sc/technical_support/pic/euro.htm
Phone: Language | Number
Belgium (English) | +32 (0) 27 45 55 32
France | +33 (0) 1 30 70 11 64
Germany | +49 (0) 8161 80 33 11
Israel (English) | 1800 949 0107 (free phone)
Italy | 800 79 11 37 (free phone)
Netherlands (English) | +31 (0) 546 87 95 45
Spain | +34 902 35 40 28
Sweden (English) | +46 (0) 8587 555 22
United Kingdom | +44 (0) 1604 66 33 99
Finland (English) | +358 (0) 9 25 17 39 48
Fax: All Languages | +49 (0) 8161 80 2045
Email: epic@ti.com
- Literature, Sample Requests and Analog EVM Ordering
- Information, Technical and Design support for all Catalog TI Semiconductor products/tools
- Submit suggestions and errata for tools, silicon and documents
Module Topics

Appendix A – Experimenter’s Kit ...........................................................................................................A-1

Module Topics.................................................................................................................. ....................... A-2

F28035 controlCARD ............................................................................................................................. A-3
F28035 PCB Outline (Top View).................................................................................................. .....A-3
LD1 / LD2 / LD3................................................................................................................ ................A-3
SW1....................................................................................................................................................A-3
SW2....................................................................................................................................................A-4
SW3....................................................................................................................................................A-4

F28335 controlCARD ............................................................................................................................. A-5
F28335 PCB Outline (Top View).................................................................................................. .....A-5
LD1 / LD2 / LD3................................................................................................................ ................A-6
SW1....................................................................................................................................................A-6
SW2....................................................................................................................................................A-7

Docking Station................................................................................................................ ....................... A-8
SW1 / LD1..........................................................................................................................................A-8
JP1 / JP2 ........................................................................................................................................... A-8
F2833x Boot Mode Selection .............................................................................................................A-9
F280xx Boot Mode Selection .............................................................................................................A-9
J3 – DB-9 to 4-Pin Header Cable .....................................................................................................A-10
F28035 controlCARD

F28035 PCB Outline (Top View)

LD1 / LD2 / LD3

LD1 – Turns on when controlCARD is powered on
LD2 – Controlled by GPIO-31
LD3 – Controlled by GPIO-34

SW1

SW1 – controls whether on-card RS-232 connection is enabled or disabled.
- ON – RS-232 transceiver will be enabled and allow communication through a serial cable via pins 2 and 42 of the DIMM-100 socket. Putting SW1 in the “ON” position will allow the F28035 controlCARD to be card compatible with the F2808, F28044, F28335, and F28027 controlCARDs. GPIO-28 will be stuck as logic high in this position.
- OFF – The default option. SW1 in the “OFF” position allows GPIO-28 to be used as a GPIO. Serial communication is still possible, however an external transceiver such as the FTDI – FT2232D chip.
SW2

SW2 – controls the boot options of the F28035 device

<table>
<thead>
<tr>
<th>Position 1 (GPIO-34)</th>
<th>Position 2 (TDO)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

SW3

SW3 – ADC VREF control

The ADC will by default convert from 0 to 3.3V, however if in the ADC registers the ADC is configured to use external limits the ADC will convert its full range of resolution from VREF-LO to VREF-HI.

Position 1 controls VREF-HI, the value that the ratiometric ADC will convert as the maximum 12-bit value, 0x0FFF. In the downward position, VREF-HI will be connected to 3.3V. In the upward position, VREF-HI will be connected to pin 66 of the DIMM100-socket. This would allow a connecting board to control the ADC-VREFHI value.

Position 2 controls VREF-LO, the value that the ratiometric ADC will convert as the minimum 12-bit value, 0x0000. In the downward position, VREF-LO will be connected to 0V. In the upward position, VREF-LO will be connected to pin 16 of the DIMM100-socket. This would allow a connecting board to control the ADC-VREFLO value.
F28335 controlCARD

F28335 PCB Outline (Top View)

PGF – Release 1.x

SW1  SW2  LD1  LD2  LD3

ZJZ – Release 2.x

SW1  SW2  LD1  LD2  LD3
Note: Older versions of the F28335 controlCARD do not include SW1 or SW2.

LD1 / LD2 / LD3

LD1 – Turns on when controlCARD is powered on
LD2 – Controlled by GPIO-31
LD3 – Controlled by GPIO-34

SW1

SW1 – controls whether on-card RS-232 connection is enabled or disabled.
- **ON** – RS-232 transceiver will be enabled and allow communication through a serial cable via pins 2 and 42 of the DIMM-100 socket. Putting SW1 in the “ON” position will allow the F28335 controlCARD to be card compatible with the F2808, F28044, F28035, and F28027 controlCARDs. GPIO-28 will be stuck as logic high in this position.
- **OFF** – SW1 in the “OFF” position allows GPIO-28 to be used as a GPIO. Serial communication is still possible, however an external transceiver is needed such as the FTDI – FT2232D chip.
  - This is primarily used for communicating over the USB to serial bridge included in the onboard XDS100 JTAG emulation on many C2000 development boards.
SW2

SW2 – controls the boot options of the F28335 device.

The boot options used in this workshop are shown below:

<table>
<thead>
<tr>
<th>Position 1 (GPIO-84)</th>
<th>Position 2 (GPIO-85)</th>
<th>Position 3 (GPIO-86)</th>
<th>Position 4 (GPIO-87)</th>
<th>Boot Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>SARAM</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>FLASH</td>
</tr>
</tbody>
</table>

For a complete list of boot mode options see the F2833x Boot Mode Selection table in the Docking Station section of this appendix.

Some earlier versions of the F28335 controlCARD use the ZJZ (a BGA) package. These are functionally equivalent to versions that use the PFG package.
Docking Station

2833x Boot*

280xx Boot*

J9  J2  J8

JP2

SW1

J3

JP1

LD1

*Note: Jumper Left = 1; Jumper Right = 0

SW1 / LD1

SW1 – USB: Power from USB; ON – Power from JP1

LD1 – Power-On indicator

JP1 / JP2

JP1 – 5.0 V power supply input

JP2 – USB JTAG emulation port


J1 – ControlCARD 100-pin DIMM socket

J2 – JTAG header connector

J3 – UART communications header connector

J8 – Internal emulation enable/disable jumper (NO jumper for internal emulation)

J9 – User virtual COM port to C2000 device (Note: ControlCARD would need to be modified to disconnect the C2000 UART connection from header J3)
Docking Station

**Note:** The internal emulation logic on the Docking Station routes through the FT2232 USB device. By default this device enables the USB connection to perform JTAG communication and in parallel create a virtual serial port (SCI/UART). As shipped, the C2000 device is not connected to the virtual COM port and is instead connected to J3.

## F2833x Boot Mode Selection

<table>
<thead>
<tr>
<th>MODE</th>
<th>GPIO87/XA15</th>
<th>GPIO86/XA14</th>
<th>GPIO85/XA13</th>
<th>GPIO84/XA12</th>
<th>MODE (1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>F</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>Jump to Flash</td>
</tr>
<tr>
<td>E</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>SCI-A boot</td>
</tr>
<tr>
<td>D</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>SPI-A boot</td>
</tr>
<tr>
<td>C</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>J2C-A boot</td>
</tr>
<tr>
<td>B</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>eCAN-A boot</td>
</tr>
<tr>
<td>A</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>Mc3SP-A boot</td>
</tr>
<tr>
<td>9</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>Jump to XINTF x16</td>
</tr>
<tr>
<td>8</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Jump to XINTF x32</td>
</tr>
<tr>
<td>7</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>Jump to OTP</td>
</tr>
<tr>
<td>6</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>Parallel GPIO I/O boot</td>
</tr>
<tr>
<td>5</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>Parallel XINTF boot</td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>Jump to SARAM</td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>Branch to check boot mode</td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>Branch to Flash, skip ADC calibration</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>Branch to SARAM, skip ADC calibration</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Branch to SCI, skip ADC calibration</td>
</tr>
</tbody>
</table>

(1) All four GPIO pins have an internal pullup.

## F280xx Boot Mode Selection

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
<th>GPIO18 SPICLKA (1)</th>
<th>GPIO29 SCI10DA</th>
<th>GPIO34 SCI03DA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boot to Flash (2)</td>
<td>Jump to flash address 0x3F 7FF0. You must have programmed a branch instruction here prior to reset to redirect code execution as desired.</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>SCI-A Boot</td>
<td>Load a data stream from SCI-A.</td>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>SPI-A Boot</td>
<td>Load from an external serial SPI EEPROM on SPI-A.</td>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>PC Boot</td>
<td>Load data from an external EEPROM at address 0x50 on the PC bus.</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>eCAN-A Boot (3)</td>
<td>Call CAN_Boot to load from eCAN-A mailbox 1.</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Boot to M0 SARAM (4)</td>
<td>Jump to M0 SARAM address 0x00 0000.</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Boot to OTP (4)</td>
<td>Jump to OTP address 0x3D 7800.</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Parallel I/O Boot</td>
<td>Load data from GPIO00 - GPIO15.</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

(1) You must take extra care because of any effect toggling SPICLKA to select a boot mode may have on external logic.
(2) When booting directly to flash, it is assumed that you have previously programmed a branch statement at 0x3F 7FF0 to redirect program flow as desired.
(3) On devices that do not have an eCAN-A module this configuration is reserved. If it is selected, then the eCAN-A bootloader will run and will loop forever waiting for an incoming message.
(4) When booting directly to OTP or M0 SARAM, it is assumed that you have previously programmed or loaded code starting at the entry point location.
J3 – DB-9 to 4-Pin Header Cable

**Note:** This cable is NOT included with the Experimenter’s Kit and is only shown for reference.

Pin-Out Table for Both Ends of the Cable:

<table>
<thead>
<tr>
<th>DB-9 female</th>
<th>SIL 0.1” female</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pin#</td>
<td>Pin#</td>
</tr>
<tr>
<td>2 (black)</td>
<td>1 (TX)</td>
</tr>
<tr>
<td>3 (red)</td>
<td>4 (RX)</td>
</tr>
<tr>
<td>5 (bare wire)</td>
<td>3 (GND)</td>
</tr>
</tbody>
</table>

Note: pin 2 on SIL is a no-connect